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●ข้อควรระมัดระวังเกี่ยวกับเรื่องความปลอดภัย●
(กรุณาอ่านก่อนเริ่มการอบรม)

ควรอ่านคู่มือเล่มนี้ขณะออกแบบระบบ พร้อมกับต้องค�ำนึงถึงเรื่องความปลอดภัยอย่างเคร่งครัด
อีกทั้งก่อนที่จะมีการฝึกอบรมควรระมัดระวังและปฏิบัติตามขั้นตอนเหล่านี้ให้ได้อย่างถูกต้อง

(ข้อควรระมัดระวังก่อนเริ่มท�ำการอบรม)

 อันตราย

●● เพื่อป้องกันอันตรายจากไฟฟ้าดูด จึงไม่ควรสัมผัสขั้วไฟ ขณะที่กระแสไฟฟ้าไหลอยู่

●● เมื่อมีการเปิดฝาเครื่อง ควรที่จะปิดสวิทซ์ หรือควรตรวจสอบเรื่องของความปลอดภัยให้ถี่ถ้วนก่อนเริ่ม
ปฏิบัติงาน

●● ไม่ควรใช้มือยื่นเข้าไปบริเวณจุดที่มีอุปกรณ์ก�ำลังเคลื่อนที่

 

 ข้อควรระมัดระวัง

●● กรุณาอบรมตามค�ำแนะน�ำของผู้สอน

●● ส�ำหรับปลั๊กไฟแบบมีสายดิน กรุณาใช้กับปลั๊กสามขา 
กรณีที่มีการใช้หัวต่อจาก 3 หัวไปเป็น 2 หัว ควรเสียบสายดินของปลั๊ก เข้ากับขั้วต่อของหัวต่อด้วย

●● ไม่ควรกระท�ำการถอดยูนิต หรือเปลี่ยนสายไฟโดยพลการ อาจเป็นสาเหตุท�ำให้เกิดความเสียหาย  
การท�ำงานที่ผิดพลาด อุบัติเหตุ หรือเพลิงไหม้ได้

●● เมื่อมีการประกอบหรือถอดแยกยูนิตจ�ำเป็นต้องปิดเครื่องก่อนทุกครั้ง 
ขณะที่กระแสไฟไหลผ่านอาจจะเป็นสาเหตุที่ท�ำให้เกิดการเสียหายของยูนิต หรืออาจเกิดไฟดูดได้

●● เมื่อเกิดกลิ่น หรือเสียงที่ผิดปกติขึ้นที่เครื่อง (อาทิเช่น X/Y Table) ให้ท�ำการปิดสวิทซ์ทันที

●● เมื่อพบว่ามีสิ่งผิดปกติเกิดขึ้น ให้เรียกผู้ฝึกสอนทันที

ระวัง :
ชุดฝึกการต่อสายไฟ, PLC Training Kit ใช้กับไฟ AC100V
กรุณาอย่าใช้กับไฟเกิน AC100V เด็ดขาด เพราะจะเป็นสาเหตุท�ำให้อุปกรณ์เสีย
และเป็นต้นเหตุของไฟไหม้ได้ เวลาใช้งานกรุณาเลือกใช้เครื่องแปลงไฟที่เหมาะสม



ค�ำแนะน�ำเบื้องต้น

คู่มือฉบับนี้ มีไว้ส�ำหรับแนะน�ำผู้ที่ก�ำลังจะใช้เครื่อง PLC เป็นครั้งแรก ซึ่งมีทั้งเนื้อหาความรู้ขั้นพื้นฐาน ส�ำหรับการควบคุม 
เครื่อง PLC รวมถึงการแนะน�ำกรณีตัวอย่างง่ายๆ

อีกทั้งเนื้อหาในคู่มือฉบับนี้ มีการใช้เครื่อง Micro PLC รุ่น FX3G-14MR/ES เป็นสื่อในการสอน และรุ่น FX-I/O-DEMO2 
ส�ำหรับใช้เป็นเครื่องในการฝึกสอน

ชื่อเรียกเอกสาร หมายเลขเอกสาร เนื้อหา

■ FX3G Series main unit

FX3G Series Hardware Manual JY997D33401
สเป๊กของ Input - Output ส�ำหรับรุ่น FX3G รวมถึงสายไฟและการติดตั้ง
คู่มือส�ำหรับ User รุ่น FX3G ที่มีความสมบูรณ์มากกว่า ฉบับ Hardware

FX3G Series User's Manual 
[Hardware Edition]

JY997D31301
สเป๊กของ Input - Output ส�ำหรับตัวเครื่อง FX3G PLC รวมถึงสายไฟ  
การติดตั้ง และการซ่อมบ�ำรุงที่เกี่ยวข้องกับ Hardware โดยมีเนื้อหา 
ที่ละเอียดแยกตามหัวข้อ

■ Programming

FX3S/FX3G/FX3GC/FX3U/FX3UC Series Programming 
Manual
[Basic & Applied Instruction Edition]

JY997D16601
มีการอธบิายค�ำส่ังขัน้พืน้ฐานของ PLC รุน่ FX3S·FX3G·FX3GC·FX3U·FX3UC

• �รวมถึงค�ำสั่งการใช้งาน ค�ำอธิบายส�ำหรับ Device แต่ละประเภท และ
หัวข้อต่างๆ ที่เกี่ยวกับ Programming ของ ซีเควนซ์

■ Handy Programming Panel

FX-30P Installation Manual JY997D34201
เนื้อหาบางส่วนน�ำมาจากคู่มือการท�ำงานเครื่อง FX-30P โดยเกี่ยวกับ 
สเป๊กและการติดตั้ง FX-30P

FX-30P Operation Manual JY997D34401
อธิบายหัวข้อรายละเอียดเกี่ยวกับ Handy Programming Panel  
รุ่น FX-30P

หนังสือเล่มนี้ มิได้จัดท�ำขึ้นเพื่อการรับประกันการจดสิทธิ์ในทรัพย์สินอุตสาหกรรมหรืออ�ำนาจเชิงสิทธิ์ อีกทั้ง
การอนุญาตในอ�ำนาจการน�ำไปปฏิบัติต่างๆ แต่อย่างใด

อีกทั้งปัญหาต่างๆ ที่อาจเกิดขึ้นโดยข้อบัญญัติทางสิทธิ์ในทรัพย์สินอุตสาหกรรมอันเนื่องมาจากสาเหตุที่ได้มี
การน�ำเนื้อหาที่ระบุอยู่ในหนังสือเล่มนี้ไปใช้ทางบริษัทจะไม่รับผิดชอบใดๆ ทั้งสิ้น
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เครือ่งหมายการคา้
• �Windows, Windows 7, Windows 8 เป็นเครื่องหมายการค้า หรือเครื่องหมายการค้าของ Microsoft Corporation  

ของประเทศสหรัฐอเมริกา และในประเทศอื่นๆ
• �ชื่อบริษัท และชื่อสินค้าของบริษัทอื่นในเอกสารชุดนี้ล้วนเป็นเครื่องหมายการค้า และเป็นเครื่องหมายการค้าของ 

บริษัทนั้นๆ

 เอกสารที่เกี่ยวข้องจะมีการระบุไว้ตามด้านล่าง
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1

มาเรยีนรูเ้กีย่วกบัซเีควนซ์ (Sequences) กันเถอะ

บทที่ 1
การควบคุมซีเควนซ์ (Sequence Control) 
คืออะไร

มาท�ำความรู้จักกับ การควบคุมซีเควนซ์ (Sequence Control)
“PLC หรือซีเควนเซอร์ (Sequencer)” ที่จะแนะน�ำให้ทุกท่านรู้จักหลังจากนี้นั้น เป็นอุปกรณ์ที่ใช้ “การควบคุม

ซีเควนซ์ (Sequence Control)” ถ้าอย่างนั้น “การควบคุมซีเควนซ์ (Sequence Control)” คืออะไรกันแน่
ปกติเราจะไม่ค่อยได้ยินชื่อนี้ผ่านหูสักเท่าไหร่ แต่ในความเป็นจริงจะมีการใช้งานผ่านอุปกรณ์ต่างๆ รอบตัวเรา
มากมาย ซึ่งไม่ว่าใครก็น่าจะเคยสัมผัสกันมาแล้ว 
ยกตัวอย่างเช่น เครื่องซักผ้า ชนิด Full automatic ที่มีระบบ “การควบคุมซีเควนซ์ (Sequence Control)” อย่าง
เต็มรูปแบบ

เนื้อหาในบทนี้ จะมีการยกตัวอย่างจากอุปกรณ์ต่างๆ ที่ปรากฏอยู่รอบตัวเรา โดยที่หัวข้ออยู่ที่ “การควบคุม 
ซีเควนซ์ (Sequence Control)” เพื่อให้ทุกท่านท�ำความเข้าใจว่า “การควบคุมซีเควนซ์ (Sequence Control)”  
ที่ว่านี้คืออะไร
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เสร็จ!

1.1	 การควบคุมซีเควนซ์ (Sequence Control) คืออะไร

1.1.1	 ซีเควนซ์ (Sequence) มีความหมายว่าอย่างไร

“การควบคุมซีเควนซ์ (Sequence Control)”… 
โดยทั่วไปแล้วเราอาจจะไม่ค่อยคุ้นเคยกับค�ำนี้สักเท่าไหร่ แต่ในความเป็นจริงแล้วรอบๆ ตัวเราจะมีการใช้ค�ำนี้อยู่อย่างกว้างขวาง รวมถึง 
รูปร่างลักษณะของอุปกรณ์ตัวนี้เราก็น่าจะเคยเห็นหรือเคยสัมผัสกันอยู่บ้าง

ก่อนอื่น ถ้าเราลองค้นหาความหมายในพจนานุกรมค�ำว่า “ซีเควนซ์ (Sequence)” จะได้ความหมายว่า 

① การเกิดอย่างต่อเนื่อง, ต่อเนื่องกัน, การเกิดขึ้นหลายครั้งติดกัน
② ด�ำเนินต่อ, ความต่อเนื่อง
③ ล�ำดับ, คิว
④ เหตุการณ์ที่เกิดขึ้นตามมาอาทิเช่น, ผลกระทบ, ผลลัพธ์...

เพราะฉะนั้นค�ำว่า ซีเควนซ์ (Sequence) คือ สิ่งที่เกิดต่อเนื่อง หรือล�ำดับของการเกิดขึ้นของปรากฏการณ์ 

ค�ำว่า “การควบคุมซีเควนซ์ (Sequence Control)” มาจากค�ำว่า “ซีเควนซ์ (Sequence)” ซึ่งมีความหมายว่า การท�ำงานที่ปฏิบัติตามล�ำดับขั้น
ตอนที่ได้มีการก�ำหนดไว้ล่วงหน้า อีกทั้งค�ำว่า “การควบคุม (Control)” หมายความว่า การท�ำงานที่ต้องเป็นไปตามที่วางแผน 

1.1.2	 ยกตัวอย่างจากสิ่งที่อยู่ใกล้ตัวเรา…
เครื่องล้างรถอัตโนมัติที่เราเห็นกันบ่อยๆ ตามปั๊มเติมน�้ำมัน
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1
จากการแนะน�ำตัวอย่างเครื่องล้างรถในหน้าที่ผ่านมา ซึ่งถึงแม้ว่าจะเป็นล�ำดับขั้นตอนที่ไม่ยุ่งยากแต่ก็เป็นแนวคิดของ ซีเควนซ์ (Sequence) 
ซึ่งการควบคุมซีเควนซ์ (Sequence Control) นั่นก็คือ การควบคุมเครื่องให้ท�ำงานเป็นระบบอัตโนมัติเพื่อให้การท�ำงานทุกครั้งออกมาถูกต้อง

ในอีกทางหนึ่ง การควบคุมซีเควนซ์ (Sequence Control) นั้น ถูกใช้กับงานในหลายๆ ด้าน หลายๆ สาขา ซึ่งกลายเป็นแนวคิดที่ขาดอีกต่อ
ไปไม่ได้

การควบคุมซีเควนซ์ (Sequence Control) ไม่ใช่เรื่องที่ยากเพราะเป็นสิ่งที่อยู่รอบๆ ตัวเรา

■ �FA (Factory automation) ในโรงงานเครื่องจักร 

■ �อุปกรณ์การท�ำงานในแต่ละประเภท

■ �เครื่องจักรผลิตอาหาร และการแปรรูป

■ น�ำไปใช้ในการควบคุมระบบอัตโนมัติต่างๆ

ใช้กับการควบคุม สายพาน (Conveyor) หรือการควบคุมใน
เครื่องจักร Machining และเครื่องจักร Assembly

ใช้ในการท�ำงานประเภท วัตถุดิบ, Injection, Heat-up, Cutting, 
Packing โดยมีการควบคุมผ่านเครื่องจักรในแต่ละประเภท

มีการน�ำไปใช้อย่างแพร่หลายในหลายสาขา

• เครื่องซักผ้าขนาดใหญ่
• เครื่องออกตั๋วอัตโนมัติ
• �ตู้เย็น เครื่องแช่แข็ง หรืออุปกรณ์เสริมต่างๆ • น�ำไปใช้ใน

การควบคุมระบบอัตโนมัติต่างๆ

• การควบคุมที่จอดรถอัตโนมัติ
• ควบคุมการย้ายของบน Conveyor
• ควบคุมการเปิดปิดของประตูกั้นน�้ำ

• การควบคุมภายในโรงเรือนเพาะปลูก
• �การควบคุมสัญญาณไฟจราจร หรือ

ป้ายไฟฟ้า
• การควบคุมประตูชัตเตอร์

จ�ำหน่ายตัว๋
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1.2	� อุปกรณ์ที่เกี่ยวข้องกับการควบคุมซีเควนซ์ (Sequence 
Control)

1.2.1	 โครงสร้างการควบคุมซีเควนซ์ (Sequence Control)

ในกรณีที่ต้องใช้การควบคุมเป็นแบบ PLC จ�ำเป็นต้องมีอุปกรณ์ดังต่อไปนี้

อุปกรณ์ชนิดนี้แบ่งการท�ำงานออกเป็นหัวข้อใหญ่ๆ ได้ดังนี้ “อุปกรณ์ที่บังคับการใช้งานด้วยคน”, “อุปกรณ์ที่แจ้งสภาพของเครื่องจักรให้คนทราบ”  
“อุปกรณ์ส�ำหรับตรวจสภาพของเครื่องจักร”, “อุปกรณ์ส�ำหรับท�ำให้เครื่องจักรเคลื่อนที่”

อุปกรณ์ที่บังคับการใช้งานด้วยคน อุปกรณ์ที่แจ้งสภาพของ 
เครื่องจักรให้คนทราบ

Switch Lamp หรือ Buzzer

อุปกรณ์ส�ำหรับท�ำให้เครื่องจักร
เคลื่อนที่

อุปกรณ์ส�ำหรับตรวจสภาพ 
ของเครื่องจักร

Motor หรือ Solinoid valveLimit switch หรือ Proximity switch

การควบคุมซีเควนซ์
(Sequence Control) Magnet conductor หรือ Relay

Solynoid valve ขนาดเล็กหรืออุปกรณ์
อื่นๆ ที่มี Load น้อย อาทิเช่น Pilot lamp 
ที่สามารถต่อตรงเพื่อที่จะขับเคลื่อนได้ แต่
ถ้าเป็น Solynoid valve ขนาดใหญ่ที่ใช้
ก�ำลัง Load สูง จ�ำเป็นต้องมีอุปกรณ์เสริม
ที่เรียกว่า Magnet conductor หรือ รีเลย์ 
(Relay) เพื่อใช้ในการขับเคลื่อน

คน

เครือ่งจกัร
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1
แบบดังต่อไปนี้เป็นเพียงตัวอย่าง ซึ่งในความเป็นจริงยังมีอุปกรณ์อีกหลายแบบ
การควบคุมซีเควนซ์ (Sequence Control) เป็นการก�ำหนดล�ำดับการท�ำงานของอุปกรณ์เพื่อให้อุปกรณ์ท�ำงานตามค�ำสั่ง ซึ่งการท�ำงาน 
ของอุปกรณ์นี้จะมีเงื่อนไขประกอบไปด้วย “อุปกรณ์ที่บังคับการใช้งานด้วยคน” “อุปกรณ์ส�ำหรับตรวจสภาพของเครื่องจักร” แต่ส�ำหรับเงื่อนไข 
ในการที่จะเดินเครื่องนั้น จะประกอบไปด้วย “อุปกรณ์ที่แจ้งสภาพของเครื่องจักรให้คนทราบ” “อุปกรณ์ส�ำหรับท�ำให้เครื่องจักรเคลื่อนที่”

ตู้ปฏิบัติการ (Operation panel)

เป็นตู้ Panel ที่มีการติดตั้งอุปกรณ์ที่ใช้คนในการควบคุม (อาทิเช่น ปุ่ม Button switch, Selector switch เป็นต้น) หรืออุปกรณ์ที่ใช้ในการ 
แจ้งสถานะของเครื่องจักร (อาทิเช่น Lamp หรือ Digital display machine เป็นต้น)

ตู้ควบคุม (Control panel)

เป็นตู้ Panel ที่มีการติดตั้งอุปกรณ์ส�ำหรับควบคุมการท�ำงานของเครื่องจักร อาทิเช่น Magnetic contactor, รีเลย์ (Relay) หรือ PLC เป็นต้น

ตัวอย่าง ภายในเครื่องล้างรถอัตโนมัติจะประกอบไปด้วยอุปกรณ์ต่างๆ ที่ใช้ในการควบคุมซีเควนซ์ (Sequence Control)

อุปกรณ์ส�ำหรับท�ำให้เครื่องจักร
เคลื่อนที่

อุปกรณ์ส�ำหรับตรวจสภาพ 
ของเครื่องจักร

Switch ที่ใช้ตรวจสอบต�ำแหน่งของรถยนต์อุปกรณ์ที่บังคับการใช้งานด้วยคน

อาทิเช่น การกดปุ่ม Start, Stop

อุปกรณ์ที่แจ้งสภาพของ 
เครื่องจักรให้คนทราบ

อาทิเช่น ไฟ Lamp ขณะท�ำการเดินเครื่อง

Motor ส�ำหรับการหมุนแปรงหรือเดินปั๊ม 
เพื่อใช้ในการฉีดน�้ำยาท�ำความสะอาดหรือน�้ำ
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1.3	� สิ่งที่จ�ำเป็นในการควบคุมซีเควนซ์ (Sequence Control)
1.3.1	� ท�ำความเข้าใจเกี่ยวกับภาพรวมของการควบคุมซีเควนซ์ 

(Sequence Control)

ลองมาคิดเกี่ยวกับการควบคุมซีเควนซ์ (Sequence Control) โดยอาศัยผังการเชื่อมต่อดังต่อไปนี้ อีกทั้งตรงนี้จะอธิบายค�ำศัพท์ที่ควรจ�ำ 
ในการศึกษาการควบคุมซีเควนซ์ (Sequence Control) ด้วย

ตัวอย่างที่ 1  : ปุ่ม Push button, ไฟ Lamp (ฟ้า, แดง), มีการใช้รีเลย์ (Relay) ในการเดินสายไฟในวงจรไฟฟ้า

◎◎ รายละเอียดของ การควบคุมซีเควนซ์ (Sequence Control)

①	 สถานะของอุปกรณ์ถ้าไม่ได้ท�ำการกด Push button เส้น B  จะเป็นเส้นที่กระแสไฟไหลผ่าน ไฟ Lamp สีฟ้าจะติด
②	 เมื่อมีการกด Push button เส้น A  จะเป็นเส้นที่กระแสไฟไหลผ่าน ไฟ Lamp สีแดงจะติด
③	 เมื่อมีการปล่อยปุ่ม Push button ไฟสีฟ้าจะติดเหมือนเช่นข้อ ①
	 ①~③ การท�ำงานของทั้งสามข้อนี้เป็นส่วนหนึ่งของ การควบคุมซีเควนซ์ (Sequence Control)

A

B

แผนผังการเชื่อมต่อแหล่งจ่ายไฟ
Power

แหล่งจ่ายไฟ
Power

สวิทซ์แบบปุ่มกด
Push button

หลอดไฟสีฟ้า
Blue lamp

หลอดไฟสีแดง
Red lamp

รีเลย์
Relay
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1
●	เกี่ยวกับหน้าสัมผัส (Contact) ประเภทต่างๆ 
หน้าสัมผัส (Contact) มีหน้าที่ในการน�ำหรือตัดกระแส เมื่อมีการเปิด-ปิด 
ส่ิงทีจ่ะเป็นพืน้ฐานของหน้าสมัผสั (Contact) คอื “หน้าสมัผสัปกตเิปิด a (“Normally open” contact หรอื N.O. Contacts)” และ “หน้าสมัผสัปกตปิิด 
b (“Normally closed” contact หรอื N.C. Contacts)” ซึง่หน้าสมัผสั (Contact) นัน้จะปรากฏอยูใ่น Switch หรอื รเีลย์ (Relay), Timer, Counter

หน้าสัมผัสปกติเปิด a (N.O. Contacts)

หน้าสัมผัสปกติเปิด a (N.O. Contacts) จะเป็นชื่อเรียกของหน้าสัมผัส (Contact) ที่มีสถานะเปิด และเมื่อมีค�ำสั่ง หรือมีการกระตุ้น 
หน้าสัมผัส (Contact) ก็จะท�ำการปิดลง

※1  ค�ำสั่ง หมายความว่า การควบคุมให้เกิดการท�ำงานหรือการเปลี่ยนแปลง ถ้าเป็น Push button การกดปุ่มก็คือ Command นั่นเอง 

การท�ำงาน	 ในกรณีที่เป็นปุ่ม Button switch 
	 กรณีที่ไม่กดปุ่ม Button switch ตัว หน้าสัมผัส (Contact) จะเปิด และจะปิดเมื่อมีการกดปุ่ม 

หน้าสัมผัสปกติปิด b (N.C. Contacts)

หน้าสัมผัสปกติปิด b (N.C. Contacts) คือ หน้าสัมผัส (Contact) ที่ปกติจะเป็นสถานะปิด เมื่อได้รับค�ำสั่ง หรือมีการกระตุ้น หน้าสัมผัส 
(Contact) จะท�ำการเปิด

การท�ำงาน	 ในกรณีที่เป็นปุ่ม Button switch
	 ในกรณีที่ไม่ได้กดปุ่ม Button switch ตัว หน้าสัมผัส (Contact) จะปิด และจะเปิดเมื่อมีการกดปุ่ม

อ้างอิง

ที่มาของชื่อ หน้าสัมผัสปกติเปิด a (N.O. Contacts), หน้าสัมผัสปกติปิด b (N.C. Contacts)
ชื่อหน้าสัมผัสปกติเปิด a (N.O. Contacts), หน้าสัมผัสปกติปิด b (N.C. Contacts) มาจากไหน

หน้าสัมผัสปกติเปิด a (N.O. Contact) : Arbeit contact  ··· หน้าสัมผัสที่มีการท�ำงาน (ภาษาเยอรมัน)    
กล่าวคือ การดึงเอา “อักษรตัวแรก” มาใช้นั่นเอง

หน้าสัมผัสปกติปิด b (N.C. Contact) : Break contact  ··· หน้าสัมผัสที่มีการหยุด

บางครั้งก็เรียก หน้าสัมผัสปกติเปิด a ว่า “หน้าสัมผัสปกติเปิด” ภาษาอังกฤษ “N.O. Contacts (Normally-open contacts)” และเรียก หน้าสัมผัสปกติปิด b ว่า 
“หน้าสัมผัสปกติปิด” ภาษาอังกฤษ “N.C. Contacts (Normally-closed contacts)”

1.3.2	 มาเรียนรู้ค�ำศัพท์ใหม่กัน

ปุ่ม Push buttonปุ่ม Push button

สายไฟสายไฟสายไฟ

หน้าสัมผัสเคลื่อนที่ไม่ได้
หน้าสัมผัสเคลื่อนที่ได้

สปริงสปริง

กระแสไฟวิ่ง

หน้าสัมผัสเคลื่อนที่ไม่ได้

หน้าสัมผัสเคลื่อนที่ได้
วงจรไฟฟ้าเปิด

วงจรไฟฟ้าปิด

สถานะก่อนการกดปุ่ม (In return position) สถานะหลังการกดปุ่ม (Operation)

ปุ่ม Push button
ปุ่ม Push button

สายไฟสายไฟ หน้าสัมผัสเคลื่อนที่ไม่ได้
สายไฟ

สปริง สปริง

หน้าสัมผัสเคลื่อนที่ได้

กระแสไฟวิ่ง

สายไฟ

วงจรไฟฟ้าเปิด
หน้าสัมผัสเคลื่อนที่ได้

หน้าสัมผัสเคลื่อนที่ไม่ได้ หน้าสัมผัสสัมผัสกัน
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●	เกี่ยวกับรีเลย์ (Relay)

รีเลย์ (Relay) เป็นชื่อเรียกอุปกรณ์ไฟฟ้าชนิดหนึ่งซึ่งมีประโยชน์ในการถ่ายทอดกระแสไฟฟ้า
ในความเป็นจริงภายใน Relay จะมีแม่เหล็กไฟฟ้า เมื่อแม่เหล็กไฟฟ้ามีการท�ำงานจะท�ำการดูด Armature ขึ้น 
เพื่อท�ำการเปิด-ปิด หน้าสัมผัส (Contact)

※1 หน้าสัมผัส (Contact) … �หน้าสัมผัส (Contact) เป็นชื่อเรียกบริเวณที่มีการสัมผัสผ่านการเปิด-ปิด ที่มาจากการปล่อยหรือตัดกระแส
ไฟ นอกเหนือจาก รีเลย์ (Relay) จะมี Switch, Timer, Counter ก็จะมีหน้าสัมผัส (Contact) เช่นเดียวกัน 
อีกทั้งภายในหน้าสัมผัส (Contact) จะมีทั้งหน้าสัมผัสปกติเปิด a (N.O. Contacts), หน้าสัมผัสปกติปิด b 
(N.C. Contacts)

หน้าสัมผัสปกติเปิด a (N.O. Contacts)

การท�ำงานของหน้าสัมผัส (Contact)  
จะเริ่มท�ำงานเมื่อมีการปล่อย 
กระแสไปที่แม่เหล็กไฟฟ้า

OFF Contact ON Contact    มีกระแสไฟวิ่งผ่าน Contact
หน้าสัมผัสเคลื่อนที่ได้ หน้าสัมผัส

เคลื่อนที่ได้

หน้าสัมผัส 
เคลื่อนที่ไม่ได้

หน้าสัมผัส 
เคลื่อนที่ไม่ได้

แม่เหล็กไฟฟ้า

สปริง

แม่เหล็กไฟฟ้า

ปล่อยกระแสไฟ 
ไปที่ Coil 

เมื่อมีการหยุดกระแสไฟ สปริงจะท�ำหน้าที่ 
Return Operation หน้าสัมผัส (Contact) 
ให้กลับไปอยู่ที่ต�ำแหน่งเดิม

หน้าสัมผัสปกติปิด b (N.C. Contacts)

เมื่อมีการปล่อยกระแสไฟไปที ่
แม่เหล็กไฟฟ้า Operation  
หน้าสัมผัส (Contact) จะท�ำงาน

OFF ContactON Contact    มีกระแสไฟวิ่งผ่าน Contact
หน้าสัมผัสเคลื่อนที่ไม่ได้หน้าสัมผัสเคลื่อนที่ไม่ได้

แม่เหล็กไฟฟ้า

สปริง

แม่เหล็กไฟฟ้า
ปล่อยกระแสไฟ 

ไปที่ Coil 

หน้าสัมผัส 
เคลื่อนที่ได้

หน้าสัมผัส 
เคลื่อนที่ได้

เมื่อมีการหยุดปล่อยกระแสไฟ สปริงจะ
ท�ำหน้าที่ Return Operation หน้าสัมผัส 
(Contact) ให้กลับไปอยู่ที่ต�ำแหน่งเดิม
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☆	ท�ำไม รีเลย์ (Relay) ถึงจ�ำเป็น ?

① สัญญาณของ รีเลย์ (Relay) เพียงเล็กน้อยก็สามารถที่จะเดิน Motor หรือ Lamp ได้  
② มีการควบคุมกระแสตรงเพื่อใช้เดินมอเตอร์กระแสสลับ หรือควบคุมกระแสไฟที่มีความแตกต่างกันได้ ดังรูป

③ สามารถเดินเครื่อง Motor หรือ Lamp ที่อยู่ในระยะห่างได้
④ สามารถควบคุมแบบซับซ้อนได้ถ้ามีการใช้ รีเลย์ (Relay) เป็นจ�ำนวนมาก

DC12V (กระแสตรง)

AC100V (กระแสสลับ) 
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1.4	� ฝึกการเดินสายไฟภายใต้เงื่อนไขของซีเควนซ์กันเถอะ
1.4.1	� หลังจากที่ได้ท�ำการเรียนรู้ศัพท์ใหม่

หลังจากที่ได้ท�ำการเรียนรู้เรื่องหน้าสัมผัสรีเลย์ (Relay contact) แล้ว มาลองซ้อมจริงในหน้า 1-6 ตัวอย่างที่ 1

◎	รายละเอียดโดยย่อของการเดินสายรีเลย์ Relay wiring demostration 

※1	 แผนผังการเดินสายไฟคืออะไร...
	� เป็นแผนผังที่แสดงถึงอุปกรณ์ไฟฟ้าชนิดต่างๆ ที่ใช้บริเวณ 

วงจรไฟฟ้า หรือใช้ในการ Connect กับวงจรไฟฟ้า อีกทั้ง
แผนผังดังกล่าวสามารถตรวจสอบโครงสร้างของอุปกรณ์
ไฟฟ้าหรือการ Wiring ได้อย่างชัดเจนจึงสะดวกสบายต่อ 
การจัดท�ำอุปกรณ์ หรือสะดวกต่อการ Maintenance

ส่วนประกอบ

เคเบิลสายไฟ. . . . . . . . . 1 เส้น 
ปุ่มกด. . . . . . . . . . . . . .1 อัน
หลอดไฟสีแดง (Red). . . .1 อัน
หลอดไฟสีฟ้า (Blue) . . . .1 อัน
รีเลย์ (Relay) . . . . . . . . .1 อัน
สายลีด
สีน�ำ้ตาล (Brown), สีแดง (Red), สีส้ม (Orange),  
สีเหลือง (Yellow), สีเขียว (Green), สีฟ้า (Blue),  
สีม่วง (Purple), สีเทา (Gray). . . . . . . . . . . . .  อย่างละ 1 เส้น

●	มาเดินสายไฟกัน
1. ตรวจสอบว่ากระแสไฟตัดหรือไม่
2. รูปที่ 1 แสดงถึงการเดินสายไฟ Red lamp

ระหว่าง ขั้วต่อ (Terminal) เบอร์ 5 [สีเขียว (Green)]
ระหว่าง ขั้วต่อ (Terminal) เบอร์ 6 [สีฟ้า (Blue)]
ระหว่าง ขั้วต่อ (Terminal) เบอร์ 1 [สีน�้ำตาล (Brown)]
ระหว่าง ขั้วต่อ (Terminal) เบอร์ 2 [สีแดง (Red)]
ระหว่าง ขั้วต่อ (Terminal) เบอร์ 3 [สีส้ม (Orange)]
ระหว่าง ขั้วต่อ (Terminal) เบอร์ 7 [สีม่วง (Purple)]
ใช้ Lead wires ในการ Connect

3. รูปที่ 2 แสดงถึงการเดินสายไฟ Blue lamp
ระหว่าง ขั้วต่อ (Terminal) เบอร์ 4 [สีเหลือง (Yellow)]
ระหว่าง ขั้วต่อ (Terminal) เบอร์ 8 [สีเทา (Gray)]
ใช้ Lead wires ในการ Connect

ข้อระมัดระวัง)  �จากกรณีดังกล่าว ขั้วต่อ (Terminal) เบอร์ 4 กับ 5 
ต้องเป็น Common ขั้วต่อ (Terminal)

รูปที่ 1 หลอดไฟสีแดง (Red)

รูปที่ 1 หลอดไฟสีฟ้า (Blue)

※1 แผนผังการเดินสายไฟ (Wiring diagram)

Common 
contact N.C. contact Relay

Coil

Pushbutton

Pushbutton switch
N.O. contact

Common 
contact N.C. contact Relay

Coil

Pushbutton

Pushbutton switch
N.O. contact

100 V AC

รีเลย์ (Relay)

หลอดไฟสีฟ้า (Blue)

กระแสไฟ DCหลอดไฟสีแดง (Red)

ปุ่มกด
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●	มาตรวจสอบการท�ำงานกัน

จงน�ำรายละเอียดของ การควบคุมซีเควนซ์ (Sequence Control) ในหน้า 1-6 และน�ำมาเรียบเรียงใหม่โดยใช้ค�ำศัพท์ที่ตนเรียนรู้

① �เมื่อมีการปล่อยกระแสเข้า หน้าสัมผัสปกติเปิด a (N.O. Contacts) กระแสจะท�ำการวิ่งผ่าน Route B และไฟที่หลอดไฟสีฟ้า (Blue lamp)
จะติด

② �หลังจากนั้น ถ้าได้กดปุ่ม Push button switch (Push button switch ก็คือ หน้าสัมผัสปกติเปิด a (N.O. Contacts)) จากการท�ำงานของ 
รีเลย์ (Relay) จะท�ำให้หน้าสัมผัสปกติเปิด a (N.O. Contacts) ปิด จึงท�ำให้กระแสไฟวิ่งผ่าน Route A ไฟสีแดงจะติด

③ �เมื่อมีการปล่อยปุ่ม Push button จะท�ำให้ไฟสีฟ้าติดอีกครั้ง

Flow chart คืออะไร
การควมคุมซีเควนซ์ (Sequence Control) คือ การออกแบบโครงสร้างวงจร
ไฟฟ้าโดยน�ำอุปกรณ์ต่างๆ มาผสมกัน
ดังนั้นอุปกรณ์ที่มีการประกอบเข้าไปรวมถึงรายละเอียดและล�ำดับการท�ำงาน 
เมื่อน�ำมาเขียนเป็นรายละเอียดจะท�ำให้เกิดความเข้าใจโดยรวมได้ยาก
ส�ำหรับ Flow chart นั้นจะใช้กรอบสี่เหลี่ยมและสัญลักษณ์ลูกศรเป็นเครื่องหมาย 
เพื่อสามารถที่จะสื่อให้เกิดความเข้าใจได้ง่าย

Time chart คืออะไร
มีการสรุปให้เข้าใจง่ายในเรื่องการปรับเวลาให้ตรงกับล�ำดับการ 
เดินเครื่อง 

ระบุอุปกรณ์ที่ใช้ในการควบคุมที่แกนนอน และมีการระบุการ

เปลี่ยนแปลงของเวลาที่แกนตั้ง

สังเกตที่สัญลักษณ์เส้นประ จะทราบว่าอุปกรณ์ไหนที่มีการท�ำงาน 
ที่เกี่ยวข้องบ้าง

อาจมีบางกรณีที่แสดงเป็นสัญลักษณ์เพื่อให้มีความเข้าใจง่าย หรือ 
อาจจะสังเกตรายละเอียดของ การควบคุมซีเควนซ์ (Sequence 
Control) จาก Flow chart หรือ Time chart

YES

NO

อธิบายการท�ำงานของ ซีเควนซ์ (Sequence) ผ่าน Flow chart

การแสดง ซีเควนซ์ (Sequence) จาก Time chart

เปิดสวิทซ์

ไฟสีฟ้าติด
ไฟสีแดงติด

มีการกดปุ่มหรือไม่

ไฟสีฟ้า ดับหรือไม่
ไฟสีแดง ดับหรือไม่

Push Button ปิด

รีเลย์ (Relay) ท�ำงาน

ไฟ Lamp สีฟ้า 

ไฟ Lamp สีแดง 

Push Button 

Realy

ปล่อย
กด

ปิด

ท�ำงาน

ไฟติด ไฟติด

ไฟติด
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RA
PB

BU

RD

RA

RA

แผนผังการเดินสายไฟ (Wiring diagram) หรือ โครงสร้างของเครื่องจักรนั้น ถ้าหากส�ำหรับงานเดินสายไฟแล้วถือว่าเป็นภาพที่เข้าใจได้ง่าย
แต่ถ้าเป็นงานวงจรไฟฟ้าที่มีความซับซ้อน อาจท�ำให้เข้าใจถึงล�ำดับการท�ำงานได้ยาก และเพื่อที่จะท�ำให้เกิดความเข้าใจได้มากยิ่งขึ้น  
เราลองมาจัดเป็นรูปแบบของ PLC drawing

แผนผังซีเควนซ์ (Sequence diagrams) จะถูกจัดท�ำขึ้นโดยเรียงตามล�ำดับของการท�ำงานที่มาจากวงจรไฟฟ้าจ�ำนวนมาก และมีการ 
จัดเรียงเนื้อหาแผนผังการเชื่อมต่อ เพื่อให้การท�ำงานเป็นไปอย่างเข้าใจง่าย อีกทั้งวิธีการจัดท�ำ Diagrams ในรูปแบบนี้นั้นมีการก�ำหนด 
ให้เป็นวิธีมาตรฐาน เมื่อบุคคลที่สามเข้ามาเปิดดูก็จะสามารถท�ำความเข้าใจได้ง่าย

การเดินสายไฟ (Wiring diagram)

แผนผังซีเควนซ์ (Sequence diagram)

แผนผังการเดินสายไฟ (Wiring diagram) และแผนผังซีเควนซ์ (Sequence diagram)

แหล่งจ่ายไฟฟ้ากระแสสลับ

Blue

Red

(หน้าสัมผัสปกติปิด b)

(หน้าสัมผัสปกติเปิด a)

Coil ของ RelayPush button 
switch

กระแสตรง

หมายเหต)ุ ดว้ยเครือ่งในการฝ กึสอนรุน่ FX-I/O-DEMO2 ทัง้รเีลย ์
และหลอดไฟจะท�ำงานดว้ยแหลง่จา่ยไฟฟา้กระแสตรง
ขนาด 24 V อยา่งไรกต็าม โดยทัว่ไปนัน้รเีลยจ์ะท�ำงาน
ดว้ยแหลง่จา่ยไฟฟา้กระแสตรงขนาด 24 V และหลอดไฟ
จะท�ำงานดว้ยแหลง่จา่ยไฟฟา้กระแสสลบัขนาด 100 V 
ซึง่แสดงอยู ่ในรูปดา้นลา่งนี้
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1.4.2	 ศึกษาจากตัวอย่างอื่น ๆ

ตัวอย่างที่ 2  : ควบคุมระดับน�ำ้ใน Tank

◎	รายละเอียดการควบคุมซีเควนซ์ (Sequence Control)

① �เมื่อมีการปิดสวิทซ์การ Start operation เกิดขึ้น เมื่อน�้ำเกิดการแห้ง Limit switch LS1 จะท�ำการปิด Magnet conductor MC จะ 
เริ่มท�ำงานเพื่อที่จะให้มอเตอร์ที่ใช้ในการเติมน�้ำเริ่มการท�ำงาน ถึงแม้ว่าน�ำ้จะอยู่ในระดับปานกลาง Magnet conductor MC จะท�ำงานเพื่อ
รักษาระดับของน�ำ้

② �ถ้าน�ำ้เต็ม Limit switch LS2 จะเปิด การท�ำงานของ Magnet conductor MC เพื่อการรักษาระดับจะถูกยกเลิก อีกทั้งมอเตอร์ที่ใช้ส�ำหรับ
การเติมน�้ำก็จะหยุดไปด้วย

③ �เมื่อน�้ำถึงระดับที่จ�ำเป็นต้องเติมน�้ำ มอเตอร์ที่ใช้ส�ำหรับการเติมน�้ำจะท�ำการเติมน�้ำแบบอัตโนมัติอีกครั้ง

จากการท�ำงานของมอเตอร์ผ่านการควบคุมชุดนี้ เมื่อน�ำ้เกิดการแห้งจนถึงระดับปานกลางมอเตอร์จะท�ำงาน
เมื่อน�้ำเกิดเต็มจนถึงระดับปานกลางมอเตอร์จะหยุดการท�ำงาน ถึงแม้จะอยู่ในระดับปานกลางเหมือนกันแต่สถานะการท�ำงานจะต่างกัน
ซึ่งเราเรียกการท�ำงานดังกล่าวว่า Hysteresis operation (การท�ำงานตามประวัติ) จากวิธีนี้เราสามารถลดปริมาณความถี่ในการเดินและ 
การหยุดของมอเตอร์ได้

M

ON

OFF

มอเตอร์ส�ำหรับเติมน�้ำ
Pump

Magnet Conductor MC

Operation start switch บ่อพักน�้ำ

Tank

LS2 (หน้าสัมผัสปกติปิด b) ท�ำงาน
เมื่อน�้ำเต็มแล้ว หน้าสัมผัส (Contact) 
จะเปิด (ไม่น�ำไฟฟ้า) Limit switch

LS1 (หน้าสัมผัสปกติเปิด a) ท�ำงาน 
เมื่อน�้ำเกิดการแห้ง หน้าสัมผัส (Contact) 
จะปิด (น�ำไฟฟ้า) Limit switch
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●	แผนผังซีเควนซ์ (Sequence diagram)

※1	 ซีเควนซ์ (Sequence) ในบริเวณนี้จะถูกเปลี่ยนไปยัง PLC ตามปกติ

※2	 เกี่ยวกับ Self-holding circuit (วงจรคงสภาพตัวเอง)
	� Self-holding circuit (วงจรคงสภาพตัวเอง) คืออะไร อุปกรณ์ที่ต้องรับค�ำสั่งจากภายนอกอย่างเช่น รีเลย์ (Relay), Magnet 

conductor MC 
	� จากหน้าสัมผัส (Contact) ที่มีอยู่ในตัวรีเลย์ (Relay), Magnet conductor MC จะท�ำการ Bypass และสร้างวงจรการท�ำงานขึ้น
	� อีกทั้ง Self-holding circuit จะแบ่งเป็นแบบปุ่มกดซึ่งจะมีการตัดเมื่อท�ำการปล่อยปุ่มหรือแบบที่มีหน่วยความจ�ำ ซึ่งจะสามารถท�ำให้

เกิดการท�ำงานแบบต่อเนื่องได้ 
	� ในกรณีนี้จะมีการต่อ Limit switch LS1 แบบขนานต่อเข้ากับ หน้าสัมผัส (Contact) ของ Magnet conductor MC 
	 เพื่อใช้ในการขับเคลื่อนมอเตอร์ ซึ่งเราเรียกวงจรแบบนี้ว่า Self-holding circuit

※3	� ส�ำหรับ Limit switch LS2 นั้นมีหน้าที่ในการตัดวงจรของ ※2 Self-holding circuit หรือหยุดการท�ำงานของมอเตอร์ในการเติมน�ำ้ 
และเมื่อมีการต่อเข้ากับ หน้าสัมผัสปกติปิด b (N.C. Contacts) หรือ Limit switch LS2 เมื่อเกิดปัญหาหน้าสัมผัสเกิดผิดปกติ
ภายในวงจร หรือสายไฟเกิดขาด Self-holding circuit จะเกิดการตัด ท�ำให้มอเตอร์ส�ำหรับเติมน�้ำเกิดการหยุด

การท�ำงานของวงจรคงสภาพตัวเอง (Time chat)

Operation start switch

Limit switch LS2 

Limit switch LS1 

Magnet Conductor 

น�้ำเติม

น�ำ้แห้ง น�้ำแห้ง

MC ท�ำงาน (เติมน�้ำ) MC ท�ำงาน (เติมน�้ำ)

น�้ำแห้งถึงแม้ว่า Limit switch LS1 จะ
เกิดการตัด แต่เนื่องจาก Self-Holding 
Circuit จึงท�ำให้ Magnet Conductor 
MC ท�ำงานได้อย่างต่อเนื่อง

※Breaker … �อุปกรณ์ส�ำหรับการตัดกระแสไฟที่
วงจรไฟฟ้า ในกรณีที่เกิดกระแส 
ที่ผิดปกติ

MC

MC

M

MC

MC ※2

LS2
※3

※

LS1
※1

มอเตอร์ในการเติมน�ำ้Power 
Supply

Breaker จากการท�ำงานของ MC จะท�ำให้มอเตอร์
ส�ำหรับการเติมน�้ำท�ำงานไปด้วย

Start switch

Control power supply

หน้าสัมผัสปกติเปิด a
Operation start switch 
นั้นจะเป็นสวิทซ์ที่ยัง ON 
ถึงแม้ว่าจะมีการปล่อยมือ 

หน้าสัมผัสปกติปิด b
Limit switch จะเปิด 
ท�ำงานในกรณีที่มี
น�ำ้เติม

หน้าสัมผัสปกติเปิด a
Limit switch จะปิด
ท�ำงานในกรณีที่มี
น�ำ้เติม

Magnet 
Conductor
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1.5	� มาจ�ำสัญลักษณ์ที่เกี่ยวกับซีเควนซ์กันเถอะ
1.5.1	 ตารางตรวจสอบสัญลักษณ์หลักของซีเควนซ์

แยกตามหน้าสัมผัส (Contacts)

แยกตามผลิตภัณฑ์

หน้าสัมผัสปกติเปิด a 
(ปกติเปิดเสมอ)

หน้าสัมผัสปกติปิด b 
(ปกติปิดเสมอ) ทีม่าของการขบัเคลือ่น 

(Drive Source)
เขียนแนวนอน เขียนแนวตั้ง เขียนแนวนอน เขียนแนวตั้ง

Push button 
switch
(Automatic 
Restoration)

Manual

Push button 
switch
(Residual 
Movements)

Manual

Thermo Relay
(OCR)

Heater

Movements

Switch
(General) Manual

Limit switch
(Machine 
control)

Dock Cam

รีเลย์ (Relay)

Electrode Coil

Electrode 
Contactor
(Magnet 
Conductor)

Timer on Delay

Timer off Delay

（JIS C 0617）
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PLC คืออะไร…
	 PLC มีชื่อเรียกอีกชื่อหนึ่งว่า Programmable Controller (PLC) หรือ การควบคุมซีเควนซ์ Sequence 
Control (SC) ซึ่งมีค�ำนิยามเกี่ยวกับอุปกรณ์นี้ว่า “คือ สิ่งที่เอาไว้ควบคุมอุปกรณ์เครื่องจักรต่างๆ โดยผ่าน 
สิ่งที่เรียกว่า Input-Output ซึ่งเป็นอุปกรณ์อิเล็คทรอนิคที่ภายในประกอบไปด้วยหน่วยความจ�ำเพื่อจดจ�ำค�ำสั่ง 
ที่สามารถสั่งงานได้ด้วยโปรแกรม (Programmable)”

ที่จริงแล้ว…
	 มาถึงตอนนี้ ขอให้คิดว่า มันคือ อุปกรณ์ที่ท�ำให้ “การควบคุมซีเควนซ์ (Sequence Control)” ที่เคยกระท�ำ
โดยการเดินสายไฟ รีเลย์ (Relay) และ Timer ให้เกิดขึ้นได้จริงด้วย “โปรแกรม” ง่าย ๆ

บทที่ 2

PLC คืออะไร

PLC มันเป็นอย่างนี้นี่เอง!!!



2-2

2.1　PLC คืออะไร

2.1.1	 PLC มีไว้ท�ำอะไร

ภายในการควบคุมซีเควนซ์ (Sequence Control) จะมีสัญญาณค�ำสั่งเกี่ยวกับ “ใช้คนในการควบคุม” “ตรวจสอบสถานะของเครื่องจักร” หรือ
อาจจะเรียกว่าสัญญาณเกี่ยวกับเงื่อนไข อีกทั้งมีการเรียก “แจ้งสถานะของเครื่องจักรให้คนรู้” “ท�ำการขับเคลื่อนเครื่องจักร”

ซีเควนเซอร์ (Sequencer) หรือ PLC คือ “การควบคุมซีเควนซ์ (Sequence Control)” ที่อยู่ในรูปด้านบน มีหน้าที่ในการควบคุมอุปกรณ์เหล่า
นั้น ซึ่งหน้าที่ของ PLC หรือซีเควนเซอร์ (Sequencer) นั้นเป็นไปตามชื่อ นั่นก็คือการควบคุมซีเควนซ์ (Sequence Control) นั่นเอง	

ซีเควนเซอร์ (Sequencer) เป็นค�ำศัพท์ที่มิตซูบิชิ อีเล็คทริคสร้างขึ้นหรือ?
โดยทั่วไปมีการใช้ชื่อ “ซีเควนเซอร์ (Sequencer)” กันอย่างกว้างขวาง ในปัจจุบันสมาคมผู้ผลิตเครื่องใช้ไฟฟ้าประจ�ำประเทศญี่ปุ่น 
(JEMA) มีชื่อเรียกอย่างเป็นทางการว่า Programmable Controller (PLC) ซึ่งจะเรียก PLC หรือ Sequencer ก็ได้ แต่ในประเทศไทย
นิยมเรียกกันว่า PLC และในเอกสารชุดนี้จะใช้ค�ำว่า PLC เป็นหลัก แต่เดิมชื่อ “Sequencer” มีประวัติการใช้งานมาก่อนค�ำว่า PLC ใน
บางส่วน ซึ่งหลังจากที่ Mitsubishi Electric ได้วางจ�ำหน่าย PLC ในชื่อ Sequencer โดยที่รุ่นที่เป็นตัวแทนหลักจะเป็น K Series  
และ F Series

อ้างอิง

スイッチなど

人が操作する
もの

人に機械の状態を
知らせるもの

機械を動かすもの

センサなど モータや電磁弁など

シーケンス制御

機械の状態を
検出するもの

ランプやブザーなど

人

機械

คน

การควบคุมซีเควนซ์ (Sequence Control)

ใช้คนในการควบคุม

แจ้งสถานะของเครื่อง
ให้กับคนรู้

เพื่อเดินเครื่องจักร

ตรวจสอบสถานะ 
ของเครื่องจักร

Switch หลอดไฟ (Lamp) หรือ

Sensor Motor หรือ Solinoid Valve

เครือ่งจกัร
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2.2　องค์ประกอบของ PLC

2.2.1	 การควบคุมซีเควนซ์ (Sequence Control) ท�ำได้อย่างไร

PLC จะมีการเชื่อมต่อกับ Load ส�ำหรับการขับเคลื่อนโดยมีเงื่อนไขของสัญญาณหรือค�ำสั่งที่เป็นสัญญาณ  
ในแต่ละอุปกรณ์ตามเนื้อหาในหน้าซ้ายมือ อีกทั้งสิ่งที่จะเชื่อมต่อกับฝั่ง Input คือ “อุปกรณ์ Input” และสิ่งที่จะเชื่อมต่อกับฝั่ง Output เรียกว่า 
“อุปกรณ์ Output”  
ซึ่งอุปกรณ์ Input-Output จะมีการเชื่อมต่อระหว่าง PLC กับ ขั้วต่อ (Terminal) ในแต่ละตัว 

ส�ำหรับ PLC สามารถเชื่อมต่อกับอุปกรณ์ Input-Output ในแต่ละตัว การเชื่อมต่อเพื่อที่จะท�ำการควบคุมซีเควนซ์ (Sequence Control) นั้น 
จะมีขั้นตอนอิเล็กทรอนิกส์ภายใน PLC 

การเชื่อมต่อกับภายใน PLC จะมีการใช้ค�ำศัพท์เฉพาะ (ค�ำสั่ง) ส�ำหรับ Sequence  
ซึ่งอุปกรณ์ที่มีการน�ำค�ำสั่งทั้งหมดมาประกอบกันคือ ซีเควนซ์โปรแกรม (Sequence program) โดยที่เราจะมีการควบคุมซีเควนซ์ (Sequence 
Control) ผ่าน Program นี้  
เพราะฉะนั้นไม่จ�ำเป็นที่จะต้องเดินสายไฟภายนอก

リミットスイッチ
コンタクタ

ランプ

電源

電源

切換えスイッチ

リレー

押しボタンスイッチ

《入力機器》

《出力機器》

入
力
イ
ン
タ
フ
ェ
ー
ス

出
力
イ
ン
タ
フ
ェ
ー
ス

シーケンサ

メモリ

マイクロコンピュータ

ハンディ
プログラミングパネル

パソコン (プログラミング用
ソフトウェア )

記憶部

演算部

(อุปกรณ์ส�ำหรับการ Programmer)

(อุปกรณ์ Input)
Limit switch

Sequencer

Memory

Micro computer

ส่วนความจ�ำ

ส่วนค�ำนวณ

Conductor

Lamp

PC (Software ส�ำหรับการ
Programmer)

Handy programming

Relay

Selector switch

Push button switch

Power

Power

In
pu

t i
nt

er
fa

ce

O
ut

pu
t i

nt
er

fa
ce

(อุปกรณ์ Output)

Solinoid valve
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อุปกรณ์ Input อุปกรณ์ Output ซีเควนซ์โปรแกรม (Sequence program) มีโครงสร้างตามรูปภาพด้านบน

อุปกรณ์ Input เชื่อมต่อกับ Input relay ของ PLC และอุปกรณ์ Output ท�ำการควบคุมผ่านหน้าสัมผัสส�ำหรับ Output ภายนอก (External 
output)

●● Input relay

Input relay มีหน้าที่ในการแปลงสัญญาณที่รับจากอุปกรณ์
ภายนอกแล้วส่งไปยัง PLC ตามรูปภาพด้านบน อุปกรณ์ Input 
สามารถท�ำงานได้เพียงแค่เชื่อมต่อระหว่าง Input terminal กับ 
COM terminal อีกทั้ง หน้าสัมผัสของ Relay โดยทั่วไป ถึงแม้จะ
เป็นจ�ำนวนมากแต่มีแค่ไม่กี่หน้าสัมผัสเท่านั้น
แต่ภายในซีเควนซ์โปรแกรม มีจ�ำนวนหน้าสัมผัสอยู่นับไม่ถ้วน

ภายใน PLC จะมี Power ส�ำหรับ Input relay อยู่ เมื่อหน้า
สัมผัส (Contact) ของอุปกรณ์ Input มีการน�ำกระแส  
กระแสไฟจะท�ำการไหลเหมือนกับเส้นประ ซึ่งจะท�ำให้ Input 
relay สามารถขับเคลื่อนได้

ตามที่ได้อธิบายไปในเบื้องต้นระหว่าง PLC กับอุปกรณ์ Input 
นั้น ไม่ส�ำคัญว่าต้องเป็นหน้าสัมผัสปกติเปิด a (N.O. Contact) 
หรือ หน้าสัมผัสปกติปิด b (N.C. Contact) เพราะว่าถ้ามีการน�ำ
กระแสเกิดขึ้นระหว่าง COM กับ Input terminal ซึ่งหน้าสัมผัส
ที่ปิดจะเป็นหน้าสัมผัสปกติเปิด a (N.O. Contact) และถ้าหน้า
สัมผัสเปิดจะเป็นหน้าสัมผัสปกติปิด b (N.C. Contact)

●● หน้าสัมผัสส�ำหรับ Output

หน้าสัมผัสส�ำหรับ Output นั้น คือหน้าสัมผัสส�ำหรับขับเคลื่อน
โหลด (Load) จากภายนอก โดย Input relay ที่ขับเคลื่อนด้วย 
ซีเควนซ์โปรแกรม
หน้าสัมผัสส�ำหรับ External output นั้นสามารถเชื่อมต่อกับ
อุปกรณ์ที่มีกระแสไฟต่างกัน อย่างเช่น COM ที่มีหน่วยเป็น AC 
(กระแสสลับ) / DC (กระแสตรง)

เมื่อ Output Relay ที่อยู่ในซีเควนซ์โปรแกรม (Sequence 
program) เกิดการขับเคลื่อน หน้าสัมผัสส�ำหรับ External 
output จะปิด
โดยที่กระแสไฟที่จะใช้ขับเคลื่อนอุปกรณ์ Output นั้น ต้องจัด
เตรียมจากภายนอกของ PLC

2.2.2	 หากมีการรวมระหว่าง รีเลย์ (Relay) กับ Timer 

COM
“ü—Í’[Žq

“ü—Í‹@Ší

การท�ำงาน COM
Input terminal

Input relay

PLC

อุปกรณ์ Input

入力リレー

出力リレー

補助リレー

タイマ 負荷

電源

外部出力用接点
入力配線 入力回路 内部シーケンス 出力回路 出力配線

シーケンサ

ヒューズ

Load

Input relay ON/OFF
ตามสัญญาณจากภายนอก

ซีเควนซ์โปรแกรมท�ำงานด้วย
หน้าสัมผัสของ Input relay

PLC

Output relay

Timer

Support relay

Output circuit Output wire

Load

Power
Fuse

External contact outputInput relay

Input circuit Inside sequenceInput wire

Output relay ON/OFF
ท�ำงานและส่งต่อ

อุปกรณ์ภายนอก Load
ท�ำงานหรือเคลื่อนที่

COM
“dŒ¹

การท�ำงาน
PLC อุปกรณ์ 

Output

แหล่งจ่ายไฟ
Power

หน้าสมัผสัส�ำหรบั External output

Output terminal
COM
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อุปกรณ์ Input-Output ที่ต่อเข้ากับ Input และ Output terminal นั้น มีการแบ่งอุปกรณ์ (Device) ในแต่ละขั้วต่อ (Terminal) (หรืออาจจะเป็น 
หมายเลข In-Output) เพื่อเทียบ Input relay กับ Output relay ของซีเควนซ์โปรแกรม (Sequence program)
ภายในอุปกรณ์ (Device) จะมีหมายเลขในแต่ละขั้วต่อ (Terminal) นอกเหนือจากนั้นภายใน Sequence จะประกอบไปด้วย Timer และ 
Counter

●	 อุปกรณ์ (Device) …	� ภายในอุปกรณ์ (Device) จะมีสัญลักษณ์ของอุปกรณ์ (Device) เพื่อการแสดงหน้าที่ของอุปกรณ์ (Device) และ
ประกอบไปด้วยหมายเลขอุปกรณ์ (Device) ที่มีโครงสร้างแยกเป็นอย่างละตัว (ซึ่งบางทีเราจะเรียกอุปกรณ์ 
(Device) ว่า Element number)

Input relay  : X000 ~ X177 (128 จุด) ＊ 1

มีหน้าที่เป็น Window เพื่อเปิดรับสัญญาณจาก Input switch 
ที่อยู่ภายนอกของ Sequence จะแทนสัญลักษณ์อุปกรณ์ 
(Device) เป็น X
ภายในประกอบไปด้วย Input relay ที่ตอบสนองจ�ำนวนของ 

Input (จ�ำนวนขั้วต่อ Terminal)

Output relay  : Y000 ~ Y177 (128 จุด) ＊ 1

มีหน้าที่เป็น Window เพื่อขับเคลื่อน Load ที่อยู่ภายนอกของ 
PLC จะแทนสัญลักษณ์อุปกรณ์ (Device) เป็น Y
ภายในประกอบไปด้วย หน้าสัมผัส (Contact) ส�ำหรับ Output ที่

ตอบสนองจ�ำนวนของ Output (จ�ำนวนขั้วต่อ Terminal)

Auxiliary relay  : M0 ~ M7679 (7680 จุด) ＊ 1

เป็น Auxiliary relay รีเลย์เสริมที่ประกอบอยู่ภายใน PLC
(บางทีเรียกว่ารีเลย์ภายใน หรือ Inside relay)

Timer  : T0 ~ T319 (320 จุด) ＊ 1

Timer เป็นอุปกรณ์ที่อยู่ภายใน Sequence  
มีหน้าที่ในการจับเวลา และประกอบไปด้วย Coil กับ หน้าสัมผัส 
(Contact) เมื่อถึงเวลาที่ก�ำหนด หน้าสัมผัส (Contact) จะท�ำ 
การปิด

Counter  : C0 ~ C199 (200 จุด) ＊ 1

Counter เป็นอุปกรณ์ที่อยู่ภายใน PLC
มีหน้าที่ในการนับจ�ำนวน เมื่อถึงจ�ำนวนที่ก�ำหนดหน้าสัมผัส 
(Contact) จะปิด

●	� Input relay, Output relay, Auxiliary relay, Timer, Counter จ�ำนวนของอุปกรณ์เหล่านี้ ที่สามารถใช้ได้นั้นต่างกันไปขึ้นอยู่กับประเภท
ของ PLC

เลขฐาน 10, เลขฐาน 8, เลขฐาน 16

อุปกรณ์ (Device) จะมีทั้งเลขฐาน 10 หรือนอกเหนือจากนั้นจะมีเลขฐาน 8 หรือ เลขฐาน 16 ตามตารางอีกด้วย

Input relay, Output relay Auxiliary relay, Timers, Counters

Micro PLC FX Series เลขฐาน 8 เลขฐาน 10

General PLC Q/QnA/A Series เลขฐาน 16 เลขฐาน 10

เลขฐาน 10 คืออะไร	� โดยทั่วไปจะใช้ 0 ~ 9, 10 ~ 19, 20 ~ 29, … จะเป็นวิธีการค�ำนวณที่มีการปัดหน่วยที่เป็น 10 ขึ้น

เลขฐาน 8 คืออะไร	 0 ~ 7, 10 ~ 17, 20 ~ 27, … จะเป็นวิธีการค�ำนวณที่มีการปัดหน่วยที่เป็น 8 ขึ้น

เลขฐาน 16 คืออะไร	� 0 ~ 9, 0A, 0B, 0C, 0D, 0E, 0F, 10 ~ 19, 1A, 1B, 1C, 1D, 1E, 1F, … จะเป็นวิธีการค�ำนวณ 
ที่มีการปัดหน่วยที่เป็น 16 ขึ้น

อ้างอิง

＊1 : เป็นขอบเขตการท�ำงานของอุปกรณ์ (Device) รวมถึงจ�ำนวนจุดของ PLC รุ่น FX3G Series 
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ซีเควนซ์โปรแกรม (Sequence program) ใน PLC นั้น มีอุปกรณ์ Input ที่มีสายต่อจากภายนอกเข้าไปในแต่ละขั้วต่อ (Terminal) และมี
อุปกรณ์ Output ที่เปรียบเสมือนวงจรไฟฟ้าเป็นการควบคุมซีเควนซ์ (Sequence Control) ..... ส�ำหรับรายละเอียดที่เกี่ยวกับค�ำสั่ง  
ตรวจสอบได้ในบทที่ 4
ต่อไปจะเป็นการอธิบายเกี่ยวกับแผนผังซีเควนซ์ (Sequence diagram) และซีเควนซ์โปรแกรม (Sequence program)
ตัวอย่างหน้า 1-13 เมื่อมองการควบคุมระดับน�ำ้ในแท๊งก์เป็นซีเควนซ์โปรแกรม (Sequence program)

พอมีการมองสลับกันแล้ว มีจุดไหนที่แตกต่างกันบ้างจะขออธิบายดังต่อไปนี้

① วิธีการแสดง หน้าสัมผัสปกติเปิด a (N.O. Contact) หน้าสัมผัสปกติปิด b (N.C. Contact)

② ไม่สามารถแสดงออกเป็นแบบวงจรไฟฟ้าได้
③ ส�ำหรับซีเควนซ์โปรแกรม (Sequence program) จะอธิบายโดยใช้อุปกรณ์ (Device) (Element number) ตามที่อธิบายไว้ในก่อนหน้านี้

④ ตามแผนผังซีเควนซ์ (Sequence diagram) แล้ว LS2 ก็คือ หน้าสัมผัสปกติปิด b (N.C. Contact) และซีเควนซ์โปรแกรม (Sequence 
program) คือ หน้าสัมผัสปกติเปิด a (N.O. Contact)
เริ่มแรกจากแผนผังซีเควนซ์ (Sequence diagram) ของ LS2 ด้านบนมีหน้าที่ตัดวงจรสภาพตัวเอง Self-hold circuit ส�ำหรับ MC ซึ่งเป็น
อุปกรณ์ที่ใช้เพื่อการหยุด MC โดยในปกติแล้วจะอยู่ในสถานะน�ำกระแสอยู่ในวงจรไฟฟ้าอยู่ตลอดเวลา

ข้อส�ำคัญ

2.2.3	� แผนผังซีเควนซ์ (Sequence diagram) และซีเควนซ์โปรแกรม 
(Sequence program)

แผนผังซีเควนซ์ (Sequence diagram) ซีเควนซ์โปรแกรม (Sequence program)

Relay sequence diagram

หน้าสัมผัสปกติเปิด a 
(N.O. Contact)

หน้าสัมผัสปกติเปิด a 
(N.O. Contact)

หน้าสัมผัสปกติปิด b 
(N.C. Contact)

หน้าสัมผัสปกติปิด b 
(N.C. Contact)

sequence program
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การท�ำงานของ “หน้าสัมผัสปกติเปิด a (N.O. Contact)” “หน้าสัมผัสปกติปิด  
b (N.C. Contact)” ในซีเควนซ์โปรแกรม (Sequence program)

การท�ำงานของ “หน้าสัมผัสปกติเปิด a (N.O. Contact)” “หน้าสัมผัสปกติปิด b (N.C. Contact)” ผ่าน Sequen program นั้น  
ถ้า Input relay ท�ำงานเหมือนกับหน้า 2-4 จะเกิดเงื่อนไขขึ้นตามเนื้อหาด้านล่าง

•	 เมื่ออุปกรณ์ Input มี “สถานะไม่มีไฟฟ้าไหลผ่าน” เข้าไปใน PLC ก็จะท�ำให้ “วงจรภายในโปรแกรมปิด” ก็จะเป็น “หน้าสัมผัสปกต ิ
เปิด a (N.O. Contact)” และในทางกลับกันจะกลายเป็น “หน้าสัมผัสปกติปิด b (N.C. Contact)” เมื่อ “วงจรภายในโปรแกรมเปิด”

•	 เมื่ออุปกรณ์ Input มี “สถานะมีไฟฟ้าไหลผ่าน” เข้าไปใน PLC ก็จะท�ำให้ “วงจรภายในโปรแกรมเปิด” ก็จะเป็น “หน้าสัมผัสปกติเปิด a 
(N.O. Contact)” และในทางกลับกันจะกลายเป็น “หน้าสัมผัสปกติปิด b (N.C. Contact)” เมื่อ “วงจรภายในโปรแกรมปิด”

เพราะฉะนั้นเพื่อที่จะให้สถานะในการท�ำงานเหมือนกันกับ Sequence diagram ในหน้า 1-14 นั้น จ�ำเป็นต้องก�ำหนดสัญญาณของ LS2 
ที่อยู่ใน Sequencer program ให้เป็น “หน้าสัมผัสปกติเปิด a (N.O. Contact)”  
รายละเอียดให้อ้างอิงจากรูปภาพ (1) ~ (2) ในด้านล่าง

อ้างอิง

(1)	 สาเหตุที่ใช้ LS2 (X2) เป็นหน้าสัมผัสปกติเปิด a (N.O. Contact)
	 ① ในกรณีที่ก�ำหนดจุดหน้าสัมผัส (Contact) ให้เป็นหน้าสัมผัสปกติปิด b (N.C. Contact) เหมือนกันกับ Sequence diagram

	 ② ในกรณีที่มีการก�ำหนดจุดหน้าสัมผัส (Contact) ให้เป็นหน้าสัมผัสปกติเปิด a (N.O. Contact)

● แนวคิดในเรื่องโปรแกรม

	� เมื่อมีสัญญาณจากภายนอกเข้ามาที่ Input … หน้าสัมผัสปกติเปิด a (N.O. Contact) จะเป็นตัวน�ำกระแสหน้าสัมผัสปกติ
ปิด b (N.C. Contact) จะเป็นตัวไม่น�ำกระแส

น�้ำแห้ง

เริ่มต้น

น�้ำแห้ง

น�้ำเต็ม

หน้าสัมผัส
ปกติปิด b

หน้าสัมผัสปกติปิด b
วงจรเปิด วงจร

ปิด
Pump จะอยู่
ในสภาพ OFF

เมื่อมีการ ON จะเป็นสภาพ
ไม่น�ำกระแส

วงจรเปิด (open circuit) จะถูก
ส่งในฐานะสัญญาณ ON

หน้าสัมผสั
ปกตปิิด b

น�้ำแห้ง

เริ่มต้น

น�้ำแห้ง

น�้ำเต็ม

หน้าสัมผัส
ปกติปิด b

หน้าสัมผัสปกติเปิด a
วงจรปิด

Pump ON

จะน�ำกระแสเมื่อมีการ ON

หน้าสัมผสั
ปกตเิปิด a

วงจร
เปิด
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(2)	 Flow การควบคุมระดับน�้ำใน Tank
	 ● เมื่อระดับน�ำ้อยู่ตรงกลางปั๊มจะ OFF

	 ● เมื่อระดับน�ำ้ใน Tank อยู่ในระดับแห้ง

	 ● เมื่อปั๊ม ON แสดงว่าน�้ำก�ำลังเติม

	 ● เมื่อระดับน�ำ้ใน Tank เต็ม

เริ่มต้น Pump 
ON

เมื่อ LS1 เกิด ON Pump 
ก็จะ ON

น�้ำแห้ง

น�้ำแห้ง

น�้ำเต็ม

เริ่มต้น Pump 
ON

เมื่อ LS1 เกิด OFF ปั๊มจะเข้า
สู่โหมดรักษาตัวเองซึ่งจะ
ท�ำการ ON อย่างต่อเนื่อง

น�้ำแห้ง

น�้ำเต็ม

เริ่มต้น Pump 
OFF

เมื่อ LS2 เกิด ON  
ปั๊มจะท�ำการ OFF

น�้ำแห้ง

น�้ำแห้ง

น�้ำเต็ม

เริ่มต้น

น�้ำแห้ง

น�้ำเต็ม

Pump 
OFF
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2.3	 การเดินสายไฟและโปรแกรม

2.3.1	 การเดินสายไฟของ PLC และโปรแกรมมีลักษณะอย่างไร

รูปด้านล่างระบุให้เห็นรายละเอียดของแผนผังวงจรไฟฟ้าในหน้า 1-14

สายไฟส�ำหรับ PLC สามารถท�ำงานแยกระหว่างสาย Input-Output กับสายไฟภายในได้

ส�ำหรับสาย Input-Output จ�ำเป็นต้องใช้ประแจหรือไขควงในการ

ปฏิบัติงานเหมือนเดิม

อีกทั้งการเชื่อมโยงระหว่าง Input terminal กับ Input relay coil หรือการเชื่อมโยงระหว่าง External contact output กับ Output terminal นั้น 
จะสามารถใช้งานได้ตั้งแต่มีการผลิตที่โรงงาน

ส�ำหรับสายไฟภายในที่มีความซับซ้อนนั้น (Sequence 
program) สามารถใช้ Control keyboard ส�ำหรับ PC หรือ 
Programming panel ในการควบคุมได้อย่างสะดวกง่ายดาย

入力配線

ヒューズ

線配力出ムラグロプスンケーシสาย Input ซีเควนซ์โปรแกรม (Sequence program) สาย Output

Fuse
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	 ประหยัดค่าใช้จ่าย
	 ส�ำหรับตู้ควบคุม (Control panel) ที่มีการใช้ Relay หรือ Timer มากกว่า 10 ตัว การแทนที่ด้วยการใช้ PLC จะถือว่าได้
เปรียบกว่าในด้านเศรษฐกิจ

	 ช่วยทุ่นแรงในด้านการออกแบบ
	 ช่วยท�ำให้ขั้นตอนการออกแบบซีเควนซ์และการออกแบบการเดินสายไฟส�ำหรับอุปกรณ์ต่างๆ ท�ำได้ง่ายขึ้น อีกทั้งง่ายและ
สะดวกในการท�ำทดสอบการท�ำงานของเครื่อง ช่วยลดขั้นตอนในการออกแบบกว่าในอดีต

	 ลดขั้นตอนการท�ำงาน
	 ลดขั้นตอนจากการต้องเตรียมชิ้นส่วนประกอบ สามารถเตรียมเครื่องจักรพร้อมกับการเตรียมตู้ควบคุมได้ในเวลาเดียวกัน 
และมีความยืดหยุ่นในการเปลี่ยนรายละเอียดงาน ช่วยท�ำให้การเดินสายไฟท�ำได้ง่ายขึ้น จึงท�ำให้สามารถลดขั้นตอนใน 
การท�ำงานได้หลายขั้นตอน

	 ขนาดกะทัดรัดและเป็นมาตรฐานเดียวกัน
	 เมื่อเทียบกับการติดตั้งแผงรีเลย์แล้วถือว่ามีขนาดที่กะทัดรัดกว่า อีกทั้งยังสามารถสร้างมาตรฐานด้วยการน�ำเอาโปรแกรม 
ที่เขียนขึ้นกลับมาใช้ใหม่ได้เรื่อยๆ

	 เพิ่มความเชื่อมั่น
	 ลดปัญหาที่เกิดจาก Relay หรือ Timer เพียงแค่มีการตรวจเซ็ทในครั้งแรก แล้วจากนั้นก็สามารถใช้งานได้อย่างอุ่นใจ

	 พัฒนาความสามารถด้านการบ�ำรุงรักษา
	 บ�ำรุงรักษาง่ายและรวดเร็วด้วยฟังก์ชันการตรวจสอบความเสียหาย หรือตรวจสอบอายุการใช้งานของชิ้นส่วนที่มีระยะอายุ
การใช้งานสั้นๆ ได้ (Self-diagnostic functions)

1
2
3
4
5
6

2.4　ข้อดีของการใช้งาน PLC

2.4.1	 ประโยชน์ที่จะได้รับจากการใช้งาน PLC
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ความเป็นมาของ PLC อย่างย่อ
เริ่มจากการที่บริษัท GM (General Motors) ในอเมริกามีความประสงค์ที่จะพัฒนาค้นคว้าเกี่ยวกับ PLC จึงท�ำให้ PLC ได้ถูกคิดค้นขึ้น
ในปี 1968 และในปี 1969 อเมริกาได้เริ่มวางจ�ำหน่ายในตลาด ส�ำหรับในประเทศญี่ปุ่นได้ให้ก�ำเนิดรุ่นแรกในประเทศขึ้นในปี 1970 แต่
ส�ำหรับรุ่นทั่วไปนั้นจะเกิดขึ้นหลังจากปี 1976 บริษัท Mitsubishi Electric เป็นผู้เปิดตลาดโดยการวางจ�ำหน่ายรุ่นทั่วไปตั้งแต่ปี 1977 
โดยผลิตรุ่นที่เป็นแบบ One-board จนติดตลาดและเป็นที่รู้จักกันทั่วไป หลังจากนั้นในปี 1980 ได้มีการวางจ�ำหน่ายรุ่น K-Series ที่ม ี
การติดตั้งฟังก์ชันการค�ำนวณและจัดการเรื่องตัวเลข (Numeric value processing functions) และในปี 1981 ถือเป็นจุดเริ่มในการ 
วางจ�ำหน่าย Micro PLC F-Series ที่มีการติดตั้งโปรแกรม (Built-in programmer) และเข้าสู่ยุคที่เริ่มใช้ PLC อย่างแพร่หลาย 
ในปัจจุบัน

อ้างอิง

วธิีการ

หวัขอ้
การควบคมุรเีลย ์ (Relay control) การควบคมุ PLC (PLC control)

1 ความสามารถ (Function)
ถ้าใช้ Relay หลายตัวก็สามารถควบคุมแบบการท�ำงาน
ที่ซับซ้อนได้

สามารถควบคุมการท�ำงานที่ซับซ้อนได้มากมาย 
ด้วยโปรแกรม

2 การเปลี่ยนแปลงเนื้อหา 
การควบคุม

ไม่มีวิธีอื่นนอกเหนือจากการเปลี่ยนการเดินสายไฟ สามารถท�ำได้โดยอิสระ เพียงแค่เปลี่ยนโปรแกรม

3  ความเชื่อมั่น
ถ้ามีการใช้งานตามปกติจะไม่มีปัญหา แต่จะมีจ�ำกัดใน
เรื่องของหน้าสัมผัสไม่ดีและเรื่องของอายุการใช้งาน

ชิ้นส่วนที่ส�ำคัญใช้วัสดุทั้งหมดเป็นกึ่งตัวน�ำไฟฟ้า 
จึงได้รับความไว้วางใจสูง

4 คุณสมบัติโดยทั่วไป อุปกรณ์ที่ท�ำเสร็จนั้นไม่สามารถน�ำไปใช้อย่างอื่นได้ ขึ้นอยู่กับโปรแกรมสามารถควบคุมประเภทไหนก็ได้

5 การขยายเครื่องจักร 
(Expandability)

จ�ำเป็นต้องมีการเพิ่มหรือมีการสร้างใหม่ซึ่งมีความยาก
ล�ำบาก

สามารถขยายได้ตามอิสระจนเต็มขีดความสามารถ

6 ความง่ายดาย 
ในการดูแลรักษา

จ�ำเป็นต้องมีการตรวจสอบเป็นระยะ และเปลี่ยนชิ้นงาน
ตามอายุการใช้งาน

สามารถท�ำการซ่อมบ�ำรุงได้เพียงแค่การเปลี่ยนยูนิต

7 ความหลากหลาย 
ด้านฟังก์ชัน

ท�ำได้เฉพาะการควบคุมรีเลย์ (Relay control)
นอกเหนือจาก Sequence program แล้ว ยังสามารถ
ควบคุมอื่นๆ เช่น อนาล็อก (Analog) หรือ การก�ำหนด
ต�ำแหน่ง (Positioning) ได้อีกด้วย

8 ขนาดเครื่องจักร มีขนาดใหญ่ทั่วๆ ไป
ถึงแม้จะเป็นการควบคุมระดับสูงและซับซ้อน ก็ไม่ท�ำให้
เครื่องจักรมีขนาดใหญ่ขึ้นกว่าเดิม

9 ระยะเวลาในการออกแบบ 
และการจัดท�ำ

ใช้เวลานาน ไม่ว่าจะเป็นการจัดท�ำ Drawing จ�ำนวน
มาก การจัดหาชิ้นงานและการทดสอบประกอบ

ถึงจะเป็นการควบคุมที่ซับซ้อน ก็สามารถท�ำการ
ออกแบบได้อย่างง่ายดาย ไม่สร้างขั้นตอนในการจัดท�ำ

2.4.2	 เปรียบเทียบกับการควบคุมรีเลย์ (Relay control)
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เรามาลองสร้างโปรแกรมโดยการใช้คอมพิวเตอร์กันเถอะ!

บทที่ 3

การใช้งานโปรแกรม GX Works 2

ขอแค่ใช้คอมพิวเตอร์เป็น ซีเควนซ์ (Sequence) ก็เป็นเรื่องง่ายๆ…
	 ในการจะสร้างหรือแก้ไขซีเควนซ์โปรแกรม (Sequence program) สามารถด�ำเนินการได้อย่างง่ายดาย 
เสมือนการวาดรูปง่ายๆ ด้วยซอฟแวร์ส�ำหรับติดตั้งในคอมพิวเตอร์ GX Works 2 
เพียงแค่เรียนรู้พื้นฐานการใช้งานเบื้องต้น ที่เหลือก็แค่การฝึกให้เกิดความช�ำนาญ
เป็นซอฟแวร์ (Software) ที่มีฟังก์ชันที่ใช้งานง่ายและหลากหลาย ก่อนอื่นเรามาเรียนรู้และความรู้จักกับ 
การใช้งานที่จ�ำเป็นตามล�ำดับเพื่อให้เกิดความเชี่ยวชาญ และช�ำนาญในการใช้งานกันเถอะ

การเรียกใช้งานและการปรับปรุงแก้ไขก็สามารถด�ำเนินการ 
ได้อย่างราบรื่น …

	 การสร้างโปรแกรม (Program) กับการแก้จุดบกพร่อง (Debug) เป็นของคู่กัน
เนื่องจากสามารถท�ำการแสดงผล (Monitoring) สภาพการท�ำงานของ Program และ PLC ได้จาก 
จอคอมพิวเตอร์จึงสะดวกในการตรวจสอบการท�ำงานและแก้ไขให้เป็นไปตามที่ต้องการได้อย่างรวดเร็ว

โปรแกรม (Program) ดูง่ายไม่ซับซ้อน …

	 เพื่อให้สามารถดูซีเควนซ์โปรแกรม (Sequence program) ได้ง่ายขึ้น ภายใน GX Works 2 จึงมีฟังก์ชัน  
“Comment input function”
เพียงแค่กรอก Comment เอาไว้ก็จะท�ำให้เข้าใจโปรแกรมได้ง่ายขึ้นและช่วยเพิ่มประสิทธิภาพในการจัดท�ำ 
ซีเควนซ์โปรแกรม (Sequence program) และ Debug ได้
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เปลี่ยนขนาดหน้าจอหรือจบการท�ำงาน

แสดงชื่อ Project ท�ำการย่อขนาดหน้าจอ ท�ำการจบการท�ำงานหน้าจอนี้

ขยาย ย่อ ขนาดหน้าจอ

3.1　ความรู้พื้นฐานเพื่อการใช้งานโปรแกรม

3.1.1	 โครงสร้างหน้าจอ

①	Title bar 
จะแสดงชื่อ Project ที่กำ�ลังเปิดทำ�งานอยู่ และ Icon การทำ�งานของ Windows

① Title bar

④ Status bar

② Menu bar

⑥ Edit screen

③ Toolbar

⑤ Navigation 
	 window
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②	Menu bar

กดเลือกเมนู แล้วจะมีหน้าจอเมนูแสดงขึ้นมาด้านล่าง

③	Toolbar＊

＊ : รายละเอียดของ Toolbar เนื่องจากสามารถท�ำการเคลื่อนย้ายหรือเอาออกได้ ท�ำให้หัวข้อที่แสดงและการจัดวางแตกต่างกันไป

หัวข้อไหนที่มีการใช้งานบ่อยๆ จะเอามาวางเป็น Icon botton สามารถคลิกเลือกได้โดยตรง ซึ่งจะเสมือนการเลือกเครื่องมือจาก Menu bar

เมื่อน�ำเมาส์ไปวาง
จะปรากฏข้อความ
อธิบายรายละเอียด
ของฟังกช์ันนั้นๆ

แสดง Input mode ปัจจุบัน

CPU
type

The location 
of the CPU 
connected

Caps Lock
status

Num Lock
status

④	Status bar 
ท�ำการแสดงสภาพการท�ำงานและการตั้งค่า
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Switch tab

⑥	Edit screen

⑤	Navigation window

คลิก [POU] → [Program] →
[MAIN] จะปรากฏแผนผังวงจร (Circuit diagram)
ขึ้นมา

เมื่อใช้เมาส์คลิกจะปรากฏรายละเอียดของ Tools 
บน “Project”

เมื่อใช้เมาส์คลิกจะปรากฏรายละเอียดของเครื่อง 
ที่คอมพิวเตอร์ Connetion Destination ที่ด้านบน 
(PLC Connection)
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	 •	� Workspace	
Workspace คือตัวควบคุม Project หลายๆ ตัว ใน GX Works2 จะควบคุมให้มีชื่อ Program 1 ชื่อ  
ในการก�ำหนด Workspace ขอให้ก�ำหนดเป็น เช่น Windows® Explorer  ห้ามท�ำการเปลี่ยนแปลง

	 •	� “Project” ประกอบด้วย Program, Device comment, Parameter, Device memory 
ใน GX Works2 ข้อมูลทั้งหมดนี้ถูกรวมไว้ด้วยกันเรียกว่า “Project” และถูก Save ลงใน Folder โดยมีชื่อ Workspace

กรณีบันทึกแบบ Workspace

	

3.1.2	 Workspace และ Project

Workspace
เป็น Folder อยู่ใน Windows®

เป็น Folder อยู่ใน Windows®

Sequence program

Comments ของ device นั้นๆ

Data ของ PLC parameter

รายละเอียดค่า Device ปัจจุบัน หรือค่า Device ที่ Input 
เข้าไป

Project

Program

Device comment

Parameter

Device memory
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①	เลือก [Start] ในด้านล่างซ้ายหน้าจอ Windows แล้ว 
เลือกตามขั้นตอนด้านล่าง [Program]

②	Software เริ่มท�ำงาน

[GX Works2]

[GX Works2]
ท�ำการเลือกตามล�ำดับด้านบน

[MELSOFT Application]

3.2　�การเรียกใช้งานโปรแกรม (Starting GX Works2) และ
การสร้าง Project ใหม่ (New project)

3.2.1	 เรียกใช้งานโปรแกรม (Starting GX Works2)
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①	ท�ำการเลือก  จาก Toolbar หรือเลือก [Project] → 
[New Projcet] ( Ctrl + N ) จากเมนู

②	คลิกปุ่ม [▼] ตรง “PLC Series”

③	เลือก “FXCPU”

④	คลิกปุ่ม [ ▼ ] ตรง “PLC Type”

⑤	เลือก “FX3G/FX3GC”

	

3.2.2	 การสร้าง Project ใหม่ (New project)

① คลิก

① คลิก

④ คลิก

⑤ คลิก แล้วเลือก

③ คลิก แล้วเลือก

② คลิก
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⑥	คลิก OK

(ระวัง)	� “Project type” ให้เลือก “Simple Project” 
“Use Label” ตรวจสอบช่องว่างว่างอยู่หรือไม่ 
“Program Language” เลือกเป็น “Ladder”

⑦	หน้าจอ Project ใหม่จะปรากฏขึ้นอยู่ในสภาพพร้อมใช้งาน 
สามารถ Input program ได้

⑥ คลิก 

⑦ หน้าจอ Project ใหม่ 
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[Circuit ที่สร้างขึ้น]

◦	Function keys และสัญลกัษณ์ Circuit จะปรากฏทีแ่ผง Toolbar ดา้นบนหนา้จอ

	

　	 　　　　　　　　　　　　　　　　　　　　　　ปุ่มหลักที่ใช้ท�ำงาน

	

	

	

	

	

	

◦	เวลาใส่หน้าสัมผัสปกติเปิดเสมอ a  และ Coil ,  เทา่นัน้ ทีส่ามารถยอ่ function keys ได้

◦	ตัวหนังสือที่ใช้ในการ Input ทั้งหมดเป็นตัวอักษรภาษาอังกฤษพิมพ์เล็ก

Point

F5 F6 F7

F8

F9

F5

Shift Shift

F6

Shift

F9

Ctrl

F10

F9

Ctrl
+

+ + + +

Point

ในคู่มือฉบับนี้จะแสดงหมายเลข Input relay 
(X), Output relay (Y) ด้วยตัวเลข 3 หลัก 
“X000”, “Y000”
ในกรณีที่ Input จากคอมพิวเตอร์สามารถย่อได้
เป็น “X0”, “Y0” 

3.3	 การสร้างโปรแกรมหรือวงจร (Circuit)

3.3.1	 การสร้างโปรแกรมหรอืวงจร (Circuit) โดยใช้ฟังก์ชนัคย์ี (Function keys)
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⑥	จะปรากฏ Circuit ที่เรา Input ไว้แล้วขึ้นมา 
⑦	ท�ำการกด F7   

แล้ว Input “Y0”
⑧	ท�ำการยืนยันโดยกด Enter  หรือ [OK]

⑨	จะปรากฏ Circuit ที่เรา Input ไว้แล้วขึ้นมา 
⑩	ท�ำการกด Shift + F5   

แล้ว Input “Y0”
⑪	ท�ำการยืนยันโดยกด Enter  หรือ [OK]

③	จะปรากฏ Circuit ที่เรา Input ไว้แล้วขึ้นมา 
④	ท�ำการกด F6   

แล้ว Input “X0”
⑤	ท�ำการยืนยันโดยกด Enter  หรือ [OK]

①	กดที่ F5   
แล้ว Input “X2” 

②	ยืนยันโดยกด Enter  หรือกด [OK]

① Input “X2” ② กด Enter  

⑦ Input “Y0”

⑥ Circuit จะปรากฏขึ้นมา

⑧ กด Enter

④ Input “X0”

③ Circuit จะปรากฏขึ้นมา

⑤ กด Enter

กด ESC  หรือ [Exit] 
เพื่อท�ำการยกเลิก

⑩ Input “Y0”

⑨ Circuit จะปรากฏขึ้นมา

⑪ กด Enter
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⑫	จะปรากฏ Circuit ที่เรา Input ไว้แล้วขึ้นมา
⑬	เคลื่อนเคอร์เซอร์ไปไว้ที่หัวแถวของบรรทัดถัดไป
⑭	ท�ำการกด F5   

แล้ว Input “X3”
⑮	ท�ำการยืนยันโดยกด Enter  หรือ [OK]

⑯	จะปรากฏ Circuit ที่เรา Input ไว้แล้วขึ้นมา
⑰	ท�ำการกด F7

แล้ว Input “Y1”
⑱	ท�ำการยืนยันโดยกด Enter  หรือ [OK]

⑲	จะปรากฏ Circuit ที่เรา Input ไว้แล้วขึ้นมา

⑳	Compile Operation (ส�ำคัญ)

	 ท�ำการกด “Compile” เพื่อท�ำการยืนยัน Circuit ที่ยัง 
ไม่ได้รับการยืนยัน (ส่วนที่แสดงเป็นสีเทา) 
 
ขอให้เลือกด�ำเนินการตามขั้นตอนที่ระบุด้านล่าง

	 •	 กด F4  (Build)

	 •	 กด  จาก Toolbar

	 •	�ทำ�การเลือก [Conversion/Compile] → [Compile] 
จากเมนู

F4 (Build)

⑭ Input “X3”

⑫ Circuit จะปรากฏขึ้นมา

⑬ ย้ายเคอร์เซอร์

⑮ กด Enter  

⑰ Input “Y1”

⑯ Circuit จะปรากฏขึ้นมา

⑱ กด Enter  

⑲ Circuit จะปรากฏขึ้นมา

⑳ ท�ำการลบส่วนที่แสดงเป็นสีเทา

ท�ำการยืนยัน Circuit เพื่อลบส่วนที่ปรากฏเป็นสีเทา  
กรณีที่เกิด Error เคอร์เซอร์จะเคลื่อนไปในต�ำแหน่งที่ 
Circuit เป็น NG ขอให้ท�ำการแก้ไขให้ถูกต้อง
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[Circuit ที่จะสร้าง]

◦	ท�ำการคลิกเมาส์เลือกปุ่มเครื่องมือ และ Input สัญลักษณ์ของ Circuit ลงไป

	

　　　　　　　　　　　　　　　　　　　　　　　　　ปุ่มหลักๆ ที่ใช้งาน	

	

◦	ตัวอักษรส�ำหรับ Input เป็นตัวอักษรภาษาอังกฤษพิมพ์เล็ก

Point

Point

ในคู่มือฉบับนี้จะแสดงสัญลักษณ์ Input relay 
(X) Output relay (Y) ด้วยตัวเลข 3 หลัก 
“X000”, “Y000”  
ในกรณีที่ Input จากคอมพิวเตอร์สามารถย่อ
เป็น “X0”, “Y0” ได้

3.3.2	 การสร้างวงจร (Circuit) โดยใช้ Toolbar buttons
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⑥	จะปรากฏ Circuit ที่เรา Input ไว้แล้วขึ้นมา 
⑦	ท�ำการกด  จาก Toolbar button  

แล้ว Input “Y0”
⑧	ท�ำการยืนยันโดยกด Enter  หรือ [OK]

⑨	จะปรากฏ Circuit ที่เรา Input ไว้แล้วขึ้นมา 
⑩	ท�ำการกด  จาก Toolbar button  

แล้ว Input “Y0”
⑪	ท�ำการยืนยันโดยกด Enter  หรือ [OK]

③	จะปรากฏ Circuit ที่เรา Input ไว้แล้วขึ้นมา 
④	ท�ำการกด  จาก Toolbar button  

แล้ว Input “X0”
⑤	ท�ำการยืนยันโดยกด Enter  หรือ [OK]

②	ท�ำการยืนยันโดยกด Enter  หรือ [OK]

①	คลิกเลือกที่  จาก Toolbar button  
แล้ว Input “X2”

① Input “X2” ② คลิก

④ Input “X0” ⑤ คลิก

③ Circuit จะปรากฏข้ึนมา

⑩ Input “Y0” ⑪ คลิก

⑨ Circuit จะปรากฏข้ึนมา

กด ESC  หรือ [Exit] เพื่อ
ยกเลิก

⑦ Input “Y0” ⑧ คลิก

⑥ Circuit จะปรากฏข้ึนมา
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⑳	Compile Operation (ส�ำคัญ)

	 ท�ำการกด “Compile” เพื่อท�ำการยืนยัน Circuit ที่ยัง 
ไม่ได้รับการยืนยัน (ส่วนที่แสดงเป็นสีเทา) 
 
ขอให้เลือกด�ำเนินการตามขั้นตอนที่ระบุด้านล่าง

	 •	 กด F4  (Build)

	 •	 กด  จาก Toolbar

	 •	�ทำ�การเลือก [Conversion/Compile] → [Compile] 
จากเมนู

⑫	จะปรากฏ Circuit ที่เรา Input ไว้แล้วขึ้นมา
⑬	ท�ำการย้ายต�ำแหน่งเคอร์เซอร์ไปที่หัวแถวของแถวถัดไป
⑭	ท�ำการกด  จาก Toolbar button  

แล้ว Input “X3”
⑮	ท�ำการยืนยันโดยกด Enter  หรือ [OK]

⑯	จะปรากฏ Circuit ที่เรา Input ไว้แล้วขึ้นมา 
⑰	ท�ำการกด  จาก Toolbar button  

แล้ว Input “Y1”
⑱	ท�ำการยืนยันโดยกด Enter  หรือ [OK]

⑲	จะปรากฏ Circuit ที่เรา Input ไว้แล้วขึ้นมา 

F4  (Build)

⑭ Input “X3” ⑮ คลิก

⑫ Circuit จะปรากฏขึ้นมา

⑬ ย้ายเคอร์เซอร์

⑰ Input “Y1” ⑱ คลิก

⑯ Circuit จะปรากฏขึ้นมา

⑳ การยกเลิกแถบสีเทาที่ปรากฏ

ท�ำการยืนยัน Circuit เพื่อลบส่วนที่ปรากฏเป็นสีเทา  
กรณีที่เกิด Error เคอร์เซอร์จะเคลื่อนไปในต�ำแหน่งที่ 
Circuit เป็น NG ขอให้ท�ำการแก้ไข

⑲ Circuit จะปรากฏขึ้นมา
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PLC
built-in port
(USB)

USB cable

USB

GX Works2

3.4.1	 การเชื่อมต่อกับ PLC
การเชื่อมต่อกับ FX3G PLC (เชื่อมต่อโดยใช้สาย USB cable)
[การเตรียมด้านคอมพิวเตอร์]
จ�ำเป็นต้อง Install USB driver ลงในคอมพิวเตอร์เพื่อท�ำการต่อสาย USB ระหว่างคอมพิวเตอร์กับ FX3G PLC

ขั้นตอนการ Install USB driver ให้ปฏิบัติตามคู่มือใน “GX Works2 Operating Manual (บท Common)”

[รูปแบบการเชื่อมต่อ]

วิธีการติดตั้งไดรเวอร์ USB

กรณีใช้งาน <Windows® 7, Windows® 8>

①	ติดสายเคเบิ้ลระหว่างคอมพิวเตอร์ และ PLC เข้าด้วยกัน จากนั้นเปิด PLC 

②	เลอืก “Device Manager” ใน “System and Security” จากแท็บ “Control Panel” จากนั้นคลิกขวาที่ “Other derices” แล้ว

เลือก “Update Driver Software...”

③	เมือ่หนา้จอของ “Update Driver Software” แสดงขึน้ใหเ้ลอืก “Browse my computer for driver software” ตอ่ไปจะปรากฎ 
“Easysocket ¥USBDrivers” โฟลเ์ดอรท์ีม่กีารตดิตัง้ GX Works2 ในกรณีผลติภณัฑ์ MELSOFT ถกูตดิตัง้ไวห้ลายตวั ใหอ้า้งองิ 
ปลายทางการตดิตัง้ของผลติภณัฑต์ัง้แตค่รัง้แรก

＊	 กรณีใช้ “FX3U-USB-BD”, “FX-USB-AW” เชื่อมกับคอมพิวเตอร์ เนื่องจากวิธีการติดตั้งมีความแตกต่างตามแต่คอมพิวเตอร์ที่
ใช้งาน ฉะนั้น กรุณาดูรายละเอียดใน “GX Works2 Operating Manual (Common)”

Point

3.4	 การเขียน Program ลงใน PLC
Sequence program ที่จัดท�ำขึ้นมา จะถูกเขียนลงใน FX PLC
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ท�ำการ Set up GX Works2 เพื่อเชื่อมต่อกับ PLC

⑤	ท�ำการ Set up communication port ด้านคอมพิวเตอร์

	・�ท�ำการเลือก “USB” เมื่อต้องการเชื่อมต่อไปยัง Built-in USB 
port ใน FX3G PLC

⑥	จากนั้นคลิก [OK]

⑦	คลิกปุ่ม [Connection Test] เพื่อท�ำการตรวจสอบการรับส่ง
สัญญาณไปที่ PLC

⑧	คลิก [OK] หลังตรวจสอบเสร็จ เพื่อยืนยันรายละเอียดที่ท�ำการ 
ตั้งค่าไป

①	คลิกที่ “Connection Destination” ในหน้าจอ Navigation
②	ดับเบิลคลิกที่ “Connection 1”

③	หนา้จอเพือ่ระบุ Destination จะปรากฏขึน้มา
④	ดับเบิลคลิกที่ Icon 

3.4.2	 “Transfer Setup” ใน GX Work2 และ “Writing programs”

⑤ เลือก
⑥ คลิก

② ดับเบิลคลิก

① คลิก

③ หน้าจอเพื่อระบุ Destination จะปรากฏขึ้นมา

④ ดับเบิลคลิก

⑦ คลิก

⑧ คลิก



3-17

3

⑨	ที่ PLC ท�ำการสับสวิทซ์ “RUN/STOP” ไปที่ “STOP”  

[หัวข้อเพิ่มเติม : Function auto RUN/STOP จาก Programming software]
	 •	�กรณีท�ำการเขียนโดยที่ PLC อยู่ในสถานะ RUN หลังจากด�ำเนินการตาม

ข้อ ⑫ แล้ว จะมีข้อความว่า “หลัง Remote STOP จะด�ำเนินการเขียน 
PLC หรือไม่” 

	  	�กรณีที่ต้องการเขียนให้คลิก [Yes (Y)] 
	 •	�เมื่อเขียนเสร็จแล้ว จะมีข้อความว่า “PLC อยู่ในสถานะ STOP จะ  

REMOTE ไป RUN หรือไม่”  
เพื่อให้ PLC RUN ให้คลิก [Yes (Y)]

⑪	 คลิก [Parameter + Program]
⑫	 คลิก [Execute] 

(อ้างอิงหัวข้อเพิ่มเติมข้อ ⑨)

⑩	เลือก  จาก Toolbar หรือเลือก [Online] → [Write to PLC] จากเมนู

⑬	หลังจากเสร็จสิ้นกระบวนการคลิก [Close]

　จะมีกล่องข้อความปรากฏขึ้นเพื่อแสดงสถานะก�ำลัง Write

⑩ คลิก

⑬ คลิก

กำ�ลังเขียน

⑫ คลิก

⑪ �ทำ�การเลือก Data
	 ที่จะเขียน

9) Set to 
    "STOP"
⑨ Set to
“STOP”
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1) Set to 
    "RUN"

①	ที่ PLC ทำ�การสับสวิทซ์ “RUN/STOP” ไปที่ “RUN”

②	ด�ำเนินการอย่างใดอย่างหนึ่งตามตัวเลือกด้านล่าง

	 •	 กด  (Monitor Mode/Start Monitoring)

	 •	 กด  จาก Toolbar

	 •	� เลือก [Online] → [Monitor] → [Start Monitoring (All 
Windows)] จากเมนู

1)	 ท�ำการตรวจสอบว่าเมื่อ [Switch X000 “OFF”] แล้ว [Switch X002 “ON”], [Output Y000 “ON”] หรือไม่
2)	 ท�ำการตรวจสอบว่าแม้ [Switch X002 “OFF”] อย่างไร [Output Y000 ก็ยัง “ON”] อยู่หรือไม่
3)	 ท�ำการตรวจสอบว่าเมื่อ [Switch X000 “ON”] แล้ว [Output Y000 “OFF”] หรือไม่ 
4)	 ท�ำการตรวจสอบว่าเมื่อ [Switch X003 “ON/OFF”] สลับกัน [Output Y001 “ON/OFF”] สลับกันด้วย

การ Edit หรือการหยุดการ Monitoring

●●  ทำ�การหยุดการ Monitor โดยคลิกที่ Icon  (Stop Monitoring) หรือเลือก [Online] → [Monitor] → [Stop Monitoring]  
 ในการ Edit circuit สามารถทำ�ได้ทั้งตอนที่กำ�ลัง Monitor อยู่ หรือหยุดการ Monitor ไปแล้ว

Point

3.4.3	 การ Monitoring เพื่อดูการท�ำงานของ PLC

ตรวจสอบการท�ำงานโดยการ Monitor Mode

① Set to
“RUN”

② คลิก
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3

	(1)	 Dialog ที่แสดง Monitor status

①② ④ ③

17ms

	(2)	 วิธีดูการแสดง Status ของ Ladder monitor

อ้างอิง

①	Scan time
		 ท�ำการแสดง Scan time สุงสุดใน Sequence program
②	PLC status
	 ท�ำการแสดงสถานะของ PLC 
	 เมื่อ PLC RUN จะแสดงเป็น “

▲

” เมื่อ PLC STOP จะแสดงเป็น 	
	 “■”
③	Memory status 
		 ท�ำการแสดงรายละเอียด Memory ของ PLC
④	ERR status (PLC Diagnotics)
	 เมื่อท�ำการคลิกจะสามารถตรวจสอบรายละเอียดได้

① ค�ำสั่งหน้าสัมผัส (Contact Instruction)

Input contact
Type

X0 : OFF X0 : ON

หน้าสัมผัสปกติเปิด a
X000

หน้าสัมผัสเปิด (Contact open)

X000

หน้าสัมผัสปิด (Contact close)

หน้าสัมผัสปกติปิด b
X000

หน้าสัมผัสปิด (Contact close)

X000

หน้าสัมผัสเปิด (Contact open)

② คำ�สั่งเอาท์ (OUT Instruction)

Driving status

Type
ไมท่�ำงาน/ไมเ่คลือ่นไหว ท�ำงาน/เคลือ่นไหว

OUT instruction
Y000 Y000

Set instruction, etc.
SET M0 SET M0

ค�ำสั่ง RST (RST Instruction) คือ การแสดง ON/OFF ของ Device ที่จะ Reset

Device status

Type
Reset device OFF Reset device ON

RST instruction
RST M0 RST M0

การแสดงสถานะของ GX Works2
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●	 ตัวอักษรที่จะ Input ต้องเป็นตัวอักษรภาษาอังกฤษพิมพ์เล็ก  ตัวอักษรภาษาอังกฤษพิมพ์ใหญ่ไม่สามารถ Input ได้

 

●	 การสลับระหว่าง “Ovrwrte” และ “Insert”	

	 ・กรณีที่จะทำ�การแก้ไข Program ที่มีอยู่แล้ว ขอให้เลือก “Ovrwrte” mode

	 ・เมื่อ Set mode เป็น “Insert” จะเป็นการ Input เป็น Program ใหม่

Point

3.5　การแก้ไขโปรแกรม

3.5.1	 การแก้ไขโปรแกรม

เมื่อกด Insert  จะเป็นการ
สลับ ระหว่าง “Insert” และ 
“Ovrwrte”
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3

X002

Y000

X000

X003
Y001

Y002
Change to

Y000

① การเปลี่ยนหมายเลข OUT coils และ contacts

[Program ที่จะแก้ไข]

④	จะปรากฏ Program หลังการแก้ไขขึ้นแสดงในกรอบสีเทา

①	ท�ำการดับเบิลคลิกในส่วนที่จะท�ำงานแก้ไข

⑤	กด F4  (Build) เพื่อยืนยัน

②	เปลี่ยน “Y001” → “Y002”
③	กด Enter  หรือ [OK] เพื่อยืนยัน

⑤ F4

เปลี่ยนเป็น

① ดับเบิลคลิก

④ แสดงผลการแก้ไข

(Build)

③ กด Enter② เปลี่ยนเป็น “Y002”
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② เพิ่ม Lines

[Program ที่จะท�ำการเพิ่ม Lines]

③	Line จะเพิ่มขึ้นตามต�ำแหน่งที่ลากเคอร์เซอร์
④	วางเคอร์เซอร์ในต�ำแหน่งที่ต้องการเพิ่ม OUT coil แล้วคลิก 

จาก Toolbar

①	คลิก Toolbar  ( F10 )

縦/横の罫線を
追加しOUTコイル
を作成する

②	เมื่อน�ำเคอร์เซอร์ไปวางด้านขวาบนของต�ำแหน่งที่ต้องการ 
เพิ่ม Line แล้ว ให้ท�ำการลากเส้น

⑤	Input “Y3” เข้าไป
⑥	ท�ำการยืนยันโดยกด Enter  หรือ [OK]

เพิ่ม Line แนวตั้ง 
หรือแนวนอน และ 
จัดท�ำ OUT coils

วางเคอร์เซอร์ที่ด้านบนขวา
ในต�ำแหน่งที่ต้องการเพิ่ม

② ลาก

④ ต�ำแหน่งเคอร์เซอร์

③ เพิ่ม Line

① คลิก

⑥ กด Enter  

⑤ Input “Y3”
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3
⑧	ท�ำการกด F4  (Build) เพื่อยืนยันการเปลี่ยนแปลง

⑦	เมื่อท�ำการเพิ่ม Ladder แล้ว จะแสดงเป็นบล็อกสีเทา

⑧ F4 (Build)

・	เมื่อด�ำเนินการเสร็จแล้ว ท�ำการคลิก  จาก Toolbar อีกครั้ง

การเพิ่มหรือลด Lines โดยการใช้ Keys

◦	GX Works2 สามารถทำ�การเพิ่มหรือลบ Lines ได้โดยใช้ Ctrl  + , , , 

อ้างอิง

⑦ เสร็จสิ้นการเพิ่ม Ladder
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③ การลบ Lines

[Program ที่ต้องการลบ Lines]

③	ท�ำการลบ Lines
④	OUT coils ท�ำการลบโดยกด Delete

①	คลิก  ( Alt  + F9 ) จาก Toolbar

この回路を
削除する

②	ท�ำการลากเคอร์เซอร์จากด้านขวาบนของต�ำแหน่งที่ต้องการ 
ลบเส้น ลากจนสุดต�ำแหน่ง

ต้องการลบ
ส่วนนี้

วางเคอร์เซอร์ที่ด้านบนขวา
ในต�ำแหน่งที่ต้องการเพิ่ม

② ลาก

③ ลบ Line

④ ลบโดยกด Delete

① คลิก
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3

⑤	Program ที่ต้องการลบจะปรากฏเป็นกรอบสีเทา

⑥	กด F4  (Build) เพื่อเปลี่ยนรายละเอียด⑥ F4 (Build)

・	กรณีที่ต้องการจบการด�ำเนินการให้กด  จาก Toolbar  
อีกครั้ง

การเพิ่มหรือลบ Lines โดยการใช้ Keys

◦	GX Works2 สามารถทำ�การเพิ่มหรือลบ Lines ได้โดยใช้ Ctrl  + , , , 

อ้างอิง
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3.5.2	 การแทรก/ลบ Rows

① การแทรก Rows

[Program ที่ต้องการแทรก Rows]

③	เสร็จสิ้นการแทรก Rows

この行を
追加する

②	ท�ำการคลิกขวาในต�ำแหน่งใดก็ได้เพื่อเลือก
	 ・ [Edit] → [Insert Row]

การแทรก Rows ท�ำการแทรกด้านบนแถวที่เคอร์เซอร์วางอยู่

①	น�ำเคอร์เซอร์วางแถวล่างของต�ำแหน่งที่ต้องการแทรก

④	ท�ำการเพิ่ม Circuit ลงในแถวที่แทรกเข้าไปใหม่

⑤	ท�ำการกด Build  (F4) เพื่อยืนยันการเปลี่ยนแปลง

ต้องการเพิ่ม 
Rows นี้

① �น�ำเคอร์เซอร์มาวางต�ำแหน่ง
 ด้านล่างแถวที่ต้องการจะเพิ่ม

③ Rows ใหม่แทรกเข้ามา

④ เพิ่ม Circuit

② คลิกขวาเลือก “Insert Row”
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3

[Program ที่ต้องการลบ Rows]

③ Row ถูกลบไปเรียบร้อย

①	ย้ายเคอร์เซอร์ไปวางใน Row ที่ต้องการลบ

②	วางเมาส์ในต�ำแหน่งใดก็ได้แล้วคลิกขวาเลือก
	 ・ [Edit] → [Delete Row]

กรณีที่การลบ Rows จะไม่มีการแสดงเป็นกรอบ  
สีเทา ให้กด Build  (F4) เพื่อท�ำการยืนยัน
การด�ำเนินการ 

Point

この行を
削除する

② การลบ Rows

ต้องการลบ 
Row นี้

① �ย้ายเคอร์เซอร์ไปวางใน Row 
ที่ต้องการลบ

③ Row ถูกลบไปเรียบร้อย

② คลิกขวาเลือก “Delete Row”
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[Program ที่ต้องการ Edit]

③	Cut โดยเลือก  จาก Toolbar หรือเลือก [Edit] → [Cut]  
( Ctrl  + X ) แล้วท�ำการ Cut

①	ย้ายเคอร์เซอร์มาวางหน้า Circuit ที่ต้องการ Cut

この行を
切り取る

②	ท�ำการลากคลุมทุกต�ำแหน่ง

④	บริเวณที่เลือกไว้จะถูก Cut 
กรณี Cut บางส่วนของ Circuit จะเหลือแสดงเป็นแถบสีเทาอยู่ 
หลังจากแก้ Circuit ไว้ กด F4  (Build) เพื่อยืนยัน 
การด�ำเนินการ

3.5.3	 การ Cut & Copy (Pasting) ladder

① การ Cut

ต้องการ Cut 
ต�ำแหน่งนี้

① �ย้ายเคอร์เซอร์มาวาง
ต�ำแหน่งหน้าสุดที่ต้องการ

บริเวณที่ต้องการ Cut, Copy

② ท�ำการลากคลุมบริเวณ

③ เริ่ม Cut

④ บริเวณที่เลือกไว้โดน Cut ไป
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③	ท�ำการเลือก  ที่ Toolbar หรือเลือก [Edit] → [Copy]  

( Ctrl  + C ) จากเมนูแล้วท�ำการ Cut

น�ำ Program ที่ “Cut” แล้วมาวางแถวหน้า

②	ท�ำการลากคลุมต�ำแหน่งจบ

⑤	ท�ำการเลือก  จาก Toolbar หรือเลือก [Edit] → [Paste]  
( Ctrl  + V ) จากเมนู

กรณีต้องการ Paste เฉพาะบางส่วนของ Program จะมีการแสดง
เป็นกรอบสีเทา ให้กด F4  (Build) เพื่อเป็นการยืนยัน

①	ท�ำการย้ายเคอร์เซอร์มาวางไว้ที่แถวหน้าของ Circuit ที่จะ 
ท�ำการ Copy

④	ย้ายเคอร์เซอร์มาวางในต�ำแหน่งที่ต้องการ Paste

การกดเปลี่ยน Insert

“Ovrwrite” mode	:	การ Paste โดยการเขียนทับใน
ต�ำแหน่งที่เคอร์เซอร์วาง
“Insert” mode	 :	ท�ำการ Insert ข้างบนต�ำแหน่งที่วาง
เคอร์เซอร์

Point

この行を
コピーする

この行に
貼り付け

[Copy (Pasting)]

① �ย้ายเคอร์เซอร์มาวางต�ำแหน่ง 
 แรกสุดที่ต้องการ Copy

③ เริ่ม Copy ② ลากเคอร์เซอร์จนถึงต�ำแหน่งจบ

⑤ Copy & Paste เรียบร้อยแล้ว

④ �น�ำเคอร์เซอร์ย้ายไปต�ำแหน่ง 
 ที่ต้องการ Paste

② Copy (Pasting)

ต้องการ Copy 
ต�ำแหน่งนี้

ต้องการ Paste 
ต�ำแหน่งนี้
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Point

①	ท�ำการเลือก  จาก Toolbar หรือเลือก [Project] → [Save]   
( Ctrl  + S ) หรือ [Save As] จากเมนู

③	ตั้งชื่อไฟล์

②	ก�ำหนด Destination ของ Project

(เฉพาะกรณี Save as เท่านั้น)

กรณีที่ Circuit ยังไม่ได้รับการยืนยัน ให้กด Build  (F4)

(กรณี Overwrite)

④	ก�ำหนด Title ที่จะแสดงเนื้อหาของ Program  
(ตั้งได้ตามต้องการ) 

⑤	คลิก Save

3.6　การบันทึก Program ที่จัดท�ำเสร็จแล้ว

3.6.1	 Save, Save as

Save Program เสร็จเรียบร้อย

① คลิก

③ ตั้งชื่อไฟล์

④ ก�ำหนด Title

⑤ คลิก

② �ก�ำหนด Destination ของ Project
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①	เลือก  จาก Toolbar หรือเลือก [Project] →  
[Open] ( Ctrl  + O ) จากเมนู

กรณีเปิด Project อื่นๆ ค้างไว้ ในตอนที่ท�ำการ Read file ใหม่ Project นั้นจะถูกปิดไป
ถ้า Project ที่จะถูกปิดนั้นยังไม่ได้ท�ำการ Convert หรือ Save จะมีข้อความแจ้งเตือนขึ้นมา

อ้างอิง

②	เลือก Destination ของ Project

③	เลือก Project ที่จะเปิด
④	คลิก Open  เพื่อเปิด Project

④ คลิก

② เลือก Destination

3.6.2	 การ Read project

③ เลือกชื่อ Project

① คลิก
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3.7　Debug program
เรื่องการอ่าน Program หรือการเชื่อมต่อ PLC ขอให้อ้างอิง “ภาคผนวก 1.4 การเขียน Program ใน PLC”

3.7.1	 Ladder monitor
ท�ำการ Monitor สภาพการท�ำงานของ Coils หรือสภาพการท�ำงานหน้าสัมผัส (Contact) ในแต่ละจุดในขณะที่ Program ก�ำลังแสดงอยู่  
(รายละเอียดในการแสดงขอให้อ้างอิง “การ Monitoring การท�ำงานของ Program”)

②	ที่ Ladder monitor จะแสดงค่าปัจจุบันของ Word device  
(Timer, Counter, Data register) และสถานะการ ON/OFF  
ของ Ladder

①	เลือก  จาก Toolbar หรือเลือก [Online] → [Monitor] → 
[Start Monitoring (All Windows)] จากเมนู

อ้างอิง
●●  ใน GX Works2 สามารถหยุดการ Monitor ได้โดยการเลือก  (Stop Monitoring) จาก Toolbar หรือเลือก [Online] 
 → [Monitor] → [Stop Monitoring] จากเมนู ส่วนการ Edit program สามารถด�ำเนินการได้ทั้งในขณะที่ก�ำลัง Monitor 
 หรือหยุดการ Monitor แล้ว 
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⑤ Device ที่เลือกไว้จะถูก Register ลงใน Watch window
⑥	สามารถ Input device names ได้โดยตรงลงในช่องว่าง “Device/

Label” เช่น “X0”, “M0”, “D0”
⑦	เลือก [Online] → [Monitor] → [Start Monitoring] จากเมนู

①	ไปที่หน้าจอ Monitor mode (อ้างอิงภาคผนวก 3.7.1 “Ladder 
Monitor”)

③	เลือก [View] → [Docking Window] → [Watch1] และ Watch  
windows จะแสดงออกมา

④	Device ที่เลือกไว้แล้ว  ให้ท�ำการ Drag และ Drop ลงใน 
Watch windows

②	・กรณีที่ต้องการ Register 1 Device ให้ใช้เมาส์คลิกเลือกที่ 
Device

	 ・กรณีที่ต้องการ Register device หลายตัว ให้ใช้เมาส์ลากคลุม
พื้นที่ที่ต้องการ

3.7.2	 Device registration monitor
เป็นการก�ำหนดขอบเขตของ Program หรือการก�ำหนด Device 1 Device ในหน้าจอ Ladder monitor แล้วท�ำการ Register device  
ส่วนนั้นๆ ลงใน Watch windows

③ Watch windows

ลากเมาส์

② กรณี Register 1 Device

②	กรณีที่ Register device 
	 หลายตัว

④ �Drag & Drop ลง 
Watch windows

⑤ �เสร็จสิ้นการ 
Register device

⑥ Input ได้โดยตรง

⑦ �ค่าต่างๆ จะปรากฏขึ้นหลังเลือก [Start
	 Monitoring] (Bit devices : ON = 1, OFF = 0, 	
	 Word device : จะแสดงค่าปัจจุบัน
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①	ไปที่หน้าจอ Monitor mode (อ้างอิงภาคผนวก 3.7.1 “Ladder 
Monitor”)

④	จะปรากฏสถานะการท�ำงานขึ้นตามการท�ำงานของ Device
・Bit devices (X, Y, M, S) : ON = 1, OFF = 0
・Timers และ Counters: �สถานะ ON/OFF ค่าที่ก�ำหนดไว้และ

ค่าปัจจุบันของ Contact Coil
・Data registers: ค่าปัจจุบัน

⑤	หลังจากใช้เมาส์เลือกส่วนที่ต้องการให้ปรากฏใน Monitor data 
ให้ท�ำการคลิกที่ [Modify Value] จะสามารถเปลี่ยนค่าปัจจุบัน
ของ Word device หรือ สามารถ Set forcibly ON/OFF

③	ท�ำการ Input หมายเลขแรกของ Device ที่จะท�ำการ Monitor ใน 
Window “Device Memory Batch” กด Enter

	� (ระวัง) กรณีที่ก�ำหนด Timer, Counter ให้คลิก [Reference] 
แล้วเลือก Program “MAIN”

②	ท�ำการเลือก [Online] → [Monitor] → [Device/Buffer Memory 
Batch] จากเมนู

3.7.3	 Device batch monitor (การเรียกดู Device ทั้งหมด)
การระบุหมายเลข Device และการ Monitor device ต่อเนื่อง

③ Device No. input ระวัง

⑤ เปลี่ยนค่าปัจจุบัน
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①	ไปที่หน้าจอ Monitor mode (อ้างอิงภาคผนวก 3.7.1 “Ladder 
Monitor”)

Force ON/OFF (Ladder monitor window)

◦	�ท�ำการกด [Shift] key ค้าง ใน Bit device ไหนก็ได้ (Contact, Coil) บน Ladder monitor window แล้วดับเบิลคลิก จะสามารถ
เลือก Force ON/OFF device ได้

อ้างอิง

③	ท�ำการ Input หมายเลข Device ที่จะท�ำการ Force ON/OFF

④ ・[Force ON] : Device ON
	 ・[Force OFF] : Device OFF
	 ・�[Force ON/OFF Invert] : Device จะ ON/OFF สลับกัน 

ทุกครั้งที่กด

②	เลือก [Debug] → [Modify Value] จากเมนู

3.7.4	 Device test

① Force ON/OFF (การบังคับเปิด/ปิด)
ท�ำการ Force ON/OFF bit device ของ PLC (เช่น M, Y, T, C) (จะไม่ Force ON/OFF ใน X)  
หาก Force ON/OFF Input (X) ในขณะที่ PLC ก�ำลัง RUN อยู่ จะท�ำการ ON/OFF เฉพาะเมื่อครบ 1 Cycle เท่านั้น  
ในกรณีที่จะตรวจสอบการท�ำงานของ Output (Y) ต้องให้ PLC อยู่ในสถานะ STOP ก่อน

③ Input Device

④ คลิก
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①	ไปที่หน้าจอ Monitor (อ้างอิงภาคผนวก 3.7.1 “Ladder  
Monitor”)

③	ท�ำการป้อนหมายเลข Device ที่ต้องการเปลี่ยนแปลงแล้วกด 
Enter

②	ท�ำการเลือก [Debug] → [Modify Value] จากเมนู

④	ท�ำการป้อนค่าที่ต้องการเปลี่ยน

⑤	คลิก [Set]

② การเปลี่ยนแปลงค่าปัจจุบันของ Word device
การเปลี่ยนค่าปัจจุบันของ Word device ของ PLC (เช่น T, C, D เป็นต้น) เป็นค่าที่ต้องการ

③ Input device

④ ค่าที่ต้องการเปลี่ยน ⑤ คลิก
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①		�Input หมายเลข Device ในช่อง “Device/Label” แล้ว Regis-
ter ลง Watch windows

	 (เพิ่มเติม) �หลังจาก Register แล้วเลือก [Online] → [Watch] 

→ [Start Watching]

②		�Input ค่าที่ต้องการเปลี่ยนลงในช่อง “Current Value” แล้ว 
กด Enter

・Bit devices (เช่น X,Y)  
: Input ค่าเป็น ON “1”, OFF “0”

・Word devices (เช่น T, C, D)  
: Input ค่าที่อยู่ในขอบเขตที่สามารถ Input ได้

③ การเปลี่ยนค่าปัจจุบันและการ Force ON/OFF โดยใช้ Watch window
เป็นการใช้ Watch window ท�ำการ Force ON/OFF bit device หรือการเปลี่ยนค่าปัจจุบันของ Word device (T, C, D เป็นต้น)
เมื่อ Force ON/OFF input (X) ในตอนที่ PLC ท�ำงาน ก็จะ ON/OFF ลงใน 1 scan cycle time  
เมื่อต้องการตรวจสอบการท�ำงานของ Output (Y) ต้องให้ PLC อยู่ในสถานะ STOP ก่อน

② Input ค่าที่ต้องการเปลี่ยน

① Device register
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①	�อธิบายโดยใช้ตัวอย่างการเพิ่มหน้าสัมผัส (Contact) เข้าไปใน 
Curcuit ตามภาพทางซ้ายมือ

◦	�กรณีที่ Program ก่อนการแก้ไขใน PLC และ ใน PLC เป็นคนละตัวกันจะไม่สามารถด�ำเนินการได้ กรณีที่ไม่แน่ใจว่าเป็นตัว
เดียวกันหรือไม่ ขอให้ท�ำการเปรียบเทียบดูก่อนหรือ ส่งไปที่ [Write to PLC]

Caution

②	เพิ่มหน้าสัมผัส (Add Contact)
	 กรอบสีเทาบริเวณวงจรจะปรากฎขึ้นมา

③	กด [Shift] + [F4] หรือเลือก [Convert/Compile] → [Online 
Program Change]

⑤	จะปรากฏข้อความแจ้ง “Online change has completed” ขึ้นมา 
คลิก [OK]

Online program 
chang

[Shift] + [F4]

④	คลิก [Yes] เมื่อมีข้อความแจ้งเตือนเกี่ยวกับระบบความปลอดภัย
ของ PLC ขณะก�ำลัง RUN

3.7.5	 การ Writing program ขณะ PLC ก�ำลัง RUN
การเขียนบางส่วนของ Program ที่ต้องการแก้ไขลงใน PLC ในขณะที่ PLC ก�ำลัง RUN
เนื่องจากไม่ได้เป็นการ Write program ทั้งหมดลงไป จึงสามารถด�ำเนินการ Write ได้ในเวลาอันรวดเร็ว

② Add contact (เพิ่มหน้าสัมผัส)

⑤ คลิก

④ คลิก
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ประเภท วัตถุประสงค์ จ�ำนวนตวัอักษร (ตวัพิมพ์ใหญ่) หมายเหตุ

① Device comment Comment แสดงบทบาทและหน้าที่
การใช้งานของแต่ละ Device

16  
(ท่ี PLC มากสดุ 8 ตวัอกัษร)

กรณี Write ลง PLC จ�ำเป็นต้องท�ำการ Set  
ค่า “Comments capacity” และจ�ำเป็นต้อง Set  
“Comment range setting” ที่จะ write

② Statement Comment แสดงบทบาทและหน้าที่
การใช้งานของ Ladder blocks

32
เป็น Comment เฉพาะด้าน Computer software  
(ไม่ Download ลง PLC)

③ Note Comment แสดงบทบาทและหน้าที่
การใช้งานต่อ Output instructions

16
เป็น Comment เฉพาะด้าน Computer software 
(ไม่ Download ลง PLC)

[ตัวอย่าง Comment]

Global device comment และ Local device comment ใน GX Works2

◦	Global device comment	 :	เป็น Comment ที่สามารถ Input ลงใน PLC

◦	Local device comment	 :	�เมื่อท�ำการ Set local device comment ใหม่ จะสามารถจัดท�ำ Comment ต่างหากแยกกับ Global 
device comment

			�   และใน GX Developer สามารถใช้งาน Comment ที่แยกต่าง Program เช่น QnH, QnU แต่ใน  
FX Series ไม่สามารถ Write ลง PLC ได้  
การใช้งานปกติแนะน�ำให้เลือก “Global device comment”

Point

วิธีการแสดง Comment

◦	ท�ำการเลือก [View] → [Display comment] จากเมนู แล้ว Comment จะปรากฏ 

◦	เมื่อต้องการยกเลิกการแสดง Comment ให้ด�ำเนินการตามขั้นตอนด้านบนอีกครั้ง

Point

3.8	 การใส่ Comment

3.8.1	 ประเภทของ Comment
สามารถใส่ Comment ได้ 3 ประเภทตามด้านล่าง

③ Note

T5 N.O. Contact มี 10 Step,  
 N.C. Contact มี 8 Step

② Statement

① Device comment
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①	ท�ำการคลิก [Global Device Comment] จาก Project list

②	ท�ำการ Input ตัวเลขต้นของ Device ที่ต้องการจัดท�ำ Comment 
ลงใน “Device Name” แล้วคลิก Enter

③	ท�ำการ Input comments ลงในช่อง “Comment”

・	กรณีที่ต้องการ Input comment ของ Device อื่นๆ ให้ท�ำการใส่
หมายเลขของ Device นั้นตามขั้นตอนข้อ ②

①	คลิก  จาก Toolbar และ ดับเบิลคลิกหมายเลข Ladder ที่
ต้องการ Input comment

②	ท�ำการ Input comment ลงในหน้าจอ “Enter symbol” แล้วคลิก 
[OK]

・	เมื่อด�ำเนินการเสร็จแล้วให้คลิก  อีกครั้ง

② วิธีการป้อน Comment โดยใช้ Enter symbol

3.8.2	 วิธีการสร้าง Device comment

① วิธีการ Input device จาก List

① ดับเบิลคลิก

② Input หมายเลข Device

③ Input Comment

① ดับเบิลคลิก

② Input Comment
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การ Set การ Write device comments ใน PLC

เพื่อท�ำการ Write comment ใน PLC จ�ำเป็นต้อง Set “Parameter setting” และ “Comment range setting”

1)	 การ Set parameter

2)	 Comment range setting

Point

①		 เลือก [Parameter] → [PLC parameter]
②		�ท�ำการ Set “จ�ำนวน Block” ใน “Comment  

capacity” 
ใน 1 Block สามารถบรรจุได้ 50 Comment  

โดย Program memory ที่ 500 Step

①		 เลือก [Online] → [Write to PLC]

②		�ท�ำการเช็คเครื่องหมายที่ “Global device  

comment”

③		คลิก [Details]

④		�ท�ำการ Set ประเภท Device และขอบเขตที ่
จะ Write ที่ PLC ลงใน Setup comment range 
dialog

วิธีการป้อน Comment เมื่อจัดสร้าง Program (ตามวิธีการข้อ 2)
อ้างอิง

◦	�เลือก [Tools] → [Options] จากนั้นเลือก [Program Editor] 
→ [Ladder/SFC] → [Enter ladder] และคลิกใส่เครื่องหมาย
ถูกใน [Enter label comment and device comment]  
หากก�ำหนดค่าตรงนี้จะท�ำให้หน้าต่าง [Enter comment]  
ปรากฎขึ้นในขั้นตอนการกรอก Ladder เวลาเขียนโปรแกรม

◦	�คลิก Icon ทางซ้ายมือเพื่อกรอก Comments

① ดับเบิลคลิก

ความจุ Program จะลดลง 
ขึ้นอยู่กับความจุ Comment

②	Comment capacity 	
	 setting

④ �Comment 
range setting

③ คลิก

② เช็ค
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①	คลิก  จาก Toolbar ท�ำการดับเบิลคลิกตรงส่วนไหนก็ได้ 
ของ Ladder block ที่ต้องการจะ Input statement

②	ท�ำการ Input statement ที่หน้าจอ “Enter line statement”  
แล้วคลิก [OK]

•	 ในกรณีที่ด�ำเนินการเสร็จแล้ว ให้กด  อีกครั้ง

3.8.4	 การจัดสร้าง Notes

①	�คลิก  จาก Toolbar ท�ำการดับเบิลคลิกตรง Output  
instruction ที่ต้องการจะ Input note

②	ท�ำการ Input note ที่หน้าจอ “Enter Note” แล้วคลิก [OK]

•	 ในกรณีที่ด�ำเนินการเสร็จแล้ว ให้กด  อีกครั้ง

3.8.3	 การจัดสร้าง Statements

① ดับเบิลคลิก

② Statement input

① ดับเบิลคลิก

② Note input
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จนมาถึงเนื้อหาในบทนี้เราได้เรียนรู้เกี่ยวกับ...
	 ใน PLC นั้นประกอบไปด้วย Relay, Timer, Counter ต่างๆ มากมาย และข้างใน Sequence เหล่านั้น 
ยังเชื่อมต่อกัน โดยทางด้าน Programming กับอุปกรณ์ต่างๆ ในแต่ละการท�ำงาน และการเดินสายไฟ ส�ำหรับ
การเดินสายไฟจ�ำเป็นต้องมีกฎเกณฑ์ เพื่อรองรับกับลักษณะการต่อ Coils ลักษณะของหน้าสัมผัส (Contact) 
ประเภทของ Coils ที่เหมาะสม ในส่วนนี้จะเรียกว่า “ค�ำสั่ง” (Instruction) นั้นเอง			 
รูปแบบของค�ำสั่ง (Instructions) ที่จัดสร้างขึ้นประกอบด้วย ‘ภาษาค�ำสั่ง (Instruction word) + Device number’ 
หรือ ที่ท�ำงานด้วย ภาษาค�ำสั่งเดี่ยวๆ (Individual instruction words)						    
	 ในบทนี้จะขออธิบายเกี่ยวกับค�ำสั่ง (Instruction) ค�ำสั่งพ้ืนฐานต่างๆ เพื่อใช้จัดสร้าง Sequence program 	
ขอให้จ�ำความหมายของแต่ละค�ำสั่ง (Instruction) ต่างๆ ให้ได้ด้วยนะ

บทที่ 4

ค�ำสั่งของซีเควนซ์ (Sequence instructions)

ค�ำสั่ง (Instructions) นั้นเหรอไม่ยากหรอก เรื่องจิ๊บๆ!
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4.1 ค�ำสั่ง (Instruction)

4.1.1 Commands และ Programs

อุปกรณ์ที่เกี่ยวข้องกับการ Input ซีเควนซ์โปรแกรม (Programing devices) มีแบบที่ไว้เขียนวงจรโปรแกรมในหน้าจอคอมพิวเตอร์และแบบ

ที่ไว้ Input โปรแกรมด้วยภาษาค�ำสั่ง (Instruction words) (อุปกรณ์ส�ำหรับท�ำ List program) เหล่านี้เพียงแค่วิธีการ Input โปรแกรมต่างกัน

เท่านั้น ส่วนตัวลักษณะโปรแกรมมีความคล้ายคลึงกัน

ตารางด้านล่างแสดง Instruction อ�ำนวยความสะดวกให้ PLC และแสดง Ladder instruction แต่ละอัน 

●●  ,    แสดงจุดหน้าสัมผัส (Contact) ใน Ladder  
จะเชื่อมต่อกันหรือไม่ขึ้นอยู่กับสถานะการ ON/OFF ของ 
Input relay, Output relay, Auxiliary relay,Timer, Counter

, SET  แสดงการท�ำงานของ Coil

ส�ำหรับ Input ด้วย Instruction words 
(เช่น Handy programming panel)

ส�ำหรับ Input ดว้ย Ladder diagrams
(Programming software ส�ำหรับคอมพิวเตอร์)

เครื่องหมาย, ชื่อเรียก ความหมาย Ladder

Load

หน้าสัมผัสปกติเปิด a
(N.O. Contact)
Bus connection

Load inverse

หน้าสัมผัสปกติปิด b
(N.C. Contact)
Bus connection 

And

หน้าสัมผัสปกติเปิด a
(N.O. Contact)

Series connection

And inverse

หน้าสัมผัสปกติปิด b
(N.C. Contact)

Series connection

Or

หน้าสัมผัสปกติเปิด a
(N.O. Contact)

Parallel connection

Or inverse

หน้าสัมผัสปกติปิด b
(N.C. Contact)

Parallel connection

And block

Series connection
between block

Or block

Parallel connection
between block

Out
Coil drive instruction

Set

Latch operation,  
Coil instruction

Reset

Cancel latch operation, 
Coil instruction

NOP
No operatioin Delete program or space

End
End of program End of program Return to step 0

SET YMS

RST YMSTCD

LD

LDI

AND

ANI

OR

ORI

ANB

ORB

OUT

SET

RST

NOP

END
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4

4.1.2 โครงสร้างของโปรแกรม

Internal sequence ส�ำหรับ Sequence control จะต้องจัดท�ำ Circuit diagram (Ladder list) หรือ Instruction list เพื่อเป็น Sequence 
program

●●  Program จะสร้างจากการประกอบกันของโค้ดค�ำสั่ง (Instruction codes) และ Device number (Operand) จ�ำนวนมาก 

แต่ละค�ำสั่ง (Instruction) จะมีการติดหมายเลขตามล�ำดบั ในทีน่ีจ้ะเรยีกวา่ Step no. (Step no. จะถกูควบคมุโดยอตัโนมตั)ิ

●●  [Instruction] จะเท่ากับ [Instruction code] + [Device number] แต่อาจมีบาง Instruction ที่มีเฉพาะ Instruction code ไม่มี Device หรือ

น�ำเฉพาะ Instruction code มาแสดงเป็น Instruction อย่างง่ายๆ 

●●  Max step ขีดจ�ำกัดที่สามารถจัดท�ำ Program ได้จะขึ้นอยู่กับ [Program memory capacity] ของ PLC ที่ใช้อยู่  
ในที่นี้จะขอเรียกว่า PLC program capacity 
ยกตัวอย่าง Capacity ใน Program memory ของแต่ละรุ่น FX1s PLC [Step 2000], FX3G [Step 32000], FX3u  [Step 64000]

●●  PLC repeatedly จาก Step 0 ถงึ End step ในทีน่ีจ้ะเรยีกวา่ Cyclic operation สว่นเวลาทีใ่ช ้ ใน 1 รอบการท�ำงานจะเรียกว่า Scan time 
Scan time นั้นจะแตกต่างกันขึ้นอยู่กับเนื้อหา Program หรือ ล�ำดับการ Cyclic operation จริง จะแตกต่างกันประมาณ ms ~ หน่วย  
10 ms

●●  PLC program ที่จัดท�ำมาจาก Circuit diagram (Ladder diagram) จะใช้ความจุจาก Program memory ใน PLC ในรูปแบบ   
“Instruction list (Program list)” 
Programming software ที่ใช้กับคอมพิวเตอร์ จะท�ำการ Convension ระหว่าง “Instruction list (Program list)”, Circuit diagram  
(Ladder diagram)

X001
Y000

Y000

X003
0

4

END

X006
T1
K30

9

Y000

Circuit diagram (Ladder diagram)

Step No.

คำ�สั่ง (Instruction)

Instruction 
code

Device (Number) 
(Operand)

0 

1 

2 

3 

4 

5 

6 

9

LD 

OR 

ANI 

OUT 

LD 

ANI 

OUT

END

X001 

Y000 

X003

Y000

Y000 

X006 

T1  K30

Instruction list (Program list)

R
epeat operation
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การ Programming โดย Instruction list

4.1.3 หน้าสัมผัสปกติเปิด a (N.O. Contact), หน้าสัมผัสปกติปิด b  
(N.C. Contact), Out instruction, End instruction 

LD Load
 ค�ำสั่งส�ำหรับ Bus connection
 ส�ำหรับหน้าสัมผัสปกติเปิด a 
 (N.O. Contact)

LDI Load inverse
ค�ำสั่งส�ำหรับ Bus connection
ส�ำหรับหน้าสัมผัสปกติปิด b  
(N.C. Contact)

OUT Out
ค�ำสั่งเคลื่อนที่ Coil

END End
ค�ำสั่งใช้ส�ำหรับเมื่อสิ้นสุดโปรแกรม

Step Instruction

0 LD X000

1 OUT Y000

2 LDI X000

3 OUT Y003

4 END

List Program

Input X000 ON Output Y000 ON
Input X000 OFF Output Y003 ON

หน้าสัมผัสปกติเปิด a (N.O. Contact) ที่ใช้ในช่วงแรกของ 
Bus line ใช้ Instruction LD (Load) ส่วนหน้าสัมผัสปกติ
ปิด b (N.C. Contact) ใช้ LDI (Load inverse) Contact 
instuction เช่น LD หรือ LDI สามารถใช้ Device input 
relay X, Output relay Y, Timer T, Counter C, Auxiliary 
relay M ได้ Coil drive instruction เช่น OUT จะใช้ Device 
อื่นๆ ได้ ยกเว้น Input relay X

Circuit program

X000

Bus line

0

X000
2

4

Y000

Y003

END

จาก Program ด้านบน...

Input    X000 ONOFF OFF

Output Y000 ONOFF OFF

Output Y003

ON OFF ON

Step number 

จะแสดงล�ำดับของ Program และขนาด Program
กรณีท�ำ Program ด้วย Instruction ตามล�ำดับ  
List program ทาง PLC จะด�ำเนินการตาม  
Step no. โดยอัตโนมัติ 

อ้างอิง 
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4

Programming โดย Instruction list 

AND And 
ค�ำสั่งเชื่อมต่อหน้าสัมผัสปกติเปิด a
(N.O. Contact) (ปกติเปิดเสมอ)

ANI And inverse
ค�ำสั่งเชื่อมต่อหน้าสัมผัสปกติปิด b
(N.C. Contact) (ปกติปิดเสมอ)

Step Instruction

0 LD X000

1 AND X001

2 ANI X002

3 OUT Y000

4 AND X003

5 OUT Y003

6 END

List program

ค�ำสั่ง AND ใช้ส�ำหรับหน้าสัมผัสปกติเปิด a (N.O. Contact) และ 
ANI จะใช้ส�ำหรับหน้าสัมผัสปกติปิด b (N.C. Contact) ซึ่งจะให ้
ตามหลังค�ำสั่ง LD และ ค�ำสั่ง LDI Y000, Y003 จะต้องก�ำลังท�ำงานอยู่ และ Series contact 

จะต้องเชื่อมต่อกันทั้งหมด 

เมื่อ Input X000 ON, X001 ON, X002 OFF จะท�ำให้ Output 
Y000 ON  
เมื่อ Input X000 ON, X001 ON, X002 OFF, X003 ON จะท�ำให้ 
Output Y003 ON  

Circuit program 

Input X001

Input X002

ON

Input X000 ON

ON

ONOFF

Input    X003 ON

ONOutput Y000

ONOutput Y003

จาก Program ด้านบน...

4.1.4 Series connection

อ้างอิง 
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Programming โดย Instruction list

4.1.5 Parallel connection

OR Or
ค�ำสั่ง Parallel connection instruction
ส�ำหรับหน้าสัมผัสปกติปิด a  
(N.O. Contact)

ORI Or inverse
ค�ำสั่ง Parallel connection instruction
ส�ำหรับหน้าสัมผัสปกติปิด b  
(N.C. Contact)

Step Instruction

0 LD X000

1 OR X001

2 ORI X002

3 OUT Y000

4 END

List program

OR (OR) instruction จะใช้ส�ำหรับ N.O. Contact  
ส่วน ORI (OR inverse) instruction จะใช้ส�ำหรับ
N.C. Contact ในการ connect กับ parallel ตาม LD,  
LDI instruction  
ส่วน Output Y000 ด้านบน เมื่อมีการ connect เพียง  
1 contact ก็จะท�ำงานเมื่อมีการ conduction

ถ้า Input X000 ON, X001 ON, X002 OFF อย่างใดอย่างหนึ่งเป็น
ตามเงื่อนไขที่กล่าวมา จะท�ำให้ Output Y000 ON

Circuit program

จาก Program ดา้นบน...

Input X000 ON

Input X001

Input X002

ON

ON

ON OFF

Output Y000 ON

อา้งองิ
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Programming  โดย Instruction list

Step Instruction

0 LD X000

1 OR X001

2 LD X002

3 OR X003

4 ANB

5 OUT Y000

6 END

List program 

Input X000 หรือ Input X001 และ X002 หรือ X003 อันใดอันหนึ่ง 
ON Y000 จะเริ่มท�ำงาน

Circuit program 

จาก Program ด้านบน...

Input X001

Inout X002

Input X000 ON

Input X003

Output Y000

ON

ON

ON

ONON

Step Instruction

0 LD X000

1 AND X001

2 LD X002

3 AND X003

4 ORB

5 OUT Y000

6 END

List program 

จาก Program ดา้นบน...

X000 และ X001 ON พร้อมกัน หรือ X002 และ X003 ON  
พร้อมกัน Output Y000 จะท�ำงาน

4.1.6 Series และ Parallel connection

ตัวอย่าง Program ① ตัวอย่าง Program ②

อา้งองิ

ตัวอย่าง Program ① ตัวอย่าง Program ②

       รายละเอียด ANB, ORB กรุณาดใูนภาคผนวก



4-8

SET SET
ค�ำสั่ง Output
คงสภาพการท�ำงาน

RST Reset
ค�ำสั่ง Cancel
การคงสภาพการท�ำงาน

SET/RST instruction จะใช้กับ เช่น Output relay Y,  
Auxiliary relay M  
ในส่วนอื่นๆ เช่น Counter หรือ Timer ก็ใช้ RST instruction

เมื่อ Input X001 ON Output Y000 จะ ON ด้วย หลังจากนั้น  
ถึง Input X001 ON จะ OFF Y000 ก็จะ Stand by ON อยู่อย่างนั้น  
เมื่อ Input X003 ON Output Y000 จึงจะ OFF

Step Command

0 LD X001

1 SET Y000

2 LD X003

3 RST Y000

4 END

List program

เป็นค�ำสั่งเพื่อขับเคลื่อน Coil เหมือนกับ OUT instruction
ส�ำหรับ OUT instruction เมื่อ Contact drive coil เปลี่ยนจาก  
ON เป็น OFF, OUT instruction ที่สั่ง Coil ก็จะเปลี่ยนเป็น OFF 
ด้วย เมื่อใช้ Instruction SET ถึง Contact จะเปลี่ยนจาก ON เป็น 
OFF coil ก็ยังจะ Stand by ON อยู่อย่างนั้น  
ใช้ค�ำสั่ง RST (Reset) เพื่อท�ำการเปลี่ยนการท�ำงานของ Coil ที่สั่ง
ด้วย SET instruction จาก ON เป็น OFF

Circuit program 

จาก Program ด้านบน...

Input X001 ON

Input X003 ON

Output Y000 ON

4.1.7 SET instruction, RST instruction

Programming โดย Instruction list
อ้างอิง

●●  วิธีการ Input

Space

Space

Space

Space
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Programming โดย Instruction list
อ้างอิง

Circuit ทัง้คูท่�ำการแบบเดยีวกนั

	 [ Output latch circuit ]	 [ Output SET/RST circuit ]

อ้างอิง

4.1.8 Latch circuit (วงจรคงสภาพตัวเอง)
สามารถท�ำการ Hold หรือ Release output ได้โดย การ Programming self-hold sequencer

●	 เมื่อ X001 ON, X003 OFF Y003 จะ ON

●	 ถึง X001 จะ OFF แต่ Y003 จะยังท�ำงานต่อไป (Self-hold)
 เมื่อ X003 ON จึงจะเปลี่ยนเป็น OFF

จาก Program ด้านบน... 

Circuit program 

เมื่อใช้ SET instruction ถึงแม้ว่า Contact coil drive จะ OFF แต่ Output จะถูก Hold ON ไว้  
ดังนั้น Output เดียวกันจะสามารถ Programming กี่ครั้งก็ได้ โดยไม่ใช้ Double coil และยังสามารถใช้งานได้อย่างดีในการควบคุม 
Output จากจุดต่างๆ ของ Program

Step Instruction

0 LD X001

1 OR Y003

2 ANI X003

3 OUT Y003

4 END

	 [ Output latch circuit ]	 [ Output SET/RST circuit ]

Step Instruction

0 LD X001

1 SET Y003

2 LD X003

3 RST Y003

4 END
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Programming โดย Instruction list

4.2 Timer circuit

Timers

Step Instruction 

0 LD X000

1 OUT Y000

2 OUT T0    K100

●●  Timer contact หลังจาก Coil ท�ำงาน จะเริ่มท�ำงาน หลังจาก   
 Deley time ที่ก�ำหนดไว้  (On delay timer)  
 เราจะเรียกเวลาที่ก�ำหนดไว้ว่า Set value จะแสดงสัญลักษณ์  
 เป็น K ค่า K ที่จะ Set นั้น สามารถ Set ได้ตั้งแต่ 1 - 32,767   
 ยกตัวอย่าง K100 Timer จะเท่ากับ 10 sec *¹

●●  เมื่อ X000 OFF ในขณะที่ Timer ท�ำงาน ค่าปัจจุบันของ Timer 
 จะกลับไปที่ 0 Timer contact ก็จะ OFF 

จาก Program ด้านบน...

Output Y000, T0 Coil

Output T0 a contact

Input   X000 ON

Output Y003 Coil

ON

ON

ON

10 Sec

SECONDS

10

30

4020

50

600

STAR DELTA TIMER

อ้างอิง

Timer program

List program

Circuit program

X000
0

5

Y000

T0

(10 Sec)

Y003

END7

K100

T0

Timers นั้นมีหลากหลายประเภท ในที่นี้จะขออธิบายถึงวิธีการ 
ใช้งานของ Digital timer ของ Micro PLC

●●  วิธีการ Input

Space

Space

Space

Spaceอา้งองิ 

Step Instruction 

5 LD T0

6 OUT Y003

7 END

*¹ :100 ms (0.1 sec) หน่วยของ Timer
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Programming โดย Instruction

Counters
Counter นั้นมีหลากหลายประเภท ในที่นี้จะขออธิบายถึงวิธีการ 
ใช้งาน Program ของ Counters ทั่วไปของ Micro PLC

●●  ส�ำหรับ Counters เมื่อ Contact (X003) เปลี่ยนจาก OFF → ON
 จ�ำนวนจะถูกนับ  
 Contact (X003) เราจะเรียกว่า Count input ส่วนตัวเลขที่ถูกนับ   
 โดย Counters เราจะเรียกว่า “Present value”  
 ส่วน Counter contact เมื่อค่าปัจจุบันวิ่งไปถึง ค่าที่ก�ำหนดไว้  
 ก็จะเริ่มท�ำงาน  
 ค่าที่ก�ำหนดนั้น สามารถก�ำหนดได้ ตั้งแต่ 1 - 32,767 

●●  หลังจาก Count up แล้ว ค่าปัจจุบันของ Counter จะไม่มีการ 
 เปลี่ยนแปลง Output contact ก็จะท�ำงานเหมือนเดิม

●●  เมื่อ Reset input X001 ON แล้ว ค่าปัจจุบัน ของ Counter  
 จะเป็น 0 Counter contact ก็จะ OFF

4.3 Counter circuit

จาก Program ด้านบน...

Input X001
(Reset)

Input X003(Total)

ค่าปัจจุบันของ
Counter CO

0 1 2 3 4 5 6 7 8 9 10

Output Y003 ON

TIME

อ้างอิง

Counter program
X001

0

7

C0

K10

Y003

END9

C0RST
Reset Input

X003

Count Input

C0

3

Circuit program

Step Instruction

0 LD X001

1 RST C0

3 LD X003

4 OUT C0  K10

●●  วิธีการ Input

Space

Space

Space

Space

List program

อ้างอิง

Step Instruction

7 LD C0

8 OUT Y003

9 END
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4.4 ล�ำดับ Program (Order of program)

ล�ำดับ Program คือ

Circuit diagram จะเรียงล�ำดับจากซ้ายไปขวา จากบนลงล่าง

Program ด้านบนนี้ จะเรียงล�ำดับ Program ① - ⑯

ล�ำดับ Step Instruction

① 0 LD X000

② 1 OUT Y000

③ 2 LD X001

④ 3 OR X002

⑤ 4 AND X003

⑥ 5 OUT Y001

⑦ 6 OUT Y002

⑧ 7 LD X004

⑨ 8 AND X005

⑩ 9 LD X006

⑪ 10 AND X007

⑫ 11 ORB

⑬ 12 OUT Y003

⑭ 13 OUT Y004

⑮ 14 OUT Y005

⑯ 15 END

X000

X001

Y000

Y001

①

③

X002
④

X003
⑤

Y002

②

⑥

⑦

X004
⑧

X005
⑨

Y003

⑬

X006
⑩

X007
⑪ ⑭⑫

Y005

⑮

END

⑯

Y004

Step
0

2

7

15

Programming โดย Instruction list
อ้างอิง
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เอาละเราหยุดเรื่องของทฤษฎไีว้แค่นี้ก่อนดีกว่า...
    ในบทนี้จะเน้นการสอนเรื่องการใช้งานทั่วไป เช่น Programming และการ Monitoring โดยยึดตามตัวอย่าง

ง่ายๆ ดังต่อไปนี้

บทที่ 5

การฝึกการเขียนโปรแกรม

ก่อนอื่นเรามาเริ่มฝึกจากโปรแกรมง่ายๆ กัน



5-2

5.1 ตัวอย่างการน�ำไปใช้งาน 1 (การควบคุมบันไดเลื่อน)

ลองคิดวิธีการท�ำ Program PLC โดยใช้ระบบบันไดเลื่อนนี้เป็นตัวอย่างกัน 

《I/O assignment (การกำ�หนด I/O)》

《ระบบการควบคุม》
①	 บันไดเลื่อนจะไม่ท�ำงานจนกว่าจะมีคนเข้ามาใกล้
②	 เมื่อมีคนเข้ามาใกล้ สวิทซต์รวจจับการผ่านของสิ่งของ : 0 จะ ON จากนั้นไฟจะติด
	  (เฉพาะบันไดเลื่อนขึ้นเท่านั้น)
③	 เมื่อคนขึ้นบันไดเลื่อนจนสุดทางเลื่อน สวิทซ์ตรวจจับการผ่านของสิ่งของ : 1 จะ ON ทั้งไฟและบันไดเลื่อนจะหยุดท�ำงาน

จากด้านบน ขอให้คิดว่าสวิทซต์รวจจับการผ่านของสิ่งของทั้ง 0 และ 1 คือ สวิทซ์แบบ Non-hold type (แบบไม่คงสภาพตัวเอง) 
ส่วนคนที่ใช้บันไดเลื่อน ก็ไม่ได้ขึ้นบันไดเลื่อนแบบต่อเนื่อง 

สวิทซตรวจจับการผาน 

ของสิ่งของ ：1 X003

สวิทซตรวจจับการผาน 

ของสิ่งของ ：0 X001

หลอดไฟ

             Y000

บันไดเลื่อนทำงาน

Y003

ที่รองนี้คือสวิทซสินะ

Input

X001 สวิทซต์รวจจับการผ่านของสิ่งของ : 0 

X003 สวิทซต์รวจจับการผ่านของสิ่งของ : 1

Output

Y000 หลอดไฟแสงสอ่งสวา่ง

Y003 Output ให้บันไดเลื่อนท�ำงาน
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สามารถสรา้งโปรแกรม (Program) ไดด้งันี้ 

《Circuit program : ตัวอย่างที่ 1》

《ต่อไปมาลองตรวจสอบขั้นตอนการท�ำงานของ Program》
เราลองน�ำ Program ด้านบน มาเขยีนลงใน PLC แล้วลองตรวจสอบขั้นตอนการท�ำงานของ Program

เมื่อท�ำการ ON Input X001, Output Y000, Y003 จะท�ำงาน หลังจากนั้น Input X003 ON, Output Y000, Y003 

《Circuit program : ตัวอย่างที่ 2》

X001

END

Y000
X003

Y000
คงสภาพตัวเอง

ตรวจจับการผานของสิ่งของ : 0 ตรวจจับการผานของสิ่งของ : 1

Y003

หลอดไฟ ON

บันไดเลื่อนทำงาน

0

5

Y000SET

Y003SET

END

X001
ตรวจจับการผานของสิ่งของ : 0  

หลอดไฟ ON

บันไดเลื่อนทำงาน

0

3 Y000RST

Y003RST

X003
ตรวจจับการผานของสิ่งของ : 1

หลอดไฟ OFF

บันไดเลื่อนหยุดทำงาน

6

   List program กรุณาดใูนภาคผนวก 2
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5.2 ตัวอย่างการน�ำไปใช้งาน 2 (เครื่องชงชา)

เรามาคิด Program PLC โดยใช้เครื่องชงชาเป็นตัวอย่างกัน

《ระบบการควบคุม》
①	  เมื่อ X000 การตรวจสอบแก้วชา ON อยู่ แล้วเรากดปุ่มเติมชา X001 (X001 ON), Output การเติมชา Y004 จะท�ำงาน 

 น�ำ้ร้อนจะไหลลงในแก้ว น�้ำร้อนจะไหลเมื่อเรากดปุ่มเท่านั้น เมื่อเราเอามือออก น�ำ้ร้อนจะหยุดไหล
	  และถ้า X000 เป็น OFF (หรือตรวจสอบไม่พบแก้วชา) ถึงเราจะกดปุ่มเติมชา X001 น�้ำร้อนก็จะไม่ไหล
②	  เมื่อน�ำ้ในถังลดลง ตัวแจ้งระดับน�ำ้ LS X003 จะ ON, Output ตัวเติมน�้ำ Y003 จะท�ำงาน 
	  เมื่อ Output ตัวเติมน�ำ้ Y003 ท�ำการเติมน�ำ้จนตัวแจ้งระดับน�้ำ LS X004 ON, Output ตัวเติมน�้ำ Y003 จะหยุดท�ำงาน
③	  เมื่อตัวเติมน�ำ้ท�ำงาน 5 ครั้ง ไฟแจ้งการเปลี่ยนใบชาจะท�ำงาน 
④	  เมื่อกดปุ่มตรวจสอบ ไฟแจ้งการเปลี่ยนใบชาจะดับ

確認

注ぐ

 ระดับน้ำสูงสุดในถัง
 X004
 ระดับน้ำสูงสุดในถัง
 X004

  เติมน้ำ
 Output Y003
  เติมน้ำ
 Output Y003

เปลี่ยนใบชา
 Y000
เปลี่ยนใบชา
 Y000

ตรวจเช็คการ
เปลี่ยนใบชา
 X002

ตรวจเช็คการ
เปลี่ยนใบชา
 X002

ปุ่มเติมชา
X001
ปุ่มเติมชา
X001

เติมชา

    Output Y004
เติมชา

    Output Y004

ระดับน้ำต่ำสุดในถัง
X003
ระดับน้ำต่ำสุดในถัง
X003

ตรวจสอบแกวชา
               X000

ตรวจสอบแกวชา
               X000

《 I/O assignment (การกำ�หนด I/O) 》
Input

X000 ตรวจสอบแก้วชา

X001 ปุ่มกดเติมชา

X002 ปุ่มตรวจสอบใบชา

X003 ระดับน�ำ้ต�่ำสุดในถัง

X004 ระดับน�ำ้สูงสุดในถัง

Output

Y000 ไฟแสดงสถานะการเปลี่ยนใบชา

Y003 Output การเติมน�้ำ

Y004 Output การเติมชา
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5

สามารถสรา้งโปรแกรม (Program) ไดด้งันี้

《Circuit program》

เราลองน�ำ Program ด้านบน มา Input ลงใน PLC แล้วลองตรวจสอบขั้นตอนการท�ำงานของ Program

①	 เมื่อ Input X000 หรือ X001 ON, Output Y004 จะทำ�งาน 
②	 เมื่อ Input X003 ON, Output Y003 จะทำ�งาน เมื่อ Input X004 ทำ�งาน Output Y003 จะหยุดทำ�งาน 
③	 ทุกครั้งที่ Output Y003 ทำ�งาน Counter C0 จะเพิ่มขึ้น 1 ครั้ง เมื่อ Counter ครบ 5 ครั้ง Y000 จะทำ�งาน
④	 เมื่อ Input X002 ON, Counter C0 จะเป็น 0 แล้ว Output Y000 จะหยุดท�ำงาน

《ต่อไปมาลองตรวจสอบขั้นตอนการท�ำงานของ Program》

X000

END

Y004

X004X003

แจงระดับน้ำ min LS แจงระดับน้ำ max LS

Self hold

Output เติมน้ำ

ปุ่มตรวจสอบ

 ตรวจสอบแกวชา

Y003

X001

ปุ่มเติมชา
Output เติมชา

Output เติมน้ำ

จำนวนครั้งในการเติมน้ำ

ไฟแจงเปลี่ยนใบชา

Counter reset

Y003

Y003
C0

C0
Y000

X002
C0RST

K5

0

3

7

11

13

16

   List program กรุณาดใูนภาคผนวก 2
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5.3 ตัวอย่างการน�ำไปใช้งาน 3 (การควบคุมพัดลม)

เรามาลองคิด Program PLC โดยใช้ระบบควบคุมพัดลมเป็นตัวอย่าง

《ระบบการควบคุม》
①	  เมื่อสวิทซเ์ตรียมความพร้อม (X001) ON ไฟแสดงความพร้อม (Y000) จะติด ON, Self-hold จะท�ำงาน และเมื่อสวิทซย์กเลิก 

 การเตรียมความพร้อม (X003) ON ไฟแสดงความพร้อม (Y000) จะดับ OFF, Self-hold เลิกท�ำงาน
②	  ไฟแสดงความพร้อมติด (Y000) ON พัดลมจะเริ่ม/หยุด การท�ำงานตาม MC ส�ำหรับพัดลม ซึ่งสั่งการเปิด/ปิดการท�ำงานตามสวทิซ ์    

 เปิด/ปิดพัดลม (X000) ส่วนแรงลมจะเลือกจากสวทิซ ์ (X005/X006)
	 ・กรณีที่ X005 ON : Output แรงลมระดับเบาจะ ON (Y001)
	 ・กรณีที่ X006 ON : Output แรงลมระดับแรงจะ ON (Y003)

《I/O assignment (การกำ�หนด I/O)》 

Input

X000 ปุม่เปิด/ปิดพัดลม

X001 สวิทซ์เตรียมความพร้อม

X003 สวิทซ์ยกเลิกการเตรียมความพร้อม

X005 เลือกระดับเบา

X006 เลือกระดับแรง

Output

Y000 ไฟแสดงความพร้อม

Y001 Output ลมระดับเบา

Y002 MC ส�ำหรับพัดลม

Y003 Output ลมระดับแรง

 ไฟแสดงความพรอมทำงาน 

 เตรียมความพรอม  ยกเลิกการเตรียมความพรอม 

 ปุ่มเปิด/ปิดพัดลม 

Y000

X001

X000

X003

X005 X006
ระดับเบา ระดับแรง

พัดลม

   Output
ระดับลมแรง
    Y003

   Output
ระดับลมเบา
    Y001

   MC สำหรับพัดลม
          Y002
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5
• เฉลย ดูท้ายบท
• List program กรุณาดใูนภาคผนวก

《Circuit program》
กรุณาใส ่ Device ทีห่ายไปลงในชอ่งวา่ง และท�ำให้โปรแกรมสมบรูณ์

Y000

Y002 Y003

Inter lock

Y001

Y001

Y000
③

0

4

16

②

④

①

END

⑤

⑥

Y002

Y003
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5.4 ตัวอย่างการน�ำไปใช้งาน 4 (การควบคุมของเครื่อง Press)

เรามาลองคิด Program PLC โดยใช้ระบบควบคุมเครื่อง Press เป็นตัวอย่าง

《ระบบการควบคุม》
①	 สายพานล�ำเลยีงชิน้งานจะ ON (Y003) เมือ่สวทิซ์สายพานล�ำเลยีง (X001) ON อยู ่และจะท�ำการส่งงานไปยงัต�ำแหน่ง Press เมือ่

เซน็เซอร์ (X004) ท�ำการตรวจจบังานงานทีผ่ลติเสรจ็แล้วครบ 4 ตัว สายพานส�ำหรบัส่งงาน (Y003) จะ OFF และหยดุท�ำงาน
②	 หลงัจากสายพานหยดุท�ำงาน ออดแจง้เครือ่งเริม่ท�ำงาน (Y001) จะดงัประมาณ 1 วนิาท ีและหลงัจากนัน้จะเริม่ท�ำการ Press (Y002)
③	 เมือ่ Press (Y002) ด�ำเนนิการเสร็จภายใน 2 วนิาท ีออด (Y001) กจ็ะ OFF ในเวลาเดยีวกนั
④	 หลงัจากด�ำเนนิการ Press เสร็จแลว้ จ�ำนวนตวังานที ่Press จะถกู Reset และจะด�ำเนนิการขัน้ตอน 1-5 ใหมอ่กีครัง้

《I/O assignments (การกำ�หนด I/O)》
Input

X001 สวิทซ์สายพานล�ำเลียง

X004 เซ็นเซอร์นับจ�ำนวน

Output

Y001 ออดแจ้งเครื่องเริ่มท�ำงาน

Y002 Press output

Y003 สายพานล�ำเลียงชิ้นงาน

สายพานลำเลียงชิ้นงาน
Y003

สวิทซสายพานลำเลียง
X001

เซ็นเซอร
นับจำนวน
X004

Press output Y002

ออดแจงเครื่องทำงาน
Y001

ทิศทางลำเลียง

RUN
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5

กรุณาใส ่ Device ทีห่ายไปลงในชอ่งวา่ง และท�ำให้โปรแกรมสมบรูณ์

《Circuit program》

X004

X001 C0

Y003

0

4

8

21

18

END

③

①

④

C0
Y001

T0

Y002

T1

K10

K20

C0RST

②

• เฉลย ดูท้ายบท
• List program กรุณาดใูนภาคผนวก
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5.5 ตัวอย่างการน�ำไปใช้งาน 5 (Timing chart)
มาลองคิด Program PLC โดยยึด Timing chart เป็นตัวอย่างดู

《ระบบการควบคุม》
เมื่อสวิทซ์เริ่มงาน (X001) ON หลอดไฟ (Y000) ON ในเวลาเดียวกัน Timer (T0) จะเริ่มจับเวลา ออด (Y001) จะดัง 
เมื่อครบเงื่อนไขที่ตั้งไว้คือ เวลา Timer เกินจาก 2 วินาที และ Timer (T1) จะเริ่มจับเวลาพร้อมกัน
หลังจากนั้น MC (Y002), Motor (Y003), Solenoid valve (Y004) จะ ON ตามล�ำดับ ลดหลั่นกัน 2 วินาที  
เมื่อ Solenoid valve ล�ำดับสุดท้าย ON ครบ 2 วินาที Output ทั้งหมดจะ OFF 

《I/O assignment (การกำ�หนด I/O)》
Input

X001 สวิทซเ์ริ่มท�ำงาน

Output

Y000 หลอดไฟ

Y001 ออดหรือกริ่งเตือน

Y002 MC

Y003 Motor

Y004 Solenoid valve

สวิทซเริ่มทำงาน

ภายใน 2 วินาที

หลอดไฟ

ออด

MC

Motor

Solenoid valve

X001

Y000

Y001

Y002

Y003

Y004

ภายใน 2 วินาที

ภายใน 2 วินาที

ภายใน 2 วินาที

ภายใน 2 วินาที
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5

《Circuit program》 

กรุณาใส ่ Device ทีห่ายไปลงในชอ่งวา่ง และท�ำให้โปรแกรมสมบรูณ์

• เฉลย ดูท้ายบท
• List program กรุณาดใูนภาคผนวก
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5.6 เฉลยค�ำตอบ 

ตัวอย่างการติดตั้ง 3

① X001

② Y000

③ X003

④ X000

⑤ X005

⑥ X006

ตัวอย่างการติดตั้ง 4

① Y003

② C0 K4

③ T0

④ T1

ตัวอย่างการติดตั้ง 5

① Y000

② Y001

③ T1 K20

④ Y002

⑤ T2 K20

⑥ Y003

⑦ T3 K20

⑧ Y004

⑨ T4 K20
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ผนวก 1-1

เรามาลองสร้างโปรแกรมโดยการใช้คอมพิวเตอร์กันเถอะ!!!

ภาคผนวก 1

GX Developer

ขอแค่ใช้คอมพิวเตอร์เป็น ซีเควนซ์ (Sequence) ก็เป็นเรื่องง่ายๆ…
	 ในการจะสร้างหรือแก้ไขซีเควนซ์โปรแกรม (Sequence Program) สามารถด�ำเนินการได้อย่างง่ายดาย เสมือนการ 
วาดรูปง่ายๆ ด้วยซอฟแวร์ส�ำหรับติดตั้งในคอมพิวเตอร์ GX Developer
เพียงแค่เรียนรู้พื้นฐานการใช้งานเบื้องต้น ที่เหลือก็แค่การฝึกให้เกิดความช�ำนาญ
เป็นซอฟแวร์ (Software) ที่มีฟังก์ชันที่ใช้งานง่ายและหลากหลาย ก่อนอื่นเรามาเรียนรู้และท�ำความรู้จักกับการใช้งาน 
ที่จ�ำเป็นตามล�ำดับเพื่อให้เกิดความเชี่ยวชาญ และช�ำนาญในการใช้งานกันเถอะ

การเรยีกใช้งานและการปรบัปรงุแก้ไขกส็ามารถด�ำเนนิการได้อย่างราบรืน่…
	 การสร้างโปรแกรม (Program) กับการ Debug (แก้จุดบกพร่อง) เป็นของคู่กัน
เนื่องจากสามารถท�ำการแสดงผล (Monitoring) สภาพการท�ำงานของ Program และ PLC ได้จากจอคอมพิวเตอร์  
จึงสะดวกในการตรวจสอบการท�ำงานและแก้ไขให้เป็นไปตามที่ต้องการได้อย่างรวดเร็ว

โปรแกรม (Program) ดูง่ายไม่ซับซ้อน…
	 เพื่อให้สามารถดูซีเควนซ์โปรแกรม (Sequence Program) ได้ง่ายขึ้น ภายใน GX Developer จึงมีฟังก์ชัน 
“Comment input function”
เพียงแค่กรอก Comment เอาไว้ก็จะท�ำให้เข้าใจโปรแกรมได้ง่ายขึ้น และช่วยเพิ่มประสิทธิภาพในการจัดท�ำซีเควนซ์ 
โปรแกรม (Sequence Program) และ Debug (แก้จุดบกพร่อง) ได้
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ภาคผนวก 1.1	 ความรู้พื้นฐานเพื่อการใช้งาน GX Developer 
ภาคผนวก 1.1.1	 โครงสร้างหน้าจอของ GX Developer 

①	 Title bar
	 จะแสดงชื่อ Project ที่ก�ำลังเปิดท�ำงานอยู่ และ Icon การท�ำงานของ Windows 

② Menu bar① Title bar

④ Project data list

⑥ Status bar

⑤ Edit screen

③ Toolbar

การเปลี่ยนขนาดหรือจบการท�ำงาน GX Developer 

ชื่อ Project และ path 	ย่อขนาดหน้าต่าง GX Developer 	
	 ให้เล็กสุด

จบการท�ำงาน GX Developer

การปรับย่อขยายขนาดหน้าจอ
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ผนวก

1

②	Menu bar

กดเลือกเมนู แล้วจะมีหน้าจอเมนู Drop down แสดงขึ้นมา

③	 Toolbar

＊ : รายละเอียดของ Toolbar เนื่องจากสามารถท�ำการเคลื่อนย้ายหรือเอาออกได้ ท�ำให้หัวข้อที่แสดงและการจัดวางแตกต่างกันไป

หัวข้อไหนที่มีการใช้งานบ่อยๆ จะเอามาวางเป็น Icon buttons สามารถคลิกเลือกได้โดยตรง ซึ่งจะเสมือนการเลือก 
เครื่องมือจาก Menu bar

④	Project data list

หน้าจอในการสร้าง Ladder creating หรือหน้าจอ Set Parameter เป็นต้น จะแสดงโดย Tree structure

เมื่อน�ำเมาส์ไปวาง
จะปรากฏข้อความ
อธิบายรายละเอียด
ของฟังชันนั้นๆ

สามารถเลือกชื่อที่ปรากฏอยู ่
ได้โดยตรง โดยการคลิกเมาส์
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⑤	Edit screen

⑥	Status bar
	 ท�ำการแสดงสภาพการท�ำงานและการตั้งค่า

Device memory FX3U(C) Host station Ovrwrte CAP NUM SCRL

หน้าจอในการสร้าง Ladder creating หรือหน้าจอ monitor จะแสดงหลายรูปแบบในหน้าจอ

อธิบายต�ำแหน่งที่อยู่ของ Mouse CPU Type 	The Location of
	the CPU connected

CAP Lock Status Num Lock Status

⑤ Edit screen

แสดงโหมดที่ Input ในปัจจุบัน Scroll Lock Status
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ผนวก

1

ภาคผนวก 1.1.2	 เกี่ยวกับ “Project”

“Project” หมายถึง สิ่งที่รวม Program, Device comment, Parameter, Device Memory เข้าด้วยกัน 
GX Developer จะเรียกตัวรวบรวม Data ว่า Project ซึ่งจะเก็บไว้ใน Folder Windows

●	การ Edit หลาย Project 

ในกรณีที่ Edit Project มากกว่า 2 Project ด้วย GX Developer ให้เปิด GX Developer แยกขึ้นมาอีกต่างหาก

Project
เทียบเท่า Folder ของ Windows

	 Program	 PLC Program

	 Device Comment	 Comment ส�ำหรับ Device

	 Parameter	 Parameter set data ของ PLC

	 Device Memory	 รายละเอียดค่า Device ปัจจุบันหรือค่า Device ที่ Input ไปแล้ว
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ภาคผนวก 1.2	� การเรียกใช้งาน GX Developer และการจัดท�ำ 
Project ใหม่ 

ภาพผนวก 1.2.1	 การเรียกใช้งาน GX Developer 

①	 กดปุ่ม Start  Start Windows เลือก [Programs]
		  ↓
	 [MELSOFT Application]
		  ↓
	 เลือก [GX Developer] 

②	GX Developer เริ่มท�ำงาน
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1

①	 เลือก จาก Toolbar หรือเลือก [Project]
	 → [New Project] ( Ctrl  + N ) จากเมนู 

ภาคผนวก 1.2.2	 การจัดท�ำ Project ใหม่ (New Project)

②	 คลิกปุ่ม [▼] ของ PLC Series
③	 เลือก “FXCPU”

④	 คลิกปุ่ม [▼] ของ PLC type
⑤	 เลือก “FX3G”
(ข้อควรระวัง) �ท�ำการเลือกให้ตรงกับ รุ่น PLC ที่ท่านใช้งาน

อยู่ปัจจุบัน 

① คลิก

① คลิก

② คลิก

③ คลิก แล้วเลือก

④ คลิก

⑤ คลิก แล้วเลือก
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⑥	 คลิก OK  

⑦	หน้าจอ Project ใหม่จะปรากฏสภาพพร้อมที่สามารถท�ำการ 
Input Project 

⑥ คลิก

⑦ New project screen
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ผนวก

1

ภาคผนวก 1.3	 การสร้างโปรแกรมหรือวงจร (Circuit)
ภาคผนวก 1.3.1	� การสร้างโปรแกรมหรือวงจร (Circuit) โดยใช ้

ฟังก์ชันคีย์ (Function Key)

[Program ที่จะจัดสร้าง]

Point

Point

ในเอกสารฉบับนี้ จะแสดงหมายเลข Input 
relay (X), Output Relay (Y) เป็นสามหลัก 
“X000”, “Y000” 
เมื่อ Input จากคอมพิวเตอร์ จะสามารถย่อ
ได้เป็น “X0”, “Y1”

●● Function Key และ ladder elements จะถูกแสดงที่ ปุ่มบน Toolbar

Key หลักๆ ที่ใช้งาน

●● ในตอนที่จัดสร้าง Program ขอให้ตรวจสอบว่าเลือกโหมด “Write mode” เรียบร้อยแล้ว

การเลือกจาก Toolbar ท�ำการเลือกจากเมนู ([Edit] → [Write mode])

●● การป้อนตัวอักษรขอให้ป้อนเป็นตัวพิมพ์เล็ก
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①	 กดปุ่ม F5  
	 Input “X2”

⑥	 Ladder ที่ input แล้ว  จะปรากฏขึ้นมา
⑦	 กด F7 (    　　)(　) หรือ input “Y0”
⑧	ท�ำการยืนยันโดยกด Enter  หรือ [OK]

⑨	 Ladder ที่ input แล้ว (     　　)(Y0) จะปรากฏขึ้นมา
⑩	 กด Shift  + F5  หรือ input “Y0”
⑪	ท�ำการยืนยันโดยกด Enter  หรือ [OK]

③	 Ladder ที่ input แล้ว
X2

จะปรากฏขึ้นมา
④	 กด F6  หรือ input “X0”
⑤	ท�ำการยืนยันโดยกด Enter  หรือ [OK]

กด ESC หรือ [Exit] 
เพื่อ Cancel

②	ท�ำการยืนยันโดยกด Enter  หรือ [OK]

 

 

③ Ladder element จะปรากฏขึ้นมา

⑥ Ladder element จะปรากฏขึ้นมา

⑨ Ladder element จะปรากฏขึ้นมา

④ Input “X0”

⑦ Input “Y0”

⑩ Input “Y0”

① Input “X2” ② Input the Enter  

⑤ Input Enter  

⑧ Input Enter

⑪ Input Enter  
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1

⑫	 Ladder ที่ input แล้ว
Y0

จะปรากฏขึ้นมา
⑬	ท�ำการเคลื่อนเคอเซอร์มาไว้หน้าสุด
⑭	 กด F5  หรือ input “X3”
⑮	ท�ำการยืนยันโดยกด Enter  หรือ [OK]

⑯	 Ladder ที่ input แล้ว
X3

จะปรากฏขึ้นมา
⑰	 กด F7 (    　　)(　) หรือ input “Y1”
⑱	ท�ำการยืนยันโดยกด Enter  หรือ [OK]

⑲	 Ladder ที่ input แล้ว (     　　)(Y1) จะปรากฏขึ้นมา!! 
เสร็จสิ้นการด�ำเนินการจัดสร้าง Program!!

F4  (Convert)

ท�ำการลบสีเทาออกและยืนยัน Program 
กรณีที่เกิด Error เคอร์เซอร์จะเคลื่อนตัวไปต�ำแหน่งที่เกิดปัญหาขึ้น  
ขอให้ตามไปแก้ไข

⑳	 การแปลง Program (ส�ำคัญ)
	 ท�ำการแปลง Program เพื่อให้ต�ำแหน่งที่ยังไม่ถูกยืนยัน 

(บริเวณสีเทา) สามารถเริ่มท�ำงานได้ 

	 กดเลือก F4  (Convert) 
	 หรือเลือก Toolbar  หรือเลือก [Convert] → [Convert] 

จากเมนู

⑫ Ladder element จะปรากฏขึ้นมา

⑯ Ladder element จะปรากฏขึ้นมา

⑲ Ladder element จะปรากฏขึ้นมา

⑳ ท�ำให้ส่วนที่ปรากฏเป็นสีเทาหายไป

⑬ ย้ายเคอร์เซอร์

⑭ Input “X3”

⑰ Input “Y1”

⑮ Input Enter  

⑱ Input Enter  
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ภาคผนวก 1.3.2	 จัดสร้าง Program โดยการใช้ Toolbar 

[Program ที่จะจัดสร้าง]

Point

Point

ในเอกสารฉบับนี้ จะแสดงหมายเลข Input 
relay (X), Output Relay (Y) เป็นสามหลัก 
“X000”, “Y000” 
เมื่อ Input จากคอมพิวเตอร์ จะสามารถย่อ
ได้เป็น “X0”, “Y1”

●● Function Key และ ladder elements จะถูกแสดงที่ ปุ่มบน Toolbar

Key หลักๆ ที่ใช้งาน

●● ในตอนที่จัดสร้าง Program ขอให้ตรวจสอบว่าเลือกโหมด “Write mode” เรียบร้อยแล้ว
การเลือกจาก Toolbar ท�ำการเลือกจากเมนู ([Edit] → [Write mode])

●● การ Input ตัวอักษร จะ Input ด้วยอักษรภาษาอังกฤษตัวพิมพ์เล็ก 



ผนวก 1-13

ผนวก

1
⑥	 Ladder ที่ input แล้ว  จะปรากฏขึ้นมา
⑦	 เลือก  จาก Toolbar แล้ว input “Y0”
⑧	ท�ำการยืนยันโดยกด Enter  หรือ [OK]

⑨	 Ladder ที่ input แล้ว (     　　)(Y0) จะปรากฏขึ้นมา
⑩	เลือก  จาก Toolbar และ input “Y0”
⑪	ท�ำการยืนยันโดยกด Enter  หรือ [OK]

กด ESC  หรือ [Exit] 
เพื่อ Cancel

③	 Ladder ที่ input แล้ว
X2

จะปรากฏขึ้นมา
④	 เลือก  จาก Toolbar แล้ว input “X0”
⑤	ท�ำการยืนยันโดยกด Enter  หรือ [OK]

②	ท�ำการยืนยันโดยกด Enter  หรือ [OK]

①	 คลิกเลือก  จาก Toolbar และ Input “X2”

③ Ladder element จะปรากฏขึ้นมา

⑥ Ladder element จะปรากฏขึ้นมา

⑨ Ladder element จะปรากฏขึ้นมา

① Input “X2”

④ Input “X0”

⑦ Input “Y0”

⑩ Input “Y0”

② คลิก

⑤ คลิก

⑧ คลิก

⑪ คลิก
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⑫	 Ladder ที่ input แล้ว
Y0

จะปรากฏขึ้นมา
⑬	ท�ำการเคลื่อนเคอเซอร์มาไว้หน้าสุด
⑭	 เลือก  จาก Toolbar และ input “X3”
⑮	ท�ำการยืนยันโดยกด Enter  หรือ [OK]

⑯	 Ladder ที่ input แล้ว
X3

จะปรากฏขึ้นมา
⑰	 เลือก  จาก Toolbar และ input “Y1”
⑱	ท�ำการยืนยันโดยกด Enter  หรือ [OK]

⑲	 Ladder ที่ input แล้ว (     　　)(Y1) จะปรากฏขึ้นมา!! 
เสร็จสิ้นการด�ำเนินการจัดสร้าง Program!!

F4  (Convert)

ท�ำการลบสีเทาออกและยืนยัน Program 
กรณีที่เกิด Error เคอร์เซอร์จะเคลื่อนตัวไปต�ำแหน่งที่เกิดปัญหาขึ้น 
ขอให้ตามไปแก้ไข

⑳	 การแปลง Program (ส�ำคัญ)
	� ท�ำการแปลง Program เพื่อให้ต�ำแหน่งที่ยังไม่ถูกยืนยัน 

(บริเวณสีเทา) สามารถเริ่มท�ำงานได้ 

	 กดเลือก F4  (Convert) 

	 หรือเลือก Toolbar  หรือเลือก [Convert] → [Convert] 
จากเมนู

⑫ Ladder element จะปรากฏขึ้นมา

⑯ Ladder element จะปรากฏขึ้นมา

⑲ Ladder element จะปรากฏขึ้นมา

⑳ ท�ำให้ส่วนที่ปรากฏเป็นสีเทาหายไป

⑬ ย้ายเคอร์เซอร์

⑭ Input “X3”

⑰ Input “Y1”

⑮ คลิก

⑱ คลิก
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ภาคผนวก 1.4	 การเขียน Program ลง PLC
Sequence Program ที่จัดท�ำขึ้นจะเขียนใส่ใน FX PLC

ภาคผนวก 1.4.1	 การเชื่อมต่อกับ PLC
การต่อกับ FX3G PLC (เชื่อมต่อโดยใช้สาย USB)
[ขั้นตอนการเตรียมการด้านคอมพิวเตอร์]
จ�ำเป็นต้อง Install USB Driver ลงในคอมพิวเตอร์เพื่อท�ำการต่อสาย USB ระหว่างคอมพิวเตอร์กับ FX3G PLC
ขั้นตอนการ Install Driver ให้ปฏิบัติตามคู่มือใน [GX Developer Operation Manual (บท Start up)]

(รูปแบบการเชื่อมต่อ) 

USB

GX Developer

[Port (USB)]
built in PLC

USB cable
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ภาคผนวก 1.4.2	 “Transfer Setup” ใน GX Developer

ด�ำเนินการ Setting GX Developer เพื่อเชื่อมต่อกับ PLC 

①	 จากเมนูเลือก [Online] → [Transfer Setup]
②	 ดับเบิลคลิกที่ Icon 

⑤	 คลิก [Connection Test] เพื่อตรวจสอบการ communicate กับ 
PLC 

⑥	หลังตรวจสอบเรียบร้อยแล้วคลิก [OK] เพื่อท�ำการยืนยันเนื้อหา
ที่ Set ไป 

③	ท�ำการ Set Communication port ของคอมพิวเตอร์
	 • �ท�ำการเลือก [USB (GOT transparent mode)] เมื่อจะท�ำ 

การเชื่อมต่อไปที่ FX3G PLC USB port (Built in) 
④	หลังจากเลือกเสร็จ คลิก OK 

① แสดงหน้าจอ Transfer Setup

② ดับเบิลคลิก

③ เลือก

④ คลิก

⑤ คลิก

⑥ คลิก
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ภาคผนวก 1.4.3	 การเขียน Program

①	ท�ำการสลับตรงสวิทซ์ [RUN/STOP] ของ PLC เป็น [STOP]

③	คลิก [Param + Prog.]
④	คลิก [Execute]

②	ท�ำการเลือก  จาก Toolbar หรือจากเมนู 
	 เลือก [Online] → [Write to PLC] 

⑤ เมื่อด�ำเนินการเสร็จสิ้นคลิก [OK] 

	 จะปรากฏ Dialog box แสดงสถานะการ Write 

⑤ คลิก

④ คลิก

③ เลือก data ที่จะด�ำเนินการ

① เลือก STOP

② คลิก
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ภาคผนวก 1.4.4	 การ Monitoring การท�ำงานของ PLC

①	ท�ำการสลับตรงสวิทซ์ [RUN/STOP] ของ PLC เลือก [RUN]

②	ท�ำการเลือก  จาก Toolbar หรือจากเมนู 
	 เลือก [Online] → [Monitor] → [Monitor Mode] 

①	 เมื่อ [switch X000 “OFF”] แล้วท�ำการ [switch X002 “ON”] ให้ท�ำการตรวจดูว่า [Output Y000 “ON”] หรือไม่
②	ท�ำการตรวจสอบว่าเมื่อ [switch X002 “OFF”] [Output Y000 “ON”] หรือไม่ 
③	ท�ำการตรวจสอบว่าเมื่อ [switch X000 “ON”] [Output Y000 “OFF”] หรือไม่
④	ท�ำการตรวจสอบว่าเมื่อท�ำการสลับ [switch X003 “ON/OFF”] [Output Y001 “ON/OFF”] หรือไม่

ตรวจสอบการท�ำงาน ได้จาก Monitor Mode 

① เลือก RUN

② คลิก
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(1)	แสดง Monitor Status Dialog 

① ② ③ ④

อ้างอิง

①	 Scan time

	 แสดง Scan time สูงสุดของ PLC Program 

②	 PLC Status

	 แสดง PLC Status 

③	 Execute status display

	 ต�ำแหน่งที่ท�ำงาน (Execute) จะกะพริบ 

④	 Memory type

	 แสดง Memory type ของ PLC 

①	 ค�ำสั่งหน้าสัมผัส (Contact Instruction)

Input contact
Type X0 : OFF X0 : ON

หน้าสัมผัสปกติเปิด a
(N.O.Contact)

X000

หน้าสัมผัสเปิด 
(Contact open)

X000

หน้าสัมผัสปิด
(Contact close)

หน้าสัมผัสปกติปิด b
(N.C.Contact)

X000

หน้าสัมผัสปิด 
(Contact close)

X000

หน้าสัมผัสเปิด 
(Contact open)

②	 ค�ำสั่งเอาท์ (Out Instruction)

Drive status
Type ไม่ท�ำงาน/ไม่เคลื่อนไหว ท�ำงาน/เคลื่อนไหว

OUT Instruction
Y000 Y000

SET Instruction. Etc.
SET M0 SET M0

ค�ำสั่ง RST (RST Instruction) คือ การแสดง ON/OFF ของ Device ที่จะ Reset

Drive status
Type Reset Device OFF Reset Device ON

RST instruction
RST M0 RST M0

(2)	วิธีดูการแสดง Status ของ Ladder Monitor



ผนวก 1-20

ภาคผนวก 1.5	 การแก้ไข Program (Editing program) 
ภาคผนวก 1.5.1	 แก้ไข Program 

Point

●● เมื่อจะท�ำการแก้ไข Program ให้เลือก “Write mode”
	 ท�ำการเลือกจาก Toolbar	 ท�ำการเลือกจากเมนู ([Edit] → [Write mode])

●● ตัวหนังสือที่ใช้ ขอให้เป็นตัวพิมพ์เล็กทั้งหมด ตัวพิมพ์ใหญ่ไม่สามารถใช้งานได้

●● การเลือกระหว่าง [Ovrwrte], [Insert]
	 • กรณีที่ท�ำการแก้ไข Program ที่มีอยู่เดิม ขอให้เลือก [Ovrwrte]
	 • เมื่อท�ำการเลือกโหมด [Insert] จะเป็นการเพิ่ม Program ใหม่ แยกเป็นอีก Program

	กด Insert  เพื่อท�ำการเลือก
	 ระหว่าง [Ovrwrte], [Insert]
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① �ท�ำการเปลี่ยนหมายเลขของ OUT Coils หรือ Contact

[Program ที่จะแก้]

③	ท�ำการยืนยันโดยกด Enter  หรือ [OK]
④	 ผลการแก้ไขจะถูกแสดงในกรอบสีเทา 

①	 ดับเบิลคลิกตรงต�ำแหน่งที่ต้องการแก้ไข

⑤	 กด F4  (Convert) เพื่อท�ำการยืนยันเนื้อหาการเปลี่ยนแปลง

②	ท�ำการเปลี่ยน “Y001” → “Y002”

①ダブルクリック

F4  (Convert) 

X002

Y000

X000

X003
Y001

Y002

Y000

เปลี่ยนเป็น 

① ดับเบิลคลิก

④ แสดงผลการแก้ไข

② เปลี่ยนเป็น “Y002” ③ กด Enter
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② การเพิ่ม Lines

[Program ที่จะท�ำการเพิ่ม Lines]

③	 Line จะเพิ่มขึ้นตามต�ำแหน่งที่ลากเคอร์เซอร์
④	 วางเคอร์เซอร์ในต�ำแหน่งที่ต้องการเพิ่ม OUT Coil แล้วคลิก 

 จาก Toolbar

①	 คลิก  ( F10 ) จาก Toolbar 

X002

Y000

X000

X003
Y002

Y000

Y003

②	 เมื่อน�ำเคอร์เซอร์ไปวางด้านขวาบนของต�ำแหน่งที่ต้องการเพิ่ม 
Line แล้ว ให้ท�ำการลากเส้น 

⑤ Input “Y3” เข้าไป
⑥ ท�ำการยืนยันโดยกด Enter  หรือ [OK]

ท�ำการเพิ่ม Line แนว
ตั้ง/แนวนอน แล้วท�ำ 
การสร้าง OUT Coil

① คลิก

② ลาก

⑤ Input “Y3”

③ เพิ่ม Line

④ ต�ำแหน่งเคอร์เซอร์

น�ำเคอร์เซอร์ไปวางด้านขวาบน 
ต�ำแหน่งเริ่มลากเส้น Line

⑥ กด Enter
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⑧	ท�ำการกด F4  (Convert) เพื่อยืนยันการเปลี่ยนแปลง

⑦	 เมื่อท�ำการเพิ่ม Ladder แล้ว จะแสดงเป็นบล็อกสีเทา

⑧ F4  (Convert)

•	 เมื่อด�ำเนินการเสร็จแล้ว ท�ำการคลิก  จาก Toolbar อีกครั้ง

⑦ เสร็จสิ้นการเพิ่ม Ladder
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③ การลบ Lines

[Program ที่ต้องการลบ Lines]

③	ท�ำการลบ Line
④	OUT Coils ท�ำการลบโดยกด Delete

①	 คลิก  ( Alt + F9 ) จาก Toolbar 

X002

Y000

X000

X003
Y002

Y000

Y003

②	ท�ำการลากเคอร์เซอร์จากด้านขวาบน Line ที่ต้องการยกเลิก 
ไปถึงต�ำแหน่งสุดท้ายของ Line

ต้องการลบ 
Line นี้

③ ลบ Line

④ ลบโดยกด Delete

วางเคอร์เซอร์ที่ต�ำแหน่งขวาบน 
จุดเริ่มของ Line ที่ต้องการจะลบ

② ลาก

① คลิก
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⑤ Line ที่ต้องการจะลบจะแสดงขึ้นมาเป็นกรอบสีเทา

⑥ กด F4  (Convert) ท�ำการยืนยันการเปลี่ยนแปลง⑥ F4  (Convert)

•	 เมื่อด�ำเนินการเสร็จแล้ว ท�ำการคลิก  จาก Toolbar อีกครั้ง
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ภาคผนวก 1.5.2	 การแทรก/ลบ Rows

① การแทรก Rows

[Program ที่ต้องการแทรก Rows]

③	 เสร็จสิ้นการแทรก Rows

X002

Y000

X000

X003
Y002

X001

Y000

Y001

②	ท�ำการคลิกขวาในต�ำแหน่งใดก็ได้ เพื่อเลือก [Insert row]

การแทรก Rows ท�ำการแทรกด้านบนแถวที่เคอร์เซอร์วางอยู่

①	น�ำเคอร์เซอร์วางแถวล่างของแถวที่ต้องการแทรก

④	ท�ำการเพิ่ม Ladder ลงในแถวที่แทรกเข้าไปใหม่ 
X001

Y001

⑤	ท�ำการกด Convert (F4) เพื่อยืนยันการเปลี่ยนแปลง

ต้องการเพิ่ม 
Rows นี้

③ ท�ำการเพิ่ม Rows ใหม่

④ เพิ่ม Ladder

	①	น�ำเคอร์เซอร์มาวางต�ำแหน่ง
		  ด้านล่างแถวที่ต้องการจะเพิ่ม

เลือก “Insert row”

② คลิกขวา
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② การลบ Rows

[Program ที่ต้องการลบ Rows]

③	 แถวถูกลบไปเรียบร้อย

①	 ย้ายเคอร์เซอร์ไปวางใน Rows ที่ต้องการลบ

②	 วางเมาส์ในต�ำแหน่งใดก็ได้แล้วคลิกขวา เลือก [Delete Row] 

กรณีที่การลบ Rows จะไม่มีการแสดงเป็นกรอบ 
สีเทา ให้กด Convert F4 เพื่อท�ำการยืนยันการ 
ด�ำเนินการ

Point

X002

Y000

X000

X003
Y002

X001

Y000

Y001

	①	�ย้ายเคอร์เซอร์ไปวาง
		  ในแถวที่ต้องการลบ

ต้องการลบ  
Rows นี้

③ แถวถูกลบไปเรียบร้อย

เลือก “Delete Row”

② 
คลิกเมาส์ขวา
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ภาคผนวก 1.5.3	 การ Cut & Copy (Pasting) Ladder 

① การ Cut 

[Program ที่ต้องการ Edit]

①	 ย้ายเคอร์เซอร์มาวางหน้า Ladder ที่ต้องการ Cut

X002

Y000

X000

この行を
切り取る

X001

Y000

Y001

②	ท�ำการลากคลุมทุกต�ำแหน่ง

③	Cut โดยเลือก  จาก Toolbar หรือเลือก [Edit] → [cut]  

( Ctrl  + X ) แล้วท�ำการ Cut

④	บริเวณที่เลือกไว้จะถูก Cut
	 กรณี Cut บางส่วนของ Ladder จะเหลือแสดงเป็นแถบสีเทาอยู่ 

หลังจากแก้ Ladder ไว้ กด F4  (Convert) เพื่อยืนยัน 
การด�ำเนินการ

ต้องการ Cut 
ต�ำแหน่งนี้

	①	ย้ายเคอร์เซอร์มาวาง
		  ต�ำแหน่งหน้าสุดที่ต้องการ

บริเวณที่ต้องการ Cut, Copy

② ท�ำการลากคลุมบริเวณ

④ บริเวณที่เลือกไว้โดน Cut ไป

③ เริ่ม Cut
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น�ำ Program ที่ “cut” แล้วมาวางแถวหน้า
①	ท�ำการย้ายเคอร์เซอร์มาวางไว้ที่แถวหน้าของ Ladder ที่จะ

ท�ำการ Copy 

②	ท�ำการลากคลุมต�ำแหน่งจบ
③	ท�ำการเลือก  ที่ Toolbar หรือเลือกเมนู [Edit] → [Copy]  

( Ctrl  + C )

⑤	ท�ำการเลือก  จาก Toolbar หรือเลือก [Edit] → [Paste]  
( Ctrl + V ) จากเมนู

	 กรณีต้องการ Paste เฉพาะบางส่วนของ Program จะมี 
การแสดงเป็นกรอบสีเทา ให้กด F4  (Convert) เพื่อเป็น 
การยืนยัน 

④	 ย้ายเคอร์เซอร์มาวางในต�ำแหน่งที่ต้องการ Paste

การกดเปลี่ยน Insert

[Ovrwrte] mode : การ Paste โดยการเขียนทับ 
ในต�ำแหน่งที่เคอร์เซอร์วาง

[Insert] mode : ท�ำการ Insert ข้างบนต�ำแหน่งที่
วางเคอร์เซอร์

Point

② Copy (Pasting)

Y000

X000

X002
Y000

この行を
コピーする

X002
Y000

Y000

X000 この行に
貼り付け

ส่วนของโปรแกรมที่ต้องการ Copy (Pasting)

② ลากเคอร์เซอร์จนถึงต�ำแหน่งจบ

⑤ Copy & Paste เรียบร้อยแล้ว

③ เริ่ม Copy

Paste

Copy

	①	 ย้ายเคอร์เซอร์มาวางต�ำแหน่ง
		  แรกสุดที่ต้องการ Copy

	④	น�ำเคอร์เซอร์ย้ายไปต�ำแหน่ง
		  ที่ต้องการ Paste
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ภาคผนวก 1.6	 การบันทึก Program ที่จัดท�ำเสร็จแล้ว 
ภาคผนวก 1.6.1	 การ Save, Save as

Point

①	ท�ำการเลือก  จาก Toolbar หรือเลือก [Project] → [Save] 
จากเมนู ( Ctrl + S )

⑥	 จะมี Dialog box ปรากฏขึ้นมา คลิก YES  

	� กรณี Save ใน แผ่น Floppy disk ความจุ อาจไม่พอ ให้ท�ำการ 
Save ใน Hard disk แล้วค่อยท�ำการย้ายจาก Hard disk ไปที่ 
Floppy disk 

②	 ก�ำหนด Destination ของ Project 
③	 ตั้งชื่อ Project
④	 สามารถก�ำหนด Title ได้ เช่น รายละเอียดของ Project (option)
⑤	 คลิก Save  

(เฉพาะกรณี Save as เท่านั้น)

กรณีที่ Ladder ยังไม่ได้รับการยืนยัน ให้กด F4 Convert

(กรณี Overwrite)

Save Program เสร็จเรียบร้อย

อ้างอิง
●● Project name ไม่สามารถใช้สัญลักษณ์ด้านล่างได้  
/ , \, > , < , * , ? , ” , “ , ｜, : , ; ( ; , \ สามารถใช้ได้เฉพาะ Drive ที่ก�ำหนดเท่านั้น) และพยางค์สุดท้ายของ Project 
name ห้ามใช้ . (period)

●● กรณีท�ำการตั้งชื่อ Project มากกว่า 8 ตัวอักษรโดยใช้ GX Developer (SW6D5-GPPW เป็นต้นไป) แล้ว Load ด้วย 
Version GX Developer (ก่อน Version SW2D5-GPPW) ตัวอักษรหลังจากหลักที่ 8 จะไม่แสดง

●● จ�ำนวนตัวอักษร Project path + Project name ตัวพิมพ์เล็กไม่เกิน 150 ตัว (ตัวพิมพ์ใหญ่ไม่เกิน 75 ตัว)
●● ตัวอักษรของ Title ตัวพิมพ์เล็กไม่เกิน 32 ตัว (ตัวพิมพ์ใหญ่ไม่เกิน 16 ตัว)
●● กรณีที่ Project path + Project name มีการเว้นวรรคด้วย ถึงจะดับเบิลคลิก File GPPW.gpj, ***.gps file ใน Explorer 
GX Developer ก็จะท�ำงานไม่ปกติ

●● กรณีที่ Project path + Project name มีการเว้นวรรคด้วย ให้ท�ำการเปิด Project ดังนี้ หลังจาก Run ด้วย Explorer → 
[Project] → [Project open] 

④ ใส่ Title ของไฟล์

① คลิก

③ ตั้งชื่อ Project

	 ②	ก�ำหนด Destination 
		  ในการ Save as ไฟล์

⑤ คลิก

⑥ คลิก
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ภาคผนวก 1.6.2	 การ Save as 

①	 เลือก [Project] → [Project save as] จากเมนู

②	ท�ำการก�ำหนด Destination ของ Project
③	 ก�ำหนดชื่อ Project
④	 สามารถก�ำหนด Title ได้ เช่น รายละเอียดของ Project (option)
⑤	 คลิก Save

⑥ จะมี Dialog box ปรากฏขึ้นมา คลิก YES

วิธีการตั้งชื่อ Drive/Path name และ Project name อ้างอิงหน้า 
ก่อนหน้า

กรณี Save ใน แผ่น Floppy disk ความจุ อาจไม่พอ ให้ท�ำการ 
Save ใน Hard disk แล้วค่อยท�ำการย้ายจาก Hard disk ไปที่ 
Floppy disk 

Point

กรณีที่ Ladder ยังไม่ได้รับการยืนยัน ให้กด F4 Convert

① คลิก

⑤ คลิก

③ ตั้งชื่อ Project

	 ②	ก�ำหนด Destination 
		  ในการ Save as ไฟล์

④ ใส่ Title ของไฟล์

⑥ คลิก
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ภาคผนวก 1.6.3	 การ Reading Project

①	 เลือก  จาก Toolbar หรือเลือก [Project] → [Open 
proejct] ( Ctrl  + O ) จากเมนู

กรณี Reading Proejct โดยที่เปิดอีก Project ค้างอยู่ Project นั้นจะถูกปิด 

กรณีที่ Project นั้น ยังไม่ได้ Convert ladder หรือยังไม่ได้ Save จะมีข้อความแจ้งเตือนปรากฏขึ้นมา

อ้างอิง

② ท�ำการเลือก Destination ของ Proejct 
③ เลือก Read Project
④ คลิก Open เพื่อเลือก Read Project 

① คลิก

	 ②	ก�ำหนด Destination 
		  ของ Project

④ คลิก

③ เลือกชื่อ Project
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ภาคผนวก 1.7	 การท�ำงานที่จ�ำเป็นในการ Debug Program
เรื่องการอ่าน Program หรือการเชื่อมต่อ PLC ขอให้อ้างอิง [ภาคผนวก 1.4 การเขียน Program ใน PLC]

ภาคผนวก 1.7.1	 Laddet Monitor
ท�ำการ Monitor สภาพการท�ำงานของ Coils หรือสภาพการท�ำงาน Contact ในแต่ละจุดในขณะที่ Program ก�ำลังแสดงอยู่

②	ที่ Ladder Monitor จะแสดงค่าปัจจุบัน ของ word device 
(timer, counter, data register) และสถานะการ ON/OFF ของ 
Ladder

③	 เมื่อต้องการจบการท�ำงานของ Ladder monitor ให้คลิกขวา 
บนหน้าจอ เลือก [Stop monitor]

④	 เมื่อต้องการแก้ไขหรือเขียน Program เลือก  จาก Toolbar 
หรือเลือก [Edit] → [Write mode] จากเมนู

①	 เลือก  จาก Toolbar หรือเลือก [Online] → [Monitor] → 
[Monitor mode]
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(1)	แสดง Monitor Status Dialog 

① ② ③ ④

อ้างอิง

①	 Scan time

	 แสดง Scan time สูงสุดของ PLC Program 

②	 PLC Status

	 แสดง PLC Status 

③	 Execute status display

	 ต�ำแหน่งที่ท�ำงาน (Execute) จะกะพริบ 

④	 Memory type

	 แสดง Memory type ของ PLC 

(2)	วิธีดูการแสดง Status ของ Ladder Monitor

①	 ค�ำสั่งหน้าสัมผัส (Contact Instruction)

Input contact
Type X0 : OFF X0 : ON

หน้าสัมผัสปกติเปิด a
(N.O.Contact)

X000

หน้าสัมผัสเปิด 
(Contact open)

X000

หน้าสัมผัสปิด
(Contact close)

หน้าสัมผัสปกติปิด b
(N.C.Contact)

X000

หน้าสัมผัสปิด 
(Contact close)

X000

หน้าสัมผัสเปิด 
(Contact open)

②	 ค�ำสั่งเอาท์ (Out Instruction)

Drive status
Type ไม่ท�ำงาน/ไม่เคลื่อนไหว ท�ำงาน/เคลื่อนไหว

OUT Instruction
Y000 Y000

SET Instruction. Etc.
SET M0 SET M0

ค�ำสั่ง RST (RST Instruction) คือ การแสดง ON/OFF ของ Device ที่จะ Reset

Drive status
Type Reset Device OFF Reset Device ON

RST instruction
RST M0 RST M0
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ภาคผนวก 1.7.2	 Device registration monitor

① การ Register Device อื่นๆ
เรื่องการ Register Device อื่นๆ (Optional Device) ในหน้าจอ Monitor และการ Monitor เฉพาะ Parts ที่ต้องการ

④ ท�ำการ Input device number ในหน้าจอ Register device

⑤ คลิก [Register]

⑥ Device จะถูกบันทึกลงใน Monitor window

⑦ เมื่อคลิก [Start monitor] จะปรากฏ สถานะ ON/OFF ของ Coils 
และค่าตัวเลข รวมถึงจุดสถานะตามการท�ำงานของ Device นั้น

①	 เปิดหน้าจอ Ladder monitor (อ้างอิงภาคผนวก 1.7.1)

③ คลิก [Register devices] ในหน้าจอ [Entry data monitor]

②	ท�ำการเลือก [Online] → [Monitor] → [Entry data monitor] 
จากเมนูหรือท�ำการคลิกขวาบนหน้าต่าง Program แล้วเลือก 
[Entry data monitor]

③ คลิก

⑤ คลิก

⑦ คลิก

④ Input device

กรณีที่ต้องการ monitor 
Device 32 bit ขอให้เลือก 
[32 bit integer]
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①	 ไปที่หน้าจอ Monitor mode (อ้างอิงภาคผนวก 1.7.1)

②	ท�ำการเลือก [Online] → [Monitor] → [Entry data monitor] 
หรือคลิกขวาที่หน้าจอ Ladder เลือก [Entry data monitor] 
(อ้างอิงหน้าก่อนหน้า)

② การ Register Device ระหว่างที่ Ladder monitor ก�ำลังแสดง
ก�ำหนดขอบเขตการแสดงผลโดยเลือกจากหน้าจอ Ladder monitor และท�ำการ Register device ที่อยู่ในขอบเขตนั้น

⑤	 คลิกที่จุดเริ่มของ Ladder

⑥	 กด [Shift] ค้างและคลิกที่จุดสุดท้าย เพื่อท�ำการเลือกขอบเขต

⑦	ท�ำการลาก ขอบเขตที่เราเลือกไว้ ลงมาใน [Entry data monitor 
windows] โดยกด [Ctrl]

⑧	ท�ำการ Register Device ใน Monitor windows

⑨	 เมื่อคลิก [Start monitor] จะปรากฏ ต�ำแหน่ง Coils status  
ON/OFF และค่า ตามการท�ำงานของ Device

③	 ท�ำการเลือก [Windows] → [Tile horizontally] จะปรากฏ 
[Ladder monitor windows] และ [Entry data monitor windows] 
ขึ้นเรียงกัน (ท�ำให้ [Entry data monitor windows] อยู่ในสถานะ 
Stop monitoring) 

④	 [Ladder monitor windows] และ [Entry data monitor 
windows] จะปรากฏจากบนลงล่าง 

③ คลิก

⑥ กด [Shift] จนสุดท้าย
⑤ เริ่มลากจุดนี้

⑦ ลาก

⑨ คลิก
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ภาคผนวก 1.7.3	 Device batch monitor (การเรียกดู Device ทั้งหมด)
ท�ำการระบุตัว Device แรก และท�ำการ Monitor Device ต่อเนื่อง 

①	 ไปที่หน้าจอ Monitor mode (อ้างอิงภาคผนวก 1.7.1)

④	ปรากฏ Coils Status ON/OFF และค่า ตามการท�ำงานของ 
Device

③ ท�ำการใส่หมายเลขแรกของ Device ที่จะ Monitor ใน Windows 
[Device batch monitor] กด Enter  หรือคลิก [Start monitor]

②	ท�ำการเลือก [Online] → [Monitor] → [Device batch] หรือ
คลิกขวาที่หน้าจอ Ladder เลือก [Device batch]

③ Device input
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ภาคผนวก 1.7.4	 Device Test

① Force ON/OFF (การบังคับเปิด/ปิด)
ท�ำการ Force ON/OFF Bit Device ของ PLC (เช่น M, Y, T, C) (จะไม่ Force ON/OFF ใน X) ในตอนที่ PLC ก�ำลัง RUN อยู่ จะท�ำการ  
ON/OFF เฉพาะเมื่อครบ 1 Cycle เท่านั้น จะต้องให้ Sequence Program ท�ำงานให้เสร็จสิ้นก่อน ในกรณีที่จะด�ำเนินการอื่นๆ อย่างเช่น 
ตรวจสอบ Output ต้องให้ PLC อยู่ในสถานะ STOP ก่อน

①	 ไปที่หน้าจอ Monitor mode (อ้างอิงภาคผนวก 1.7.1)

②	ท�ำการเลือก [Online] → [Debug] → [Device Test] หรือ 
คลิกขวาที่หน้าจอ Program เลือก [Device test] 

Force ON/OFF (Ladder Monitor Windows)
ท�ำการกด [Shift] ค้าง ใน Bit Device ไหนก็ได้ (Contact, Coil) บน Ladder monitor windows แล้วดับเบิลคลิก  
จะสามารถเลือก force ON/OFF Device ได้

อ้างอิง

③	ท�ำการ Input หมายเลข Device ที่จะท�ำการ Force ON/OFF

④	 • [Force ON] : Device ON
	 • [Force OFF] : Device OFF
	 • [Toggle force] : Device จะ ON/OFF สลับกันทุกครั้งที่กด 

③ Input Device

④ คลิก
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② การเปลี่ยนแปลงค่าปัจจุบันของ Word Device
การเปลี่ยนค่าปัจจุบันของ Word Device ของ PLC (เช่น T, C, D เป็นต้น) เป็นค่าที่ต้องการ

①	 ไปที่หน้าจอ Monitor (อ้างอิงภาคผนวก 1.7.1)

③ ท�ำการป้อนหมายเลข Device ที่ต้องการเปลี่ยนแปลง

④ ท�ำการป้อนค่าที่ต้องการเปลี่ยน

⑤ คลิก [Set]

②	ท�ำการเลือก [Online] →[Debug] → [Device Test] หรือคลิก
ขวาที่หน้าจอ Program เลือก [Device test] 

③ Input Device

④ ค่าท่ีต้องการเปลีย่น ⑤ คลิก
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ภาคผนวก 1.7.5	 การเขียน Program ขณะ Run Program 
ท�ำการเขียน Program ลงใน PLC เฉพาะ Program ส่วนที่แก้ไข ขณะ PLC ก�ำลังท�ำงาน 
ท�ำการลดระยะเวลาการเขียน program โดยไม่ต้อง Run Program ทั้งหมด

①	 อธิบายการเพิ่ม หน้าสัมผัส (Contact) ลงที่ Ladder ตาม 
ด้านซ้าย เปลี่ยน Program ให้อยู่ใน Write mode ( )

กรณีที่ Program ใน GX Developer กับ Program ใน PLC ก่อนการแก้ไข ไม่ตรงกัน จะไม่สามารถ write ได้ กรณีที ่
ไม่แน่ใจว่า Program ตรงกันหรือไม่ให้ท�ำการเปรียบเทียบก่อน หรือ Transfer ไปที่ [Write to PLC] 

ข้อควรระวัง

②	ท�ำการเพิ่มหน้าสัมผัส (Add Contact)
	 กรอบ Program จะปรากฏเป็นสีเทา

③	 เลือก [Shift] + [F4] หรือเลือก [Convert] → [Convert (Write 
during RUN)] จากเมนู

⑤ เมื่อมี Message แจ้งขึ้นมาว่า “RUN write processing has 
completed” ให้คลิก [OK]

Write during RUN	 [Shift] + [F4]

④	 เพื่อความปลอดภัยจากการเปลี่ยนการควบคุม PLC ด้วย 
การเปลี่ยน Program จะมี Message แจ้งเตือน ให้คลิก [Yes] 

② Add contact (เพิ่มหน้าสัมผัส)

④ คลิก

⑤ คลิก
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ภาคผนวก 1.8	 การใส่ Comment 
ภาคผนวก 1.8.1	  ประเภทของ Comment 
สามารถใส่ Comment ได้ 3 ประเภทตามด้านล่าง 

ประเภท วัตถุประสงค์
จ�ำนวนตัวอักษร
(ตัวพิมพ์ใหญ่) หมายเหตุ

① Device comment 
Comment แสดง บทบาทและหน้าที่
การใช้งานของแต่ละ Device

16
(ที่ PLC มากสุด 8 ตัวอักษร)

กรณี write ลง PLC จ�ำเป็นต้องท�ำการ Set 
ค่า [Comment Capacity] และจ�ำเป็นต้อง 
Set [Comment range setting] ที่จะ write

② Statement
Comment แสดง บทบาทและหน้าที่
การใช้งานของ Ladder block

32
เป็น Comment เฉพาะด้าน Computer 
software (ไม่ Download ลง PLC)

③ Note 
Comment แสดงบทบาทและหน้าที่
การใช้งานต่อ Output instruction

16
เป็น Comment เฉพาะด้าน Computer 
software (ไม่ Download ลง PLC)

[ตัวอย่าง Comment]

วิธีการแสดง Comment

• ท�ำการเลือก [Display] → [Display comment] จากเมนู แล้ว Comment จะปรากฏ 

• เมื่อต้องการยกเลิกการแสดง Comment ให้ด�ำเนินการตามขั้นตอนด้านบนอีกครั้ง

Point

② Statement

① Device comment

③ Note

* เมื่อถึงเวลาที่ตั้งไว้ Buzzer จะดัง

	T5 N.O. Contact มี 10 Step, 
	 N.C. Contact มี 8 Step

* (ไฟกะพริบเมื่อกดปุ่ม Start)
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ภาคผนวก 1.8.2	 วิธีการสร้าง Device comment 

① วิธีการ Input Device จาก List

①	ท�ำการคลิก [Device Comment] → [COMMENT] จาก Project 
list

②	ท�ำการ Input ตัวเลขต้นของ Device ที่ต้องการจัดท�ำ Comment 
ลงใน “Device name” แล้วคลิก [Display]

③	ท�ำการ Input Comment ลงในช่อง [Comment] 

 •	 กรณีที่ต้องการ Input comment ของ Device อื่นๆ ให้ท�ำการใส่
หมายเลขของ Device นั้นตามขั้นตอนข้อ ② อีกครั้ง

①	 คลิก  จาก Toolbar และ ดับเบิลคลิกหมายเลข Ladder  
ที่ต้องการ Input Comment 

②	 วิธีการป้อน Comment โดยใช้ Enter Symbol แล้วคลิก [OK]

 •	 เมื่อด�ำเนินการเสร็จแล้วให้คลิก  อีกครั้ง

② วิธีการป้อน Comment โดยใช้ Enter Symbol

① คลิก

② Input หมายเลข Device

③ Input Comment

① ดับเบิลคลิก

② Comment input
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วิธีการป้อน Comment เมื่อจัดสร้าง Program
อ้างอิง

การ Set การ Write Device Comment ใน PLC 

เพื่อท�ำการ write Comment ใน PLC จ�ำเป็นต้อง Set “Parameter Setting” และ “Comment range setting”

①	 การ Set parameter

 •	 เลือก [Parameter] → [PLC Parameter] 
 •	 ท�ำการ Set “จ�ำนวน Block” ใน [Comment Capacity]
		 ในหนึ่ง Block สามารถบรรจุได้ 50 Comment โดย Program memory ที่ 500 Step

②	 Comment range setting

 •	 เลือก [Device Comment] → [COMMENT] จะปรากฏหน้าจอให้ Input Comment 
 •	 เลือก [Edit] → [Setup Comment range] จากเมนู
 •	 ท�ำการ Set ประเภท Device และขอบเขตที่จะ Write ที่ PLC ลงใน Setup comment range dialog

Point

ท�ำการเลือก [Tools] → [Options] จากเมนู ท�ำการใส่
เครื่องหมายถูก “Continues during command write”  
ในช่อง [Comment input] ใน [Program common]

เมื่อด�ำเนินการ Set ตามนี้แล้ว จะปรากฏหน้าจอข้อ ② 
“Enter symbol” หลังจาก Input Program ในขั้นตอน 
การจัดสร้าง Program 

Comment capacity setting

	ความจุ Program 
	 จะลดลง ขึ้นอยู่กับ 
	 ความจุ Comment

	Comment range 
	 setting
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ภาคผนวก 1.8.3	 ด�ำเนินการจัดสร้าง Statement 

①	 คลิก  จาก Toolbar ท�ำการดับเบิลคลิกตรงส่วนไหนก็ได้
ของ Ladder block ที่ต้องการจะ input Statement

②	ท�ำการ Input statement ที่หน้าจอ [Enter Line Statement] 
แล้วคลิก [OK]

 •	 เมื่อด�ำเนินการเสร็จแล้ว ท�ำการคลิก  จาก Toolbar อีกครั้ง

ภาคผนวก 1.8.4	 การจัดสร้าง Note

①	 คลิก  จาก Toolbar ท�ำการดับเบิลคลิกตรง Output 
instruction ที่ต้องการจะ Input Note

②	ท�ำการ Input Note หน้าจอ “Enter Note” แล้วคลิก [OK]

 •	 เมื่อด�ำเนินการเสร็จแล้ว ท�ำการคลิก  จาก Toolbar อีกครั้ง 

① ดับเบิลคลิก

① ดับเบิลคลิก

② Statement input

② Note input
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ภาคผนวก 1.9	 การจัดสร้าง List Program 
GX Developer สามารถจัดสร้าง Program โดยใช้ List ได้

ภาคผนวก 1.9.1	 การแสดงหน้าจอ List edit

①	 จัดสร้าง New project (อ้างอิงภาคผนวก 1.2.2) หรือเลือกเปิด 
Program จาก Project เดิม

②	 เลือก  จาก Toolbar หรือเลือก [View] → [Instruction list] 
จากเมนู

ภาคผนวก 1.9.2	 วิธีการป้อนค�ำสั่ง (Instructions)

①	ท�ำการ Input ตาม Step ตั้งแต่ Step 0 ในตัวเลขที่ปรากฏของ
แต่ละ Step เมื่อ Input เข้าไปแล้ว จะท�ำการเพิ่มให้อัตโนมัติ  
(วิธีการ Input อ้างอิงหน้าถัดไป) 

Start up monitor	 After input list

③	 จะปรากฏหน้าจอ List edit ขึ้น 

	 กรณีต้องการกลับมาที่หน้าจอ Ladder ให้กด  เลือก 
[View] → [Ladder] จากเมนู 

① Edit Screen แสดงขึ้นมา

③ Edit Screen แสดงขึ้นมา
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●	วิธีการป้อนค�ำสั่งพื้นฐานและค�ำสั่งประยุกต์ (Input Basic instruction และ applied instruction)

Instruction กับหมายเลข Device หรือ Operand ท�ำการเว้นวรรคด้วยการใส่ “Space” 

[ตัวอย่าง Basic instruction]

LD	 X0	 Enter

OUT	 Y0	 Enter

LDI	 X0	 Enter

AND	 Y0	 Enter

OUT	 M0	 Enter

LD	 M0	 Enter

OUT	 T0　K10	 Enter

OUT	 C0　K5	 Enter

[ตัวอย่างค�ำสั่งประยุุกต์ (Applied instruction)]

MOV	 K1　D0　	 Enter

CMP	 K20　D3　M10	 Enter

Connection and OUT Instructions

การใช้งาน Key ในการ Input และ Edit
•	 เมื่อกด Insert  จะเป็นการสลับ Mode [Ovrwrte] / [Insert] 

•	 สามารถท�ำการ Delete 1 instruction ได้ด้วย Delete

•	 เมื่อคลิกขวาที่เมาส์ สามารถท�ำการ [Insert line] / [Delete line]

อ้างอิง

Coil instructions for the timer and counter



ผนวก 1-47

ผนวก

1

ภาคผนวก 1.9.3	 การตรวจสอบรายละเอียดในการ Input List 
ท�ำการตรวจสอบ Program ที่จัดสร้างขึ้นว่ามี Error หรือไม่ โดยใช้ Input List ที่หน้าจอ Ladder

①	 เลือก  จาก Toolbar หรือเลือก [View] → [Ladder]  
จากเมนู

③	 เมื่อท�ำการ Execute Program check ที่เลือกจากเมนู [Tools] 
→ [Check program] จะสามารถตรวจสอบได้ว่ามี Error หรือไม่ 
หรือเกิด Error ที่ Step ไหน 

②	 ขอให้ท�ำการตรวจสอบ Program ที่จัดสร้างขึ้น ที่ List ที่ Input 
ไป
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ผนวก 2-1

ภาคผนวก 2

แนะน�ำตัวอย่างการใช้งาน List programs
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ภาคผนวก 2.1	 List programs 

ตัวอย่างที่ 1 

≪List program : ตัวอย่างที่ 1≫
Step Command
0 LD X001
1 OR Y000
2 ANI X003
3 OUT Y000
4 OUT Y003
5 END

≪List program : ตัวอย่างที่ 2≫
Step Command
0 LD X001
1 SET Y000
2 SET Y003
3 LD X003
4 RST Y000
5 RST Y003
6 END

≪List program≫
Step Command
0 LD X000
1 AND X001
2 OUT Y001
3 LD X003
4 OR Y003
5 ANI X004
6 OUT Y003
7 LD Y003
8 OUT C0　K5
11 LD C0
12 OUT Y000
13 LD X002
14 RST C0
16 END

ตัวอย่างที่ 2 

ตัวอย่างที่ 3

≪List program≫ ≪List program≫
Step Command
0 LD X001
1 OR Y003
2 ANI C0
3 OUT Y003
4 LD X004
5 OUT C0　K4
8 LD C0
9 OUT Y001
10 OUT T0　K10
13 AND T0
14 OUT Y002
15 OUT T1　K20
18 LD T1
19 RST C0
21 END

ตัวอย่างที่ 4

Step Command
0 LD X001
1 OR Y000
2 ANI X003
3 OUT Y000
4 LD Y000
5 AND X000
6 OUT Y002
7 AND Y002
8 MPS
9 AND X005
10 ANI Y003
11 OUT Y001
12 MPP
13 AND X006
14 ANI Y001
15 OUT Y003
16 END
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ตัวอย่างที่ 5 

≪List program≫
Step Command
0 LD X001
1 OR Y000
2 ANI T4
3 OUT Y000
4 OUT T0　K20
7 LD T0
8 OUT Y001
9 OUT T1　K20
12 LD T1
13 OUT Y002
14 OUT T2　K20
17 LD T2
18 OUT Y003
19 OUT T3　K20
22 LD T3
23 OUT Y004
24 OUT T4　K20
27 END
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ผนวก 3-1

กรณีใช้ Handy programming panel (HPP)…
กรณีที่ใช้ HPP จะสามารถท�ำการ Edit program list ได้อย่างง่ายดาย 
ในการจัดสร้าง Program หรือ Debug เครื่อง สามารถใช้ HPP ท�ำการเปลี่ยน Program อย่างง่ายๆ หรือ  
Set timer / Counter ได้โดยเป็นส่วนที่ Computer ทั่วไปไม่สามารถเปลี่ยนแปลงได้ 

และยังด�ำเนินการตรวจสอบ รายละเอียด Errors ได้… 
ใช้ Monitor function, Program check function ของ HPP จะสามารถตรวจสอบรายละเอียด Error ได้อย่าง
สะดวก

สามารถ Storing programs และ Transfering programs ไปที่ PLCs…
HPP รุ่น FX-30P สามารถจุ Sequence programs ได้สูงสุด 15 programs (กรณี Step programs เกิน 32000 
steps ได้สูงสุด 7 sequence programs) ในการ Update ของ PLC ที่แยกต่างหากไม่จ�ำเป็นต้องใช้ PC 
และกรณีการเขียน Program เดียวกันลงใน PLC หลายๆตัว ก็ไม่จ�ำเป็นต้องใช้ PC

ใช้กับเครื่องจักรส�ำหรับต่างประเทศก็ได้…
HPP รุ่น FX-30P เนื่องจากรองรับการเปลี่ยนภาษาทั้งญี่ปุ่น, อังกฤษ, จีน จึงสะดวกในการใช้งานในต่างประเทศ

ภาคผนวก 3 

การใช้งาน Handy programming panel 
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ภาคผนวก 3.1	 การใช้ Handy programming panel (HPP) 

กรณีที่ใช้ HPP จะสามารถท�ำการ Edit programs list ได้อย่างง่ายดาย 
ในการจัดสร้าง Programs หรือ Debug เครื่อง สามารถใช้ HPP ท�ำการเปลี่ยน Programs อย่างง่ายๆ หรือ Set timers/counters ได้โดย 
เป็นส่วนที่ Computer ทั่วไปไม่สามารถเปลี่ยนแปลงได้ 

①	 Functions ที่สะดวกในการ Set up เครื่องจักร
	 •	 ท�ำการ Edit programs โดยการใช้ Instruction list
	 •	 Devices monitoring, Force ON/OFF
②	 Functions ที่สะดวกในการใช้งาน เมื่อเกิด Error ขึ้น
	 •	 Program check function 
	 •	 PC (PLC) diagnostic function
③	 Functions ที่สะดวกส�ำหรับการ Maintenance 
	 •	 Functions ที่สามารถแก้ไข Parameter timer, Counter 
	 •	� Functions ในการ Transfer sequence programs ที่ Update แล้ว (กรณีเป็น Programs capacity เท่ากับหรือต�ำ่กว่า 32000 steps  

สามารถจุใน HPP ได้มากกว่า 15 sequence programs)
④	 Functions ที่สะดวกในการใช้งานกับเครื่องจักรส่งออกต่างประเทศ
	 •	 ข้อความสามารถรองรับได้หลายภาษา เช่น อังกฤษ, จีน, ญี่ปุ่น 

[FX-30P Demensions]

87mm

17
0m
m

น�้ำหนัก : 0.3 kg 

[ตัวอย่างการเชื่อมต่อ]

PLC

Programming 
port

FX-20P-CAB0 type 
program cable 1.5 m

HPP FX-30P 
Main unit
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[ตาราง FX-30P Function]
■	Online mode (Functions การเชื่อมต่อโดยตรงไปยัง Memory ของ PLC)

Function Description

Programming 

Read การ Read sequence program (จาก Program memory ใน PLC → FX-30P Monitor )

Write การ Writing sequence program (โดย Key input ลงใน FX-30P → Program memory ใน PLC)

Insert ท�ำการ Insert intruction ลงใน Sequence program (โดย Key input ลงใน FX-30P → Program memory ใน PLC)

Delete ท�ำการยกเลิก Intruction จาก Sequence program (โดย Key input ลงใน FX-30P → Program memory ใน PLC)

Monitor ท�ำการ Read สถานะการท�ำงาน (Program memory → FX-30P screen)

Test การ Force writing device (โดย Key input ลงใน FX-30P → Program memory)

อื่นๆ 

การสลับ Offline การสลับเปลี่ยน Offline mode

PLC Diagnostic ท�ำการ PLC diagnostic

Memory cassette transfer ท�ำการส่ง Memory cassette 

Parameter ท�ำการ Set parameter 

Key word ท�ำการ Set key word 

Device conversion ท�ำการ Device conversion

Latch clear ท�ำ Latch clear

Device batch monitor ท�ำ Device batch monitor

BFM batch monitor ท�ำการ Monitor buffer memory

Baud rate ท�ำการเปลี่ยน Baud rate

PLC memory clear ท�ำการ Clear memory ใน PLC

Remote RUN/STOP ท�ำการเปลี่ยน Mode RUN/STOP ใน PLC

PLC clock setting ท�ำการ Set PLC timer

HPP set ท�ำ HPP set

■	Offline mode (Functions การ Access เข้า RAM Memory ใน FX-30P)
Function Description

Programming 

Read การ Read sequence program (จาก Built in RAM ของ FX-30P → FX-30P Screen )

Write การ Writing sequence program (โดย Key input ลงใน FX-30P → Built in RAM ของ FX-30P)

Insert ท�ำการ Insert instruction ลงใน Sequence program (โดย Key input ลงใน FX-30P → Built in RAM ของ FX-30P)

Delete ท�ำการยกเลิก Instruction จาก Sequence program (โดย Key input ลงใน FX-30P → Built in RAM ของ FX-30P)

อื่นๆ 

การสลับ Online การสลับเปลี่ยน Offline mode

Program check ท�ำการ Check program

HPP-FX transfer ท�ำการ Transfer ระหว่าง 30P RAM - FX PLC

HPP-PC transfer* ท�ำการ Transfer ระหว่าง 30P RAM - Computer

Parameter ท�ำการ Set parameter

Device conversion ท�ำการ Device conversion

PLC type ท�ำการเปลี่ยน PLC Type

HPP memory clear ท�ำการ Clear memory ใน 30P

Program management ท�ำการ Manage program ใน 30P RAM หรือ Flash memory (15 Block)

HPP setting ท�ำ HPP set

*: การ Transfer ระหว่าง HPP-PC รองรับ Version ตั้งแต่ F/W version 1.10 ขึ้นไป

■	Set HPP (Functions ในการ Set FX-30P main unit)
Function Description

Language สามารถเลือกภาษาในการแสดงค�ำสั่งได้ English, Japanese, Chinese 

Buzzer sound level สามารปรับระดับเสียง Buzzer ได้ 

LCD contrast สามารถปรับ LCD contrast ได้

Backlight brightness สามารถปรับระดับ Backlight ของ LCD brightness ได้

Screen saver สามารถ Set screen save ได้

HPP protect สามารถ Set protect ให้ Program ใน 30P ได้

HPP initialization สามารถ Set 30P ให้กลับสู่สภาพเหมือนตอน Ship ออกจากโรงงานได้

HPP F/W update สามารถท�ำการ Update firmware 30P ได้ 
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ภาคผนวก 4 
ผังการเชื่อมต่อ I/O ใน Training kit 
(Wiring diagram)
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ภาคผนวก 4.1	 I/O Wiring diagram ส�ำหรับ Training machine

L

N

X000

X001

X002

X003

X004

X005

X006

Y004

Y003

Y002

Y001

Y000

0V

S/S 24V

COM0～

COM2

 
AC100V

FX3G-14MR/ES

แหล่างจ่ายไฟ

เบรคเกอร์

เชื่อมไปยัง Ⓐ

สวิทซ์แบบปุ่มกด

สวิทซ์แบบปุ่มกด

Toggle SW

Limit SW

Proximity SW

Select SW
(ปุ่มปรับเปลี่ยน)

หลอดไฟ (แดง)

Micro PLC

Varlable resistor

Min	 Max

ออดหรือกริ่ง

Magnetic connector

รีเลย์

Solenoid valve

มอเตอร์

เชื่อมต่อ

เชื่อมไปยัง Ⓐ

ลักษณะการเชื่อมต่อของ
FX-I/O-DEMO2
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ประวัติการแก้ไข
วันที่จัดท�ำ ล�ำดับ รายละเอียด

สิงหาคม 2557 A จัดพิมพ์ครั้งแรก

พฤษภาคม 2558 B แก้ไขเนื้อหาการติดต่อสอบถาม

พฤษภาคม 2559 C การเพิ่มและการแก้ไขรายละเอียดอื่น ๆ





ส�ำนักงานจ�ำหน่ายประจ�ำประเทศไทย
บริษัท มิตซูบิชิ อีเล็คทริค แฟคทอรี่ ออโตเมชั่น (ประเทศไทย) จ�ำกัด
เลขที่ 896/19 และ 20 อาคารเอสวี ซิตี้ ออฟฟิศทาวเวอร์ 1 ชั้น 12
ถนนพระราม 3 แขวงบางโพงพาง เขตยานนาวา กรุงเทพมหานคร 10210
โทร : 02-682-6522-31 แฟกซ์ : 02-682-6020 
URL : http://www.MitsubishiElectric.com/fa/th_th

HEAD OFFICE : TOKYO BUILDING, 2-7-3 MARUNOUCHI, CHIYODA-KU, TOKYO 100-8310, JAPAN

JY997D57401C(MEE) แปลเมื่อพฤษภาคม 2559
อาจมีการเปลี่ยนเนื้อหาโดยไม่มีการแจ้งให้ทราบล่วงหน้า

Your First PLC
  สำ�ห

รับ
ผู้เริ่ม

ต
้น

ใช้งาน
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